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Disclaimer

Specifications written in this document are believed to be accurate, but are not guaranteed to
be entirely free of error. The information in this manual is subject to change for functional or
performance improvements without notice. Please make sure your manual is the latest edition.
While the information herein is assumed to be accurate, SEGGER Microcontroller GmbH (SEG-
GER) assumes no responsibility for any errors or omissions. SEGGER makes and you receive no
warranties or conditions, express, implied, statutory or in any communication with you. SEGGER
specifically disclaims any implied warranty of merchantability or fitness for a particular purpose.

Copyright notice

You may not extract portions of this manual or modify the PDF file in any way without the prior
written permission of SEGGER. The software described in this document is furnished under a
license and may only be used or copied in accordance with the terms of such a license.

© 2013-2018 SEGGER Microcontroller GmbH, Hilden / Germany

Trademarks

Names mentioned in this manual may be trademarks of their respective companies.

Brand and product names are trademarks or registered trademarks of their respective holders.

Contact address

SEGGER Microcontroller GmbH

Ecolab-Allee 5
40789 Monheim am Rhein

Germany

Tel. +49 2103-2878-0
Fax. +49 2103-2878-28
E-mail: support@segger.com
Internet: www.segger.com
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Manual versions

This manual describes the current software version. If you find an error in the manual or a
problem in the software, please report it to us and we will try to assist you as soon as possible.

Contact us for further information on topics or functions that are not yet documented.

Print date: Februar 7, 2019
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version
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2.56 1 180227 JD

Section Downloading Program Files added.
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2.56 0 180214 JD
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2.52 1 171029 JD Improved the layour and readability of multiple sections.
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About this document

Assumptions

This document assumes that you already have a solid knowledge of the following:
• The software tools used for building your application (assembler, linker, C compiler).
• The C programming language.
• The target processor.
• DOS command line.

If you feel that your knowledge of C is not sufficient, we recommend The C Programming Lan-
guage by Kernighan and Richie (ISBN 0–13–1103628), which describes the standard in C pro-
gramming and, in newer editions, also covers the ANSI C standard.

How to use this manual

This manual explains all the functions and macros that the product offers. It assumes you have
a working knowledge of the C language. Knowledge of assembly programming is not required.

Typographic conventions for syntax

This manual uses the following typographic conventions:

Style Used for

Body Body text.

Keyword
Text that you enter at the command prompt or that appears on
the display (that is system functions, file- or pathnames).

Parameter Parameters in API functions.
Sample Sample code in program examples.
Sample comment Comments in program examples.

Reference Reference to chapters, sections, tables and figures or other doc-
uments.

GUIElement Buttons, dialog boxes, menu names, menu commands.
Emphasis Very important sections.
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Chapter 1
 
Introduction

Ozone is SEGGER’s user-friendly and high-performance debugger for ARM Microcontroller
programs. This manual explains the debuggers usage and functionality. The reader is
welcome to send feedback about this manual and suggestions for improvement to sup-
port@segger.com.
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1.1    What is Ozone?
Ozone is a source-level debugger for embedded software applications written in C/ C++ and
running on ARM-Microcontroller units. It was developed with three design goals in mind:
user-friendly, high performance and advanced feature set.

Ozone is tightly coupled with SEGGER’s set of J-Link debug probes to ensure optimal per-
formance and user experience. J-Link’s instruction set simulation capability makes Ozone
one of the fastest stepping debuggers for embedded systems on the market.

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH



20 CHAPTER 1 Features of Ozone

1.2    Features of Ozone
Ozone has a rich set of features and capabilities. The following list gives a quick overview.
Each feature and its usage is explained in more detail in chapter 3 as well as later chapters
of the manual.

1.2.1    Unlimited Flash Breakpoints
Ozone integrates SEGGER’s flash-breakpoints technology which allows users to set an un-
limited number of software breakpoints in flash memory.

1.2.2    Wide Range of Supported File Formats
Ozone supports a wide range of program and data file formats:

• ELF or compatible files (*.elf, *.out, *.axf)
• Motorola s-record files (*.srec, *.mot)
• Intel hex files (*.hex)
• Binary data files (*.bin)

1.2.3    Fully Customizable User Interface
Ozone features a fully customizable multi-window user interface. All windows can be un-
docked from the Main Window and freely positioned and resized on the desktop. Fonts,
colors, and toolbars can be adjusted according to the user’s preference. Content can be
moved amongst windows via Drag&Drop.

1.2.4    Extensive Printf-Support
Ozone can capture printf-output by the embedded application via SEGGER’s Real-Time
Transfer (RTT) technology that provides extremely fast IO coupled with low MCU intrusion,
the Cortex-M SWO capability, and ARM’s semihosting.

1.2.5    Peripheral and CP15 Register Support
Ozone supports  System View Description  files that describe the memory-mapped (periph-
eral) register set of the target. Once an SVD-File is specified, the register window displays
peripheral registers and their bit-fields next to the core registers of the target. Additionally,
the register window allows users to observe and edit coprocessor-15 registers of the target.

1.2.6    Scripting Interface
Ozone features a C-programming language conformant programming (scripting) interface
that enables users to reconfigure the graphical user interface and most parts of the debug-
ging workflow via script files. All actions that are accessible via the graphical user interface
have an affiliated script function that can be evoked from script files or the debuggers
console window.

1.2.7    Instruction Trace
Ozone is able to trace program execution on a machine instruction level. The history of
executed machine instructions is accessible via the instruction trace window and − used
in conjunction with the call stack window − gives the developer additional insight into the
program’s execution path.
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1.2.8    Code Profiling
Ozone’s code profiling features assist users in optimizing their program code. The Code
Profile Window displays CPU load and code coverage statistics selectively at a file, function
or instruction level. Code profiles can be saved to disk in human-readable or in CSV format
for further processing. Ozone’s code windows display code profile statistics inlined with the
code. A color coding scheme is used to indicate to users source code lines and machine
instructions that can be removed or improved.

1.2.9    Power Profiling
The Power Graph Window tracks the current drawn by the target at resolutions of down to
1 microseconds and displays the resulting graph in an interactive signal plot.

1.2.10    Data Graphs
Ozone is able to trace symbol values and values of arbitrary C-style expressions at time
resolutions of down to 1 microseconds and visualize the resulting time signals within the
Data Graph Window.

1.2.11    Timeline
Ozone’s Timeline Window visualizes the course of the program’s call stack over time. It
provides advanced navigation features that allow users to quickly understand relative and
absolute call frame sizes and positions, which make it a great profiling tool as well.

1.2.12    Disassembly Export
Ozone includes a performant disassembler that is able to create a whole-program disas-
sembly export in the form of a single recompilable GNU-syntax assembly code file.

1.2.13    Advanced Memory View
Ozone’s memory window is fully editable and has many advanced features such as disk-
IO, periodic updating and copy/paste of clipboard content. An unlimited number of memory
windows can be opened at the same time.

1.2.14    Source Editor
Ozone’s combined source code viewer/editor allows users to perform quick adjustments
to source code without having to switch to the IDE window. Ozone automatically detects
changes made to the program file via an external compiler and prompts the user if the
modified file should be reloaded.

1.2.15    System Variable Editor
Ozone’s System Variable Editor enables users to modify behavioral debugger settings from
a central location.

1.2.16    Change-Level Highlighting
Ozone emphasizes changes to user interface values with a set of three different colors
depending on the recency of the change. Change levels are updated each time program
execution is advanced.

1.2.17    Easy Data Member Navigation
All of Ozone’s symbol windows are based on a tree-structure which permits users to easily
navigate through the data hierarchy of complex symbols.
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1.3    Requirements
To use Ozone, the following hardware and software requirements must be met:
• Windows 2000 or later operating system
• 1 gigahertz (GHz) or faster 32-bit (x86) or 64-bit (x64) processor
• 1 gigabyte (GB) RAM
• 100 megabytes (MB) available hard disk space
• J-Link or J-Trace debug probe
• JTAG or SWD data cable to connect the target with the debug probe (not needed for

J-Link OB)
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1.4    Supported Operating Systems
Ozone currently supports the following operating systems:
• Microsoft Windows 2000
• Microsoft Windows XP
• Microsoft Windows XP x64
• Windows Vista Microsoft
• Windows Vista x64
• Windows 7
• Windows 7 x64
• Windows 8
• Windows 8 x64
• Windows 10
• Linux
• macOS/OS X
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1.5    Supported Target Devices
Ozone currently works in conjunction with Microcontrollers (target devices) based on the
following architecture profiles:

1.5.1    ARM
• ARM7
• ARM9
• ARM11
• Cortex-M
• Cortex-A
• Cortex-R

1.5.2    RISC-V
• RV32I

1.5.3    Target Support Plugins
Ozone features a generic target support plugin API that simplifies the process of extending
device support to new MCU architectures.
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1.6    Supported Debug Interfaces
Ozone communicates with the target via a J-Link or J-Trace debug probe. Other debug
probes / hardware interfaces are not supported.

The following target interfaces are supported:
• JTAG
• SWD
• cJTAG
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1.7    Supported Programming Languages
Ozone supports debugging of programs that were written in:
• C
• C++

It is likely that applications written in programming languages other than the ones listed
above can be debugged satisfactory using Ozone, as ELF debugging information is stored
in a mostly language-independant format.
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Getting Started

This chapter contains a quick start guide. It covers the installation procedure and explains
how to use the Project Wizard in order to create a basic project file. The chapter completes
by explaining how a debug session is entered.
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2.1    Installation
This section explains how Ozone is installed and uninstalled from the operating system.

2.1.1    Installation on Windows
Ozone for Windows ships as an executable file that installs the debugger into a user-spec-
ified destination folder. The installer consists of four pages and guides the user through the
installation process. The pages themselves are self-explanatory and users should have no
difficulty following the instructions.

First page of the windows installer

After installation, Ozone can be started by double-clicking on the executable file that is
located in the destination folder. Alternatively, the debugger can be started by executing
the desktop or start menu shortcuts.

2.1.1.1    Multiple Installed Versions
Multiple versions of Ozone can co-exist on the host system if they are installed into different
folders. Application settings, such as user interface fonts, are shared amongst the installed
versions.

2.1.2    Uninstallation on Windows
Ozone can be uninstalled from the operating system by running the uninstaller’s executable
file (Uninstall.exe) that is located in the installation folder. The uninstaller is very simple to
use; it only displays a single page that offers the option to keep the debuggers application
settings intact or not. After clicking the uninstall button, the uninstallation procedure is
complete.
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2.1.3    Installation on Linux
Ozone for Linux ships as an installer (.deb or .rpm) or alternatively as a binary archive
(.tgz).

2.1.3.1    Installer
The Linux installer requires no user interaction and installs Ozone into folder /opt/ SEG-
GER/ozone/<version>. A symlink to the executable file is copied to folder /usr/ bin. The
installer automatically resolves unmet library dependencies so that users do not have to
install libraries manually.

SEGGER provides two individual Linux installers for Debian and RedHat distributions. Both
installers behave exactly the same way and require an internet connection.

2.1.3.2    Binary Archive
The binary archive includes all relevant files in a single compacted folder. This folder can
be extracted to any location on the file system. When using the binary archive to install
Ozone, please also make sure that the host system satisfies all library dependencies (see
Library Dependencies on page 29).

2.1.3.3    Library Dependencies
The following libraries must be present on the host system in order to run Ozone:

• libfreetype6 2.4.8 or above
• libfontconfig1 2.8.0 or above
• libext6 1.3.0 or above
• libstdc++6 4.6.3 or above
• libgcc1 4.6.3 or above
• libc6 2.15 or above

Please note that Ozone’s Linux installer automatically resolves unmet dependencies and
installs library files as required.

2.1.3.4    Multiple Installed Versions
Multiple versions of Ozone can co-exist on the host system if they are installed into different
folders. Application settings, such as user interface fonts, are shared amongst the installed
versions.

2.1.4    Uninstallation on Linux
Ozone can be uninstalled from Linux either by using a graphical package manager such as
synaptic or by executing a shell command (see Uninstall Commands on page 29).

2.1.4.1    Uninstall Commands

Debian

sudo dpkg –remove Ozone

RedHat

sudo yum remove Ozone

2.1.4.2    Removing Application Settings
Ozone’s persistent application settings are stored within the hidden file “$Home/.config/
SEGGER/Ozone.conf”. In order to erase Ozone’s persistent application settings, please
delete this file.

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH



30 CHAPTER 2 Installation

2.1.5    Installation on macOS
Ozone for macOS ships as an installer or alternatively as a disk image. The same installer
or disk image is used for both 32 and 64 bit systems since it provides universal binaries.

2.1.5.1    Installer
The macOS-installer installs Ozone into the application folder. It provides a single installa-
tion option, which is the choice of the installation disk.

MacOS Installer

2.1.5.2    Disk Image
The disk image mounts as an external drive that contains the Ozone executable and its
user documentation. Ozone can be run from the mounted disk out of the box − no further
setup steps are required.

2.1.5.3    Multiple Installed Versions
Currently, only one version of Ozone can be installed on macOS. Installing a version will
overwrite the previously installed version.

2.1.6    Uninstallation on macOS
To uninstall Ozone from macOS, move its application folder to the trash bin. The application
folder is “/applications/SEGGER/ozone”.

2.1.6.1    Removing Application Settings
Ozone’s persistent application settings are stored in the hidden file $Home/Library/ Pref-
erences/com.segger.Ozone.plist. In order to erase Ozone’s persistent application settings,
please delete this file.
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2.2    Using Ozone for the first time
When running Ozone for the first time, users are presented with a default user interface
layout and the Project Wizard pops up. The Project Wizard will continue to pop up on start-
up until the first project was created or opened.

2.2.1    Project Wizard
The Project Wizard provides a graphical facility to specify the required settings needed to
start a debug session. The wizard hosts a total of three settings pages that are described
in more detail below. The user may navigate forward and backward through these pages
via the next and back buttons.

First page of the Project Wizard

Device

On the Project Wizard’s first page, the user is asked to select the target to be debugged on.
By clicking on the dotted button, a complete list of MCU’s grouped by vendors is opened in
a separate dialog from which the user can choose the desired device.

Peripherals

The user may optionally specify a peripheral register set description file that describes the
memory-mapped register set of the target. If a valid register set description file is specified,
peripheral registers will be observable and editable via the debugger’s Register Window
(see Register Window on page 113).
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Second page of the Project Wizard

On the second page of the Project Wizard, J-Link settings are defined.

Target Interface

The target interface setting specifies how the J-Link debug probe is connected to the target.
Ozone currently supports the JTAG and SWD target interfaces.

Target Interface Speed

The target interface speed parameter controls the communication speed with the target.
The range of accepted values is 1 kHz to 50 MHz. Some MCUs require a low, others an
adaptive target interface speed throughout the initial connection phase. Usually, the tar-
get interface speed can be increased after the initial connection, when certain peripheral
registers of the target were initialized. In case the connection fails, it is advised to retry
connecting at a low or adaptive target interface speed.

Host Interface

The host interface parameter specifies how the J-Link debug probe is connected to the PC
hosting the debugger (host-PC). All J-Link models provide a USB interface. Some J-Link
models provide an additional Ethernet interface which is especially useful for debugging an
embedded application from a remote host-PC.

Serial No. IP Address

In case multiple debug probes are connected to the host-PC via USB, the user may enter
the serial number of the debug probe he/she wishes to use. If no serial number is given,
the user will need to specify the serial number via a dialog that pops up when starting the
debug session. If Ethernet is selected as host interface, the caption of this field changes to
IP Address and the user may enter the IP address of the debug probe to connect to.
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Last page of the Project Wizard

On the last page of the Project Wizard, the user specifies the debuggee.

Data File

This input field allows the user to specify the desired program to debug. Please note that
only ELF or compatible program files contain symbol information. When specifying a pro-
gram file without symbol information, the debugging features of Ozone are limited (see
Symbol Information on page 135).

Applying Project Changes Persistently

Project settings applied via the Project Wizard are persistent, i.e. remain valid after the
debugger is closed. In addition, any manual changes carried out within the project file are
persistent. However, project settings applied by other means for instance via the System
Variable Editor are only valid for the current session.

Completing the Project Wizard

When the user completes the Project Wizard, a new project with the specified settings is
created. The project can be saved to disk thereafter.

State after Completing the Project Wizard

After completing the Project Wizard, the source file containing the program’s entry function
is opened inside the Source Viewer. However, the debugger is still offline, i.e. a J-Link
connection to the target has not yet been established. At this point, only windows whose
content does not depend on target data are operational and display content. To put the
remaining windows into use and to begin debugging the program, the debug session must
be started.

2.2.2    Starting the Debug Session
The debug session is started by clicking on the green start button in the debug toolbar
or by hitting the shortcut F5. After the startup procedure is complete, the user may start
to debug the program using the controls of the Debug Menu. The debugging workflow is
described in detail in Chapter 5.
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Graphical User Interface

This chapter provides a description of Ozone’s graphical user interface and its usage. The
focus lies on a brief description of graphical elements. Chapter 5 will revisit the debugger
from a functional perspective.
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3.1    User Actions
A user action (or action for short) is a particular operation within the debugger that can be
triggered via the user interface or programmatically from a script function. Ozone provides
a set of around 200 user actions.

3.1.1    Action Tables
Section Action Tables on page 35 provides multiple tables that contain quick facts on all
user actions. The action tables are particularly well suited as a reference when running the
debugger from the command prompt or when writing script functions.

3.1.2    Executing User Actions
User actions can (potentially) be executed in any of the ways listed below.

Execution Method Description

Menu A user action can be executed by clicking on its menu item.
Toolbar A user action can be executed by clicking on its tool button.
Hotkey A user action can be executed by pressing its hotkey.

Command Prompt A user action can be executed by entering its command into
the command prompt.

Script Function A user action can be executed by placing its command into a
script function.

However, some user actions do not have an associated text command and thus cannot
be executed from the command prompt or from a script function. On the other hand,
some actions can only be executed from these locations, but have no affiliated user inter-
face element. Furthermore, some actions do not provide a hotkey. Section User Actions
on page 35 provides information about which method of execution is available for the
different user actions.

3.1.2.1    User Action Hotkeys
A user action that belongs to a particular debug window may share the same hotkey with
another window-local user action. As a rule of thumb, a window-local user action can only
be triggered via its hotkey when the window containing the action is visible and has the
input focus. On the contrary, global user actions have unique hotkeys that can be triggered
without restriction.

3.1.3    Dialog Actions
Several user actions execute a dialog. The fact that a user action executes a dialog is
indicated by three dots that follow the action’s name within user interface menus.
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3.2    Change Level Highlighting
Ozone emphasizes changed values with a set of three different colors that indicate the
recency of the change. The change level of a particular value is defined as the number of
times the program was stepped since the value has changed. The table below depicts the
default colors that are assigned to the different change levels.

Change Level Meaning

Level 1 The value has changed one program step ago.
Level 2 The value has changed two program steps ago.
Level 3 The value has changed three program steps ago.

Level 4 (and above) The value has changed 4 or more program steps ago or does
not display change levels.

Both foreground and background colors used for change level highlighting can be adjusted
via the User Preference Dialog (see User Preference Dialog on page 52 or via user action
Edit.Color (see Edit.Color on page 204).
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3.3    Main Window
Ozone’s Main Window consists of the following elements, listed by their location within the
window from top to bottom:
• Menu Bar
• Tool Bar
• Content Area
• Status Bar

These components will be explained further down this chapter. First, the Main Window is
described:

Main Window hosting debug information windows

In its center, the Main Window hosts the source code document viewer, or Source Viewer
for short. The Source Viewer is surrounded by three content areas to the left, right and on
the bottom. In these areas, users may arrange debug information windows as desired. The
layout process is described in section Window Layout on page 44. The only window that
cannot be undocked or repositioned is the Source Viewer itself.
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3.4    Menu Bar
Ozone’s Main Window provides a menu bar that categorizes all user actions into five func-
tional groups. It is possible to control the debugger from the menu bar alone. The five
menu groups are described below.

3.4.1    File Menu
The File Menu hosts actions that perform file sys-
tem and related operations
(see File Actions on page 192).

New

This submenu hosts actions to create a new project
and to run the Project Wizard (see Project Wizard
on page 31).

Open

Opens a project-, program-, data- or source-file
(see File.Open on page 197).

Save Project as

Opens a dialog that lets users save the current
project to the file system.

Save All

Saves all modified workspace files.

Recent Projects

The “Recent Projects” submenu contains a list of
recently used projects. When an entry is selected,
the associated project is opened.

Export

A submenu that hosts the following entries:

Disassembly The disassembly export creates a
single assembly code text file containing the self-
contained and recompilable assembly code image
of the program.

Exit

Exits the application.

3.4.2    View Menu
The View Menu hosts actions that add debug infor-
mation windows and toolbars to the Main Window
(see View Actions on page 195).

Views

The View Menu contains an entry for each debug
information window. By clicking on an entry, the
corresponding window is added to the Main Win-
dow at the last used position (see Opening and
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Closing Windows on page 51).

embOS

If an RTOS awareness plugin has been set using action Project.SetOSPlugin, a submenu is
added to the View Menu that hosts additional debug information windows provided by the
RTOS awareness plugin (see Project.SetOSPlugin on page 223).

Toolbars

This submenu hosts three checkable actions that define whether the file-, debug- and help-
toolbars are visible (see Showing and Hiding Toolbars on page 42).

Enter/Exit Full Screen

Enters or exit fullscreen mode.

3.4.3    Find Menu
The Find Menu hosts actions that facilitate navigation to program entities.

Find Text

Opens the Find Dialog (see Find Dialog on page 61).

Find Function

Opens an input widget that when edited, scrolls the source viewer or disassembly window
to the given function.

Find Symbol

Opens an input widget that when edited, scrolls the source viewer to declaration of the
given variable.

3.4.4    Debug Menu
The Debug Menu hosts actions that control program execution (Debug Actions on
page 191).

Start/Stop Debugging

Starts the debug session, if it is not already started. Stops
the debug session otherwise.

Continue/Halt

Resumes program execution, if the program is halted. Halts
program execution otherwise (see Resume on page 141).

Reset

Resets the program using the last employed reset mode.
Other reset modes can be executed from the action’s submenu (see Reset on page 140).

Step Over

Steps over the current source code line or machine instruction, depending on the active
code window (see Active Code Window on page 45 and Step on page 140).

Step Into

Steps into the current subroutine or performs a single instruction step, depending on the
active code window (see Active Code Window on page 45 and Step on page 140).
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Step Out

Steps out of the current subroutine (see Step on page 140).

3.4.5    Tools Menu
The Tools Menu hosts four dialog actions that allow users to edit Ozone’s graphical and
behavioral settings (see Tools Actions on page 194).

J-Link Settings

Opens the J-Link-Settings Dialog that allows users to
specify the hardware setup, i.e. the target device and
debugging interface to be used (see J-Link Settings Di-
alog on page 59).

Trace Settings

Opens the Trace Settings Dialog that is provided to con-
figure Ozone’s trace data input channel (see Trace Settings Dialog on page 67).

Preferences

Opens the User Preference Dialog that allows users to configure Ozone’s graphical user
interface (see User Preference Dialog on page 52).

System Variables

Opens the System Variable Editor that allows users to configure behavioral settings of the
debugger (see System Variable Editor on page 21).

3.4.6    Window Menu
The Window Menu lists all open windows and documents and provides actions to alter the
window and document state.

Close Window

Closes the debug window that contains the input
focus.

Close All Windows

Closes all debug windows.

Undock

Undocks the debug window that contains the input
focus.

Window List

The list of open debug information windows. By se-
lecting an item, the corresponding debug window is focused.

Close Document

Closes the active source document.

Close All Documents

Closes all source documents.
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Close All Unedited Documents

Closes all unedited source documents.

Document List

The list of open source documents is appended to the window menu.

3.4.7    Help Menu

User help related actions.

User Guide

Opens the user guide and reference manual.

Command Help

Prints a description of all user actions to the Console Window
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3.5    Toolbars
Three of Ozone’s Main Menu groups − File, Debug and View − have affiliated toolbars
that can be docked to the Main Window or positioned freely on the desktop. In addition,
a breakpoint toolbar is provided.

Category Toolbar

File

Debug

View

Breakpoints

3.5.1    Showing and Hiding Toolbars
Toolbars can be added to the Main Window via the toolbar menu (View → Toolbars) or
by executing user action Toolbar.Show using the toolbar’s name as parameter (e.g. Tool-
bar.Show(“Debug”)). Removing toolbars from the Main Window works the same way using
action Toolbar.Close (see Toolbar.Close on page 209).

3.5.2    Arranging Toolbars
Toolbars can be arranged either next to each other or above each other within the toolbar
area as desired. To reposition a toolbar, pick the toolbars handle and drag it to the desired
position.

3.5.3    Docking and Undocking Toolbars
Toolbars can be undocked from the toolbar area and positioned anywhere on the desktop.
To undock a toolbar, pick the toolbar’s handle and drag it outside the toolbar area. To hide
an undocked toolbar, follow the instructions of section Showing and Hiding Toolbars on
page 42.
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3.6    Status Bar
Ozone’s status bar displays information about the debugger’s current state. The status bar
is divided into three sections (from left to right):
• Status message and progress bar
• Window context information
• Connection state

Status bar

3.6.1    Status Message
On the left side of the status bar, a status message is displayed. The status message informs
about the following objects, depending on the situation:

Program State

By default, the status message informs about the program state, e.g. “Program running”.

Operation Status

When the debugger performs a lengthy operation, the status message displays the name
of the operation. In addition, a progress bar is displayed that indicates the progress of the
operation.

Context Help

When hovering the mouse cursor over a user interface element, the status message displays
a short description of the element.

3.6.2    Window Context Information
The middle section of the status bar displays information about the active debug information
window.

3.6.3    Connection State
The right section of the status bar informs about the debugger’s J-Link connection state.
When the debugger is connected to the target, the data transmission speed is displayed
as well.
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3.7    Debug Information Windows
Ozone features a set of 22 debug information windows that cover different functional areas
of the debugger. This section describes the common features shared by all debug infor-
mation windows. An individual description of each debug information window is given in
chapter Debug Information Windows on page 44.

3.7.1    Context Menu

Each debug information window owns a context menu that
provides access to the window’s options. The context menu
is opened by right-clicking on the window.

3.7.2    Display Format

Several debug information windows allow users to
change the value display format of a particular (or
all) items displayed within the window. If supported,
the value display format can be changed via the win-
dow’s context menu or via user actions Window.Set-
DisplayFormat and Edit.DisplayFormat (see Window
Actions on page 195).

3.7.3    Window Layout
Section Window Layout on page 44 describes how
debug information windows are added to, removed from and arranged on the Main Window.

3.7.4    Change Level Highlighting

Multiple debug information windows highlight numeric values accord-
ing to recency of their last change (see Change Level Highlighting on
page 44).

3.7.5    Code Windows
Ozone includes two debug information windows that display the pro-
gram’s source code and assembly code, respectively. The code windows share several com-
mon properties that are described in Code Windows on page 44.

3.7.6    Table Windows
Several of Ozone’s debug information windows are based on a joint table layout that pro-
vides a common set of features. A shared description of the table-based debug information
windows is given in Table Windows on page 44.

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH



45 CHAPTER 3 Code Windows

3.8    Code Windows
Ozone includes two debug information windows that display program code: the Source
Viewer and the Disassembly Window. These windows display the program’s source code
and assembly code, respectively. Both windows share multiple properties which are de-
scribed below. For an individual description of each window, please refer to Source Viewer
on page 118 and Disassembly Window on page 89.

3.8.1    Program Counter Tracking
Ozone’s code windows automatically scroll to the position of the PC line when the user steps
or halts the program. In case of the Source Viewer, the document containing the PC line
is automatically opened if required.

3.8.1.1    Active Code Window
At any point in time, either the Source Viewer or the Disassembly Window is the active
code window. The active code window determines the debugger’s stepping behavior, i.e.
whether the program is stepped per source code line or per machine instruction.

3.8.1.2    Recognizing the Active Code Window
The active code window can be distinguished from the inactive code window by a higher
color saturation level of the PC line (see the illustration below).

Source Viewer (inactive, left) and Disassembly Window (active, right)

3.8.1.3    Switching the Active Code Window
A switch to the active code window occurs either manually or automatically.

Manual Switch

A manual switch of the active code window can be performed by clicking on one of the
code windows. The selected window will become active while the other code window will
become inactive.

Automatic Switch to the Disassembly Window

When the user steps or halts the program and the PC is not affiliated with a source code
line via the program’s address mapping table, the debugger will automatically switch to the
Disassembly Window. The user can hereupon continue stepping the program on a machine
instruction level.

Automatic Switch to the Source Viewer

When the program was reset and the PC is affiliated with a source code line, the debugger
will switch to the Source Viewer as its active code window.
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3.8.2    Sidebar
Each code window hosts a sidebar on its left side. The sidebar displays distinct icons that
provide additional information about code lines. Breakpoints can be toggled by clicking on
the sidebar. If desired, the sidebar can be hidden.

3.8.2.1    Showing an Hiding the Sidebar
The display of the sidebar can be toggled from the User Preference Dialog (see User Pref-
erence Dialog on page 52) or via user action Edit.Preference (see Edit.Preference on
page 203).

3.8.2.2    Sidebar Icons
The following table gives an overview of the sidebar icons and their meanings:

Icon Meaning

The code line does not contain executable code.

The code line contains executable code.

A breakpoint is set on the code line.

The code line contains the PC instruction and will be executed next.

The code line contains a call site of a function on the call stack.

The code line contains the PC instruction and a breakpoint is set on the line.

The code line contains a call site and a breakpoint is set on the line.

The code line contains a tracepoint that starts trace.

The code line contains a tracepoint that stops trace.

3.8.3    Code Line Highlighting
Each code window applies distinct highlights to particular code lines. The table below ex-
plains the meaning of each highlight. Code line highlighting colors can be adjusted via the
User Preference Dialog (see User Preference Dialog on page 52) or via the user action
Edit.Color (see Edit.Color on page 204).

Highlight Meaning

for (int i = 0) { The code line contains the program execution point (PC).
Function(x,y); The code line contains the call site of a function on the call stack.
for (int i = 0) { The code line is the selected line.

for (int i = 0) {
The code line contains the instruction that is currently selected
within the instruction trace window (see Backtrace Highlighting on
page 97).

3.8.4    Breakpoints
Ozone’s code windows provide multiple options to set, clear, enable, disable and edit break-
points. The different options are described below.

3.8.4.1    Toggling Breakpoints
Both code windows provide the following options to set or clear breakpoints on the selected
code line:
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Method Set Clear

Context Menu Menu Item “Set Breakpoint” Menu Item “Clear Breakpoint”
Hotkey F9 F9
Sidebar Single-Click Single-Click

Breakpoints on arbitrary addresses and code lines can be toggled using the actions
Break.Set, Break.SetOnSrc, Break.Clear and Break.ClearOnSrc (see Breakpoint Actions on
page 190).

3.8.4.2    Enabling and Disabling Breakpoints
The code windows allow users to disable and enable the breakpoint on the selected code line
by pressing the hotkey Shift-F9. Breakpoints on arbitrary addresses and code lines can be
enabled and disabled using actions Break.Enable, Break.Disable, Break.EnableOnSrc and
Break.DisableOnSrc (see Breakpoint Actions on page 190).

3.8.4.3    Editing Advanced Breakpoint Properties
Advanced breakpoint properties, such as the trigger condition or implementation type,
can be edited via the Breakpoint Properties Dialog (see Breakpoint Properties Dialog on
page 58) or programmatically via user actions Break.Edit (see Break.Edit on page 244)
and Break.SetType (see Break.SetType on page 242).

3.8.5    Code Profile Information
The code windows are able to display code profile information within their sidebar areas.

3.8.5.1    Hardware Requirements
The code profile features of Ozone require the employed hardware setup to support in-
struction tracing (see Hardware Requirements on page 47). The user experience can be
enhanced by employing a J-Trace PRO debug probe (see Streaming Trace on page 147).

3.8.5.2    Execution Counters

When code profiling features are supported
by the hardware setup, the code windows
display a counter next to each text line that
contains executable code. The counter indi-
cates how often the source code line or in-
struction was executed.

Resetting Execution Counters

The execution counters are reset automati-
cally at the same time the program is reset. A manual reset option is provided within the
code window context menu.

Toggling Execution Counters

The display of execution counters can be toggled from the code window context menu.
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3.8.5.3    Execution Counter Highlighting
Execution Counters are highlighted in different colors. The default colors and their meanings
are explained below.

Color Description

10 000 Line has been executed.
10 000 Line has been partially executed.
10 000 Line has not been executed.

These default colors can be adjusted via the User Preference Dialog (see User Preference
Dialog on page 52) or programmatically via user action Edit.Color (see Edit.Color on
page 204).

Executed Line

All instructions of the line have been executed and all conditions have been met and not met.

Partially Executed Line

Not all instructions of the line have been executed or conditions are only partially met.

Not Executed Line

No instruction of the line has been fetched from memory or executed.

3.8.5.4    Execution Profile Tooltips

When hovering the sidebar area next to executable
code, an execution profile tooltip is displayed.

Fetched

Number of times the instruction was fetched from
memory.

Executed

Number of times the instruction was executed. A
conditional instruction may not be executed after having been fetched from memory.

Not-Executed

Number of times the instruction was fetched from memory but not executed.

Load

Number of times the instruction was fetched divided by the total amount of instructions
fetched during program execution.

Please note that the execution profile of source code lines is identical to the execution profile
of the first machine instruction affiliated with the source code line.
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3.9    Table Windows
Several of Ozone’s debug information windows are based on a joint table layout that pro-
vides a common set of features. The Breakpoint Window illustrated below is an example of
a table-based debug information window (or table window for short).

Table Window Example

3.9.1    Selectable Table Columns

Each table column has a checkable entry in the context menu of the table
header. When an entry is checked or unchecked, the corresponding table
column is shown or hidden. The table header context menu can be opened
by right-clicking on the table header.

3.9.2    Sortable Table Rows
Table rows can be sorted according to the values displayed in a particular
column. To sort a table according to a particular column, a left click on the column header
suffices. A sort indicator in the form of a small arrow indicates the column according to which
the table is currently sorted. The sort strategy depends on the data type of the column.

3.9.3    Filter Bar

Each table window provides a filter bar
that allows users to filter table con-
tents. When a filter is set on a ta-
ble column, only table rows whose col-
umn value matches the filter stay vis-
ible. The display state of the filter bar
(shown or hidden) can be toggled via the context menu of the table window.

3.9.3.1    Value Range Filters
Columns that display numerical data accept value range filter input. A value range filter is
specified in any of the following formats:

Format Description

x-y keep items whose column value is contained within the range [x,y].
>x keep items whose column value is greater than x.
≥x keep items whose column value is greater than or equal to x.
<x keep items whose column value is less than x.
≤x keep items whose column value is less than or equal to x.
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3.9.3.2    Filter Bar Context Menu

In addition to the standard text interaction options, the filter bar
context menu provides the following actions:

Clear All Filters

Clears all column filters.

Set Filter...

Opens the filter input dialog.

3.9.4    Editable Table Cells
Certain table cells such as variable values are editable. When a
value that is stored in target hardware is edited, a data readback is performed. This mech-
anism ensures that the displayed value is always synchronized with the hardware state.

3.9.5    Tree Structure

A table row that displays a button on its left side can be expanded to
reveal its child rows. A table window where multiple rows have been
expanded attains a tree structure as illustrated on the right.

3.9.6    Letter Key Navigation
By repeatedly pressing a letter key within a table window, the table
rows that start with the given letter are scrolled into view one after the other.
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3.10    Window Layout
This section describes how debug information windows can be added to, removed from and
arranged on the Main Window.

3.10.1    Opening and Closing Windows

Opening Windows

Windows are opened by clicking on the affiliated view menu item (e.g. View → Breakpoints)
or by executing the command Window.Show using the window’s name as parameter (e.g.
Window.Show(“Breakpoints”)). When a window is opened, it is added to its last known
position on the user interface.

Closing Windows Programmatically

Windows can be closed programmatically via user action Window.Close using the window’s
name as parameter.

3.10.2    Undocking Windows
Windows can be undocked from the Main Window by dragging or double-clicking the win-
dow’s title bar. An undocked window can be freely positioned and resized on the desktop.

Undocked disassembly window floating over the Main Window

3.10.3    Docking and Stacking Windows
Windows can be docked on the left, right or bottom side of the Main Window by dragging
and dropping the window at the desired position. If a window is dragged and dropped over
another window the windows are stacked. More than two windows can be stacked above
each other.

Stacked debug information windows
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3.11    Dialogs
This section describes the different dialogs that are employed within Ozone.

3.11.1    User Preference Dialog
The User Preference Dialog provides multiple options that allow users to customize the
graphical user interface of Ozone. In particular, fonts, colors and toggleable items such as
line numbers and sidebars can be customized.

User preference dialog

3.11.1.1    Opening the User Preference Dialog
The User Preference Dialog can be opened from the Main Menu (Edit → Preferences) or by
executing user action Tools.Preferences (see Tools.Preferences on page 202).

3.11.1.2    Dialog Components

Page Navigator

The Page Navigator on the left side of the User Preference Dialog displays the available
settings pages grouped into two categories: general and appearance. Each settings page
applies to a single or multiple debug information windows, as indicated by the page name.

Settings Pane

The Settings Pane on the right side of the User Preference Dialog displays the settings
associated with the selected page.

3.11.1.3    General Application Settings

This settings page lets users adjust general appli-
cation settings.

Open the most recent project on startup

Specifies if the most recent project should be
opened when the debugger is started instead of
displaying the welcome dialog.

Show progress bar while running

Indicates if a moving progress bar should be an-
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imated within Ozone’s status bar area while the program is executing.

Show dialog option "Do not show again"

Indicates if popup-dialogs should contain a checkbox that allows users to stop the dialog
from popping up.

3.11.1.4    Source Viewer Settings
This settings page lets users adjust general display options of the Source Viewer.

Show Line Numbers

Specifies if the Source Viewer displays source
code line numbers (see Source Line Numbers
on page 120).

Show Sidebar

Specifies if the Source Viewer displays a side-
bar.

Show Line Expansion Bar

Specifies if the Source Viewer displays line
expansion indicators next to source code
lines.

Show Code Profile

Specifies if code profile information should
be displayed within the sidebar area of the Source Viewer (see Execution Counters on
page 47).

Lock Header Bar

Specifies if the Source-Viewer’s header bar should be visible at all times or only when
hovered with the mouse.

Tab Spacing

Sets the number of whitespaces drawn for each tabulator in the source text.

3.11.1.5    Disassembly Window Settings
This settings page lets users adjust general display options of the Disassembly Window.

Show Source

Specifies if assembly code should be augmented with
source code text to improve readability (see Mixed Mode
on page 91).

Show Labels

Specifies if assembly code should be augmented with
labels to improve readability (see Mixed Mode on
page 91).

Show Sidebar

Specifies if the Disassembly Window displays a sidebar
(see Sidebar on page 46).
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Show Code Profile

Specifies if code profile information should be displayed within the sidebar area of the
Disassembly Window (see Execution Counters on page 47).

3.11.1.6    Function Window Settings

This settings page lets users adjust general display
options of the Functions Window.

Prepend Class Names to Func Names

Specifies if the class name of a member function
should be preceding the function name itself (see
User Preference Identifiers on page 175).

3.11.1.7    Terminal Window Settings
This settings page lets users adjust general display
options of the Terminal Window (see Terminal Window on page 123).

Suppress Control Characters

Specifies if non-printable and control
characters are filtered from IO da-
ta prior to terminal output (see User
Preference Identifiers on page 175).

Clear On Reset

When checked, the window’s text area
is cleared following each program re-
set.

Zero-Terminate Input

Indicates if a string termination char-
acter (\0) is appended to terminal input before the input is sent to the debuggee.

Echo Input

When checked, each terminal input is appended to the terminal window’s text area.

Newline Input Termination

Specifies the type of line break to be ap-
pended to terminal input before the input
is send to the debuggee (see Newline For-
mats on page 172).

3.11.1.8    Table Window Settings
This settings page lets users adjust gen-
eral display options of the Table Windows
(see Table Windows on page 49).

Show Character Value

By checking a data type’s option, all sym-
bols of this data type display their value in
the format “<number> (<text represen-
tation>)” instead of just “<number>”.

Globally Hide Filter Bars
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filter bars is globally disabled (see Filter Bar on page 49).

Symbol Member Count Display Limit

Specifies the maximum amount of members that are displayed for complex-type symbols
such as arrays.

3.11.1.9    Appearance Settings

On the appearance settings pages,
fonts and colors of a particular win-
dow or window group can be adjust-
ed. Within the window group “Appli-
cation”, the default appearance set-
tings for all windows and dialogs can
be specified.

Fonts

Lets users adjust individual fonts of the
window or window group.

Colors

Lets users adjust individual colors of
the window or window group.

3.11.1.10    Specifying User Preferences Programmatically
Each setting provided by the User Preference Dialog is affiliated with an user action. User
preference actions allow users to change the preference from a script function or at the
command prompt. The table below gives an overview of the available user preference ac-
tions.

User Preference Category Affiliated User Action(s)

General Settings Edit.Preference (see Edit.Preference on page 203)

Appearance Settings Edit.Color (see Edit.Color on page 204) and Ed-
it.Font (see Edit.Font on page 204)
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3.11.2    System Variable Editor
Ozone defines a set of system variables that control behavioral aspects of the debugger.
The System Variable Editor lets users observe and edit these variables in a tabular fashion.

System Variable Editor

3.11.2.1    Opening the System Variable Editor
The System Variable Editor can be opened from the Main Menu (Edit → System Variables)
or by executing user action Tools.SysVars (see Tools.SysVars on page 202).

3.11.2.2    Editing System Variables Programmatically
The user action Edit.SysVar on page 203 is provided to manipulate system variables inside
script functions or at the command prompt (see Command Prompt on page 81).

3.11.2.3    Applying Changes

Save

By clicking the save button, the displayed system settings are written as Ozone API com-
mands to the project file and thereby applied persistently.

Close

By clicking the close button, the selected system settings are applied to the current session
only.
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3.11.3    Data Breakpoint Dialog
The Data Breakpoint Dialog allows users to place data breakpoints on global program vari-
ables and individual memory addresses. Please refer to Data Breakpoints on page 144 for
further information on data breakpoints in Ozone.

The dialog can be accessed from the con-
text menu of the Breakpoints/Tracepoints win-
dow (see Breakpoints/Tracepoints Window on
page 71) or from the context menu of the
data symbol windows.

Data Location

The data location pane allows users to speci-
fy the memory address(es) to be monitored for
IO accesses. When the “From Symbol” field is
checked, the memory address is adapted from
the data location of a global variable. Other-
wise, the memory addresses need to be speci-
fied manually.

Access Condition

The access condition pane allows users to spec-
ify the type and size of a memory access that
triggers the data breakpoint.

Value Condition

The value condition pane allows users to specify
the IO-value required to trigger the data break-
point. The value condition can be disabled by
checking the “Ignored” field.

OK Button

By pressing the OK button, a data breakpoint with the specified attributes is set in target
hardware and added to the Breakpoints/Tracepoints Window. In case the debugger is dis-
connected from the target, the data breakpoint is added to the Breakpoints/Tracepoints
Window and scheduled to be set in target hardware when the debug session is started.

Cancel Button

Closes the dialog without setting the data breakpoint.
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3.11.4    Breakpoint Properties Dialog
The Breakpoint Properties Dialog allows users to edit advanced breakpoint properties such
as the trigger condition and the implementation type. The dialog can be accessed via the
context menu of the Source Viewer, Disassembly Window or Breakpoints/Tracepoints Win-
dow. Breakpoint properties can also be set programmatically using actions Break.Edit (see
Break.Edit on page 244) and Break.SetType (see Break.SetType on page 242).

State

Enables or disables the breakpoint.

Permitted Implementation

Sets the breakpoint’s permitted implementa-
tion type (see Break.SetType on page 242).

Skip Count

Program execution can only halt each Skip-
Count+1 amount of times the breakpoint is hit.
Furthermore, the remaining trigger conditions
must be met in order for program execution to
halt at the breakpoint.

Reload

When unchecked, the skip count condition is
deactivated as soon as the program halts at the
breakpoint for the first time.

Task

Specifies the RTOS task that must be running
in order for the breakpoint to be triggered. The
RTOS task that triggers the breakpoint can be
specified either via its name or via its ID. When
the field is left empty, the breakpoint is task-
insensitive.

Condition

An integer-type or boolean-type symbol ex-
pression that must be met in order for program execution to halt at the breakpoint. When
option “trigger when true” is selected, the expression must evaluate to a non-zero value in
order for the breakpoint to be triggered. When option “trigger when changed” is selected,
the breakpoint is triggered each time the expression value changed since the last time the
breakpoint was encountered.

Extra Actions

Specifies the additional actions that are performed when the breakpoint is hit. The provid-
ed options are a text message that is printed to the Console Window, a message that is
displayed within a popup dialog and a script function that is executed.
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3.11.5    J-Link Settings Dialog
The J-Link-Settings-Dialog allows users to configure J-Link related settings, such as the
target model and the debugging interface. Please refer to Project Wizard on page 31 for
further details on these settings.

J-Link Settings Dialog

3.11.5.1    Opening the J-Link Settings Dialog
The J-Link Settings Dialog can be opened from the Main Menu (Edit → J-Link Settings) or
by executing user action Tools.JLinkSettings (see Tools.JLinkSettings on page 202).

3.11.5.2    Applying Changes

Save

By clicking the save button, the selected J-Link settings are written as Ozone API commands
to the project file and thereby applied persistently.

Close

By clicking the close button, the selected J-Link settings are applied to the current session
only.

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH



60 CHAPTER 3 Dialogs

3.11.6    Generic Memory Dialog
The Generic Memory Dialog is a multi-functional dialog that is used to:
• Dump target memory data to a binary file
• Download data from a binary file to target memory
• Fill a target memory area with a specific value

All values entered into the Generic Memory Dialog are interpreted as hexadecimal numbers,
even when not prefixed with “0x”.

3.11.6.1    Save Memory Data
In its first application, the Generic Memory Dialog is used to save target memory data to
a binary file.

File

The destination binary file (*.bin) into which mem-
ory data should be stored. By clicking on the dotted
button, a file dialog is displayed that lets users se-
lect the destination file.

Address

The addresses of the first byte stored to the desti-
nation file. Size The number of bytes stored to the
destination file.

3.11.6.2    Load Memory Data
In its second application, the Generic Memory Dia-
log is used to write data from a binary file to target memory.

File

The binary file (*.bin) whose contents are to be written to target memory. By clicking on
the dotted button, a file dialog is displayed that lets users choose the data file.

Address

The download address, i.e. the memory address that should store the first byte of the data
content.

End Address / Size

The number of bytes that should be written to target memory starting at the download
address.

3.11.6.3    Fill Memory

In its third application, the Generic Memory Dialog
is used to fill a memory area with a specific value.

Fill Value

The fill value.

Address

The start and end addresses (inclusive) of the mem-
ory area.

End Address / Size

The size of the memory area.
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3.11.7    Find Dialog
The Find Dialog allows users to search for text patterns within source code documents.

Find What

Defines the search pattern. The search pattern
is either a plain text string or a regular expres-
sion, depending on the type of the search (see
Use Regular Expressions below).

Look In

Specifies the search location. The search loca-
tion defines the source code documents that are
to be included in the search (see Search Loca-
tions on page 62).

Match Case

Specifies if a substring is considered a match
only when its letter casing corresponds to that
of the search string.

Match Whole Word

Specifies if a substring is considered a match
only when it constitutes a single word and is not
a substring of another word.

Use Regular Expressions

Indicates if the search string is interpreted as
a regular expression (checked) or as plain text (unchecked). In the first case, the search
is conducted on the basis of a regular expression pattern match. In the latter case, the
search is conducted on the basis of a substring match.

Show Filepaths

Indicates if the file path of matching locations should be included in the search result. The
search result is displayed within the Find Results Window.

Find All

Finds all occurrences of the search pattern in the selected search location. The search result
is printed to the Find Results Window.

Find Next

Finds the next occurrence of the search pattern in the selected search location. When a
match is found, it is highlighted within the Source Viewer. After closing the find dialog, the
next occurrence of the search pattern can still be located using hotkey F3.

Find Prev

Finds the previous occurrence of the search pattern in the selected search location. When
a match is found, it is highlighted within the Source Viewer. After closing the find dialog,
the next occurrence of the search pattern can still be located using the hotkey Shift+F3.

Close

Closes the dialog.

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH



62 CHAPTER 3 Dialogs

3.11.7.1    Search Locations
Text search can be conducted in three individual locations. The desired search location can
be specified via the “Look In” selection box of the Find Dialog.

Search Location Description

Current Document The search is conducted within the active document.

All Open Documents The search is conducted within all documents that are open
within the Source Viewer.

Current Project The search is conducted within all source files used to com-
pile the debuggee.
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3.11.8    Disassembly Export Dialog
The Disassembly Export Dialog is provided to save the disassembly of arbitrary memory
address ranges, including source code and symbol information, to CSV and assembly code
files.

Disassembly Export Dialog

CSV

Disassembly data is exported in CSV format.

Assembly Code

Disassembly data is exported to a single recompilable GNU-syntax assembly code file.

Entity/Function

Selects the address range to be exported.

3.11.8.1    Exemplary Output
Shown below is an excerpt of a CSV file that was generated using the Disassembly Export
Dialog.

CSV content generated by the Disassembly Export Dialog
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3.11.9    Instruction Trace Export Dialog
The Instruction Trace Export Dialog is provided to save the current instruction trace record
to a CSV file.

Instruction Trace Export Dialog

Instruction Count

Maximum amount of instructions to export.

Output File

Output file.

3.11.9.1    Exemplary Output
Shown below is an excerpt of a CSV file that was generated using the Instruction Trace
Export Dialog.

CSV content generated by the Instruction Trace Export Dialog
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3.11.10    Code Profile Report Dialog
The Code Profile Report Dialog is provided to save the application’s code profile to a text
or a CSV file (see Code Profile Window on page 77).

Code Profile Export Dialog

Report Scope

Program scope to be covered by the output file.

Tree View

Allows users to define the report scope by selecting the files and functions to be covered
by the output file.

Output Format

Output file format. The default option “Report” generates a human-readable text file. The
alternate option “CSV” generates a comma-separated values file that can be used with
table-processing software such as excel.

CSV Format

Available when output file format is “CSV”. Specifies which program entities within the se-
lected report scope are to be exported. For example, if the report scope contains a single
file and the selected CSV format is “Instructions”, then a code profile report about all in-
structions within the selected file is generated.

Output File

Output file path.
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3.11.10.1    Code Profile Report
Shown below is the content of a text file generated by the Code Profile Report Dialog.

Code Profile Report Example
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3.11.11    Trace Settings Dialog
The Trace Settings Dialog allows the user to configure the available trace data channels.

Trace Settings Dialog

Trace Source

Selects the trace data channel to be used:

Trace Source Description

Trace Pins

Instruction Trace (ETM) data is read realtime-continuously from the
target’s trace pins and supplied to Ozone’s Trace Windows. This option
requires a J-Trace debug probe to be employed (see Streaming Trace
on page 147).

Trace Buffer Instruction Trace (ETM) data is read from the target’s trace data
buffer and supplied to Ozone’s Trace Windows.

SWO “Printf-type” textual application (ITM) data is read via the SWO chan-
nel and supplied to Ozone’s Terminal Window on page 123.

For detailed information on ETM and ITM trace and how to set up your hardware and soft-
ware accordingly, please consult the  J-Link User Guide .

Note

The simultaneous use of multiple trace data channels in Ozone is currently not sup-
ported.
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Timestamps

Specifies if the target is to output cycle counters (instruction execution timestamps) mul-
tiplexed with the pin trace. The cycle counters are employed by various debug windows to
present users with information about the CPU time spend inside different program entities.
Trace timestamps can also be enabled from inside script functions via command Edit.SysVar
on page 203 using argument VAR_TRACE_TIMESTAMPS_ENABLED.

CPU Frequency

Specifies the constant conversion factor to use when converting cycle counters to time
values and vice versa.

Trace Port Width

Specifies the number of trace pins comprising the target’s trace port (see Project.SetTra-
cePortWidth on page 226).

Maximum Instruction Count

The maximum number of instructions that are read from the selected trace source before
readout is stopped.

Trace Timing

Specifies the software delays to be applied to the individual trace port data lines. This essen-
tially performs a software phase correction of the trace port’s data signals (see Project.Set-
TraceTiming on page 226).

SWO Clock

Specifies the signal frequency of the SWO trace interface in Hz. (see Project.ConfigSWO
on page 226).

CPU Clock

Specifies the core frequency of the target in Hz. (see Project.ConfigSWO on page 226).

3.11.11.1    Opening the Trace Settings Dialog
The Trace Settings Dialog can be opened from the Main Menu (Edit → Trace Settings) or by
executing user action Tools.TraceSettings (see Tools.TraceSettings on page 202).

3.11.11.2    Applying Changes

Save

By clicking the save button, the selected trace settings are written as Ozone API commands
to the project file and thereby applied persistently.

Close

By clicking the close button, the selected trace settings are applied to the current session
only.
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3.12    Application Messages
This section provides a brief description of Ozone’s application message and user notification
system.

3.12.1    Message Format
The format of Ozone application messages is:

<type>(<code>): <message>

where <type> is either error, warning or info and <code> is a unique message number.

3.12.2    Message Codes
Ozone partitions message numbers into groups, depending on the origin and type of the
message. As an example, warning messages emitted from the ELF parser start at code
1000.

Section Errors and Warnings on page 185 lists all user-visible application exceptions by
their code and provides an overview of the cause and possible solutions to each exception.

3.12.3    Logging Sinks
Application messages are output to any of the following destinations:

• Ozone’s Console Window
• Debug Console
• Application Logfile

Application messages printed to the Console Window have the highest priority and become
immediately noticeable to the user.

The allocation of message types to logging sinks is depicted in the table below.

Message Type Ozone Console Debug Console Logfile

Error x x x
Warning (important) x x x
Info (important) x x x
Warning x x
Info x x

3.12.4    Debug Console
When Ozone is started with command line argument –debug, a debug console will open
next to the Main Window. The debug console displays all application messages of lower
significance that would otherwise only be visible to the software developer.

3.12.5    Application Logfile
The global logfile storing all application messages is disabled per default. It can be enabled
via command line argument –logfile <path> (see Command Line Arguments on page 180).

3.12.6    Other Logfiles
Messages output to the Console Window or Terminal Window can additionally be logged to
a separate logfile (see Project.SetConsoleLogFile on page 230 and Project.SetTerminal-
LogFile on page 231).
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Chapter 4
 
Debug Information Windows

This chapter provides individual descriptions of Ozone’s 22 debug information windows,
starting with the Breakpoint Window.
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4.1    Breakpoints/Tracepoints Window
Ozone’s Breakpoints/Tracepoints Window lists all breakpoints, data breakpoints and trace-
points that have been set by the user during the current debug session.

For reasons of simplicity, the terms breakpoint and tracepoint are used interchangeably
in this section.

4.1.1    Breakpoint Properties
The Breakpoint Window displays the following information about breakpoints:

Column Description

State Indicates if the breakpoint is enabled or disabled.
Type One of CODE, DATA, TRACE_START and TRACE_STOP.
Location Source line or instruction address location.

Extras

Lists all advanced breakpoint properties that are set to non-default
values. Advanced breakpoint properties are summarized in Advanced
Breakpoint Properties on page 142 and Data Breakpoint Attributes
on page 144. Tracepoints do not carry advanced properties.

4.1.2    Derived Breakpoints
Source breakpoints can be expanded in order to reveal their derived instruction breakpoints
(see Derived Breakpoints on page 71).

4.1.3    Breakpoint Dialog

The breakpoint dialog allows users to place break-
points on:
• Memory addresses of machine instructions
• Source code lines
• Functions and other code symbols such as

assembly code labels

Source Line Input

Source code lines are specified in a predefined format
(see Source Code Location Descriptor on page 168).

Opening the Breakpoint Dialog

The Breakpoint Dialog can be accessed via the con-
text menu of the Breakpoint Window.
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4.1.4    Editing Breakpoints Programmatically
Ozone provides multiple user actions that allow users to edit breakpoints inside script func-
tions or at the command prompt (see Breakpoint Actions on page 190 and Trace Actions
on page 194).

4.1.5    Context Menu
The Breakpoint Window’s context menu hosts the following actions (see Breakpoint Actions
on page 190):

Clear

Clears the selected breakpoint.

Enable / Disable

Enables or disables the selected breakpoint.

Edit

Edits advanced properties of the selected Breakpoint
such as its trigger condition (see Breakpoint Proper-
ties Dialog on page 58).

View Source

Displays the source code line associated with the se-
lected breakpoint. This action can also be triggered by double-clicking a table row.

View Disassembly

Displays the assembly code line associated with the selected breakpoint.

Set Breakpoint...

Opens the Breakpoint Dialog (see Breakpoint Dialog on page 71).

Set Data Breakpoint...

Opens the Data Breakpoint Dialog (see Data Breakpoint Dialog on page 57).

Set Tracepoint...

Opens the Tracepoint Dialog.

Clear All

Clears all breakpoints.

4.1.6    Offline Breakpoint Modification
Breakpoints can be modified even when the target connection was not yet established.

4.1.7    Table Window
The Breakpoint Window shares multiple features with other table-based debug information
windows (see Table Windows on page 49).
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4.2    Call Graph Window
Ozone’s Call Graph Window informs about the application’s function call paths and stack
usage.

4.2.1    Overview
Each table row of the Call Graph Window provides information about a single function call.
The top-level rows of the call graph are populated with the program’s entry point functions.
Individual functions can be expanded in order to reveal their callees.

4.2.2    Table Columns

Name

Name of the function.

Stack Total

The maximum amount of stack space used by any call path that originates at the function,
including the function’s local stack usage.

Stack Local

The amount of stack space used exclusively by the function.

Depth

The maximum length of any non-recursive call path that originates at the function.

Called From

Source code location of the function call.

Call Site PC

Instruction memory location of the function call.
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4.2.3    Table Window
The Call Graph Window shares multiple features with other table-based debug information
windows provided by Ozone (see Table Windows on page 49).

4.2.4    Uncertain Values
A plus (+) sign that follows a table value indicates that the value is not exact but rather a
lower bound estimate of the true value. A trailing “R” or “FP” further indicates the reason
for the uncertainty. R stands for recursion and FP stands for function pointer call.

4.2.5    Recursive Call Paths
In order to obtain meaningful values for recursive call paths, the Call Graph Window only
evaluates these paths up to the point of recursion. This means that the total stack usage
and depth values obtained for recursive call paths are only lower bound estimates of the
true values (see Uncertain Values on page 74).

4.2.6    Function Pointer Calls
The Call Graph Window is able to detect function calls via function pointers. Currently, these
calls are restricted to be leaf nodes of the call graph. A function pointer call is indicated
by the display name “<fp-call>”.

4.2.7    Context Menu

View Call Site

Displays the call location of the selected function within the Source Viewer (see Source
Viewer on page 118). This action can also be triggered by double-clicking a table row.

View Implementation

Displays the implementation of the selected func-
tion within the Source Viewer (see Source Viewer
on page 118).

Show path with max stack usage

Expands all table rows on the call path with the
highest stack usage.

Group By Root Functions

Indicates if the top-level shows root functions on-
ly, i.e. functions that are not called by any other functions. If unchecked, the top level
shows all program functions.

Group Callees

Displays all calls made to the same function as a single table row.

Expand All / Collapse All

Expands or collapses all top-level entry point functions.

4.2.8    Accelerated Initialization
The Call Graph Window employs an optimized initialization routine when the ELF program
file provides address relocation information. Please consult your compiler’s user manual for
information on how to include address relocation information in the output file (GCC uses
the compile switch -q).
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4.3    Call Stack Window
Ozone’s Call Stack Window displays the function call sequence that led to the current pro-
gram execution point.

4.3.1    Overview
The topmost entry of the Call Stack Window informs about the current program execution
point. Each of the other entries displays information about a previous program execution
point. As an example consider the illustration above. Here, the fourth row describes the
program context that was attained when the PC was within function LCD_X_DisplayDriver
on the instruction that called function _InitController.

4.3.2    Table Columns
The Call Stack Window partitions program execution point information into 5 columns:

Table Column Description

Function The calling function’s name.
Stack Info Size and position of the stack frame of the calling function.
Source Source code location of the function call.
PC Instruction address of the function call (call site PC).

Return Address
PC that will be attained when the program returns from the function
call. This field is actually displayed as “location:value”, where “loca-
tion” is the target data location of the return address.

Note

A call site that the debugger cannot affiliate with a source code line is displayed as
the address of the machine instruction that caused the branch to the called function.

4.3.3    Unwinding Stop Reasons
The reason why call stack unwinding stopped is displayed at the bottom of the stack. Section
Errors and Warnings on page 185 gives possible causes of, and solutions to, incomplete
call stacks.

4.3.4    Active Call Frame
By selecting a table row within the Call Stack Window, the affiliated call frame becomes
the active program execution point context of the debugger. At this point, the Register and
Local Data Windows display content no longer for the current PC, but for the active call
frame. The active frame can be distinguished from the other frames in the call stack by
its color highlight.
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4.3.5    Context Menu
The Call Stack Windows’s context menu hosts actions that navigate to a call site’s source
code or assembly code line (see View Actions on page 195).

View Source

Displays the selected call site within the Source Viewer (see Source Viewer on page 118).
This action can also be triggered by double-clicking a table row.

View Disassembly

Displays the selected call site within the Disassembly Window (see Disassembly Window
on page 89).

Current Frame On Top

Selects the ordering of the frames on the call stack.

4.3.6    User Preferences
The table below lists all users preferences pertaining to the call stack (see Edit.Preference
on page 203).

User Preference Description

PREF_CALLSTACK_LAYOUT
Specifies if the current frame is displayed at the top
or at the bottom of the call stack (see User Prefer-
ence Identifiers on page 175).

PREF_CALLSTACK_DEPTH_LIMIT
Selects the maximum amount of frames the call
stack can hold.

4.3.7    Table Window
The Call Stack Window shares multiple features with other table-based debug information
windows (see Table Windows on page 49).
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4.4    Code Profile Window
Ozone’s Code Profile Window displays runtime code statistics of the application being de-
bugged.

4.4.1    Setup
Section Setting Up Trace on page 152 explains how to configure Ozone and the hardware
setup for instruction trace, thereby enabling the Code Profile Window.

4.4.2    Code Statistics
The Code Profile Window displays 4 different code statistics about program entities. A pro-
gram entity is either a source file, a function, an executable source line or a machine in-
struction. Table items can be expanded to show the contained child entities.

Instruction Coverage

Amount of machine instructions of the program entity that have been covered since code
profile data was reset. A machine instruction is considered covered if it has been “fully”
executed. In the case of conditional instructions, “full execution” means that the condition
was both met and not met. In the title figure, 99.7% or 310 of 311 machine instructions
within function main were covered.

Source Coverage

Amount of executable source code lines of the program entity that have been covered since
code profile data was reset. An executable source code line is considered covered if all of its
machine instructions were fully executed. In the title figure, 98.7% or 78 of 79 executable
source codes lines within function main were covered.

Run Count

Amount of times a program entity was executed since code profile data was reset.
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Load

Amount of instruction fetches that occurred within the program entities address range di-
vided by the total amount of instruction fetches that occurred since code profile data was
reset.

Fetch Count

Amount of instruction fetches that occurred within the address range of the program entity.

4.4.3    Execution Counters
The execution count, coverage and load information can be shown in the Code Windows,
as well. For more information, refer to Execution Counters on page 78.

4.4.4    Table Window
The Code Profile Window shares multiple features with other table-based debug information
windows (see Table Windows on page 49).

4.4.5    Filters
Individual program entities can be filtered from the code profile statistic. In particular, there
are two different type of filters that can be applied to program entities, as described below.

Profile Filter

When a profile filter is set on a program entity, its CPU load is filtered from the code profile
statistic. After filtering, the load column displays the distribution of the remaining CPU load
across all none-filtered program entities.

Coverage Filter

When a coverage filter is set on a program entity, its code coverage value is filtered from the
code profile statistic. After filtering, the code coverage columns displays coverage values
computed as if the filtered program entities do not exist.

4.4.5.1    Adding and Removing Profile Filters
A profile filter can be set and removed via user actions Profile.Exclude and Profile.Include
(see Code Profile Actions on page 190). In Addition, the load column of the Code Profile
Window provides a checkbox for each item that allows users to quickly set or unset the
filter on the item.

4.4.5.2    Adding and Removing Coverage Filters
A coverage filter can be set and removed via user actions Coverage.Exclude and Cov-
erage.Include (see Code Profile Actions on page 190). In Addition, the code coverage
columns of the Code Profile Window provide a checkbox for each item that allows users to
quickly set or unset the filter on the item.

4.4.5.3    Filtering Code Alignment Instructions
Compilers may place alignment instructions into program code that have no particular oper-
ation and do never get executed. These so-called NOP-instructions can be filtered from the
code coverage statistic via context menu entry “Filter All NOP Instructions” or programmat-
ically via user action Coverage.ExcludeNOPs (see Coverage.ExcludeNOPs on page 233).

4.4.5.4    Observing the List of Active Filters
The Code Profile Filter Dialog can be accessed from the context menu and displays all filters
that were set, alongside the affiliated user action commands that were executed.

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH



79 CHAPTER 4 Code Profile Window

4.4.6    Context Menu

The context menu of the Code Profile Window
provides the following actions:

View Source

Displays the selected item within the Source
Viewer (see Source Viewer on page 118).

View Disassembly

Displays the selected item within the Disas-
sembly Window (see Disassembly Window on
page 89).

Include/Exclude from

Filters or unfilters the selected item from the
load, code coverage or both statistics.

Exclude All NOP Instructions

Excludes all “no operation” (code alignment)
instructions from the code coverage statistic.

Exclude (Dialog)

Moves multiple items to the filtered set (see
Profile.Exclude on page 231).

Include (Dialog)

Removes multiple items from the filtered set (see Profile.Include on page 232).

Remove All Filters

Removes all filters.

Show Filters

Opens a dialog that displays an overview of the currently active filters.

Reset Execution Counters

Resets all execution counters (see Execution Counters on page 78).

Show Execution Counters in Source

Displays execution counters within the Source Viewer (see Source Viewer on page 118).

Show Execution Counters in Disassembly

Displays execution counters within the Disassembly Window (see Disassembly Window on
page 89).

Group by Files

Groups all functions into expandable source file nodes.

Sort Respects Filters

When this option is checked, filtered items are moved to the bottom of the table.
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Parent Relative Load

When this option is checked, the CPU load of a table item is calculated as the total amount of
instructions executed within the item divided by the total amount of instructions executed
within the parent item. Otherwise, the total amount of instructions executed is used as
the divisor.

Export

Opens the Code Profile Report Dialog (see Code Profile Report Dialog on page 65).

4.4.7    Selective Tracing
Ozone can instruct the target to constrain trace data output to individual address ranges
(see Tracepoints on page 154). When selective tracing is active, it acts as a hardware
prefilter of code profile data.
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4.5    Console Window
Ozone’s Console Window displays application- and user-induced logging output.

4.5.1    Command Prompt
The Console Window contains a command prompt at its bottom side that allows users to
execute any user action that has a text command (see User Actions on page 35). It is
possible to control the debugger from the command prompt alone.

4.5.2    Message Types
The type of a console message depends on its origin. There are three different message
sources and hence there are three different message types. The message types are de-
scribed below.

4.5.2.1    Command Feedback Messages
When a user action is executed − be it via the Console Window’s command prompt or any
of the other ways described in Executing User Actions on page 35 − the action’s command
text is added to the Console Window’s logging output. This process is termed command
feedback. When the command is entered erroneously, the command feedback is highlighted
in red.

Window.Show(“Console”);

4.5.2.2    J-Link Messages
Control and status messages emitted by the J-Link firmware are a distinct message type.

J-Link: Device STM32F13ZE selected.

4.5.3    Script Function Messages
The user action Util.Log outputs a user-supplied message to the Console Window. Util.Log
can be used to output logging messages from inside script functions (see Util.Log on
page 213).

Executing Script Function “BeforeTargetConnect”.

4.5.4    Message Colors
Messages printed to the Console Window are colored according to their type. The message
colors can be adjusted via user action Edit.Color (see Edit.Color on page 204) or via the
User Preference Dialog (see User Preference Dialog on page 52).
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4.5.5    Context Menu
The context menu of the Console Window provides the following actions:

Copy

Copies the selected text to the clipboard.

Select All

Selects all text lines.

Clear

Clears the Console Window.

Commands

Prints the command help.

4.5.6    Command Help
When user action Help.Commands is executed, a quick facts table on all user actions in-
cluding their commands, hotkeys, and purposes is printed to the Console Window (see
Help.Commands on page 220). The command help can be triggered from the Console
Window’s context menu or from the main menu (Help → Commands).

Command help displayed within the Console Window
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4.6    Data Graph Window
Ozone’s Data Graph Window traces the values of expressions over time (see Expressions
on page 181).

4.6.1    Overview
The Data Graph Window employs J-Link’s High-Speed Sampling (HSS) API to trace the val-
ues of user-defined expressions at time resolutions of up to 1 microseconds. The sampling
of expressions starts automatically each time the program is resumed and stops automat-
ically each time the program halts. Users simply have to add expressions to the window,
similarly to the use case of the Watched Data Window. For further information on HSS,
please consult the  J-Link User Guide .

4.6.2    Requirements
The Data Graph Window requires the target to support background memory access (BMA).

4.6.3    Window Layout
The Data Graph Window features three content panes − or views (3) − of which only one
is visible at any given time. The view can be switched by selecting the corresponding tab
within the tab bar (1). In addition, a toolbar (2) is provided that provides quick access to
the most important window settings.

4.6.4    Setup View
The Setup View allows users to assemble the list of expressions whose values are to be
traced while the program is running (see Expressions on page 181). An expression can
be added to the list in any of the following ways:
• via context menu entry Add Symbol.
• via user action Window.Add (see Window.Add on page 207).
• via the last table row that acts as an input field.
• by dragging a symbol from a symbol window or the Source Viewer onto the Setup View.

and removed from the list via:
• context menu entry Remove.
• user action Window.Remove (see Window.Remove on page 208).

A graphed expression must satisfy the following constraints:
• the expression must evaluate to a numeric value of size less or equal to 8 bytes.
• all symbol operands of the expression must be either static variables or constants.

4.6.4.1    Signal Statistics
Next to its editing functionality, the Setup View provides basic signal statistics for each
traced expression. The meanings of the displayed values are explained below.

Min, Max, Average

Minimum, maximum and average signal values.
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#Changes

The amount of times the signal value has changed between two consecutive samples.

Min. Change

The largest negative change between two consecutive samples of the symbol value.

Max. Change

The largest positive change between two consecutive samples of the symbol value.

4.6.4.2    Context Menu
The context menu of the Setup View provides the following actions:

Remove

Removes an expression from the window.

Display (All) As

Allows users to change the display format of the selected ex-
pression or all expressions.

Add Symbol

Opens an input box that lets users add an expression to the
window.

Remove All

Removes all expression from the window.

Clear Data

Clears the HSS sampling data, i.e. resets the window to its initial state.

4.6.5    Graphs View
The Graphs View displays the sampling data as graphs within a two-dimensional signal plot.
The signal plot provides multiple interactive features that allow users to quickly understand
the time course of expressions both on a broad and on a narrow time scale.
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4.6.5.1    Plot Legend

The plot legend links each graph to the affiliated expression. The
legend can be moved around the plot by dragging its title bar.
The context menu of the plot legend allows users to select in-
dividual graphs for display and to adjust the display colors of
graphs. Checkboxes are provided to toggle the display of individ-
ual graphs.

4.6.5.2    Sample Cursor

The origin of the timescale is attached to the sample cursor. The
sample cursor also marks the time position of the data sample that
is currently selected within the Samples View (see Samples View
on page 87). The sample cursor can be displaced by dragging it
to a new position or double-clicking on the signal plot.

Pinned Sample Cursor

The sample cursor can be pinned to a fixed window position via
context menu entry “Cursor”. When pinned to the window, the sample cursor will always
stay visible regardless of any view modification.

4.6.5.3    Hover Cursor

The hover cursor is a vertical line displayed below the mouse cursor that
follows the movements of the mouse. At the intersection point of the hover
cursor with each graph, a value box is displayed that indicates the graph’s
signal value at that position. Each value box has got an expansion indicator
that can be clicked to show or hide the value box.

4.6.5.4    Interaction

Timescale

The plot’s timescale is given as the time-distance between adjacent ver-
tical grid lines (time per div). The “time per divisor” can be increased or decreased in any
of the following ways:
• by scrolling the mouse wheel up or down
• by using the drop-down list displayed within the toolbar
• by selecting a timescale via the context menu

Mouse Zooming

When the mouse wheel is scrolled, the plot scales around the position of the mouse cursor.
Thus, by moving the mouse cursor to a plot position of interest and then scrolling the mouse
wheel, users can quickly and precisely zoom into regions of the signal plot.

Selection Zooming

By holding down the right mouse button and
moving the pointer, a selection rectangle is
drawn. When a plot region was selected, the
context menu entry “Fit Selection” can be
used to fit the selected region into view.

Mouse Panning

The signal plot can be displaced by clicking
on the plot and then dragging the clicked position to the left or to the right.
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Measuring Time Distances

A label is displayed next to the hover cursor that shows the time distance between the
positions of the hover and the sample cursor. By first positioning the sample cursor on a
point of interest and then moving the mouse cursor to another point of interest, the time
distance between these two positions can be precisely measured.

Vertical Auto-Scale

The scale of the y-axis cannot be changed randomly. Instead, the y-axis auto-scales at all
times so that all visible graphs fit completely into the available vertical window space.

Further interactive options are provided via the context menu, as summarized below.

4.6.5.5    Context Menu

The context menu of the Graphs View provides the following
actions:

Fit Width

Adjusts the timescale so that all graphs are visible and oc-
cupy the whole window width.

Fit Height

Adjusts the timescale so that all graphs are visible and oc-
cupy the whole window height.

Go To Cursor

Scrolls the Sample Cursor into view.

Go To Time

Opens a time input dialog that when accepted, sets the
Sample Cursor to the given time and scrolls it into view.

Clear Data

Clears all sampling data, effectively resetting all graphs.

Cursor

Pins the sample cursor to a fixed window position or unpins it.

Sampling Frequency

The frequency at which all expressions are sampled (see Sampling Frequency on
page 87).

Timescale

Timescale used to plot the graphs of expressions (see Timescale on page 87).

Clear Event

The debugging event upon which the signal plot is cleared (see Clear Event on page 88).

Draw Points

When checked, sampling data is visualized as points instead of continuous signal graphs.
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Uniform Sample Spacing

When checked, the timestamp of a graph sample is computed by multiplying the inverse
of the sampling frequency with the sample index. When unchecked, the timestamp given
by J-Link is used.

Toolbar

Toggles the toolbar.

4.6.6    Samples View
The Samples View displays the sampling data in a tabular fashion. Following two columns
that displays the index and timestamp of a sample, the remaining columns display the
values of each traced expression at the time the sample was taken.

The selected table row and the position of the Sample Cursor are automatically synchro-
nized: changing one will also change the other.

4.6.6.1    Context Menu

The context menu of the Samples View provides the following
actions:

Goto Time

Opens an input dialog that allows users to set the sample cursor
on a particular time position.

Export

Opens a file dialog that allows users to export the sampling data to a CSV file.

4.6.7    Toolbar
The Data Graph Window’s toolbar provides quick access to the most important window
settings (see Window Layout on page 83). The settings affiliated with each toolbar element
are described below, going from left to right on the toolbar.

4.6.7.1    Sampling Frequency
All expressions added to the Data Graph Window are sampled together at the same
points in time. This common sampling frequency is stored as Ozone’s system variable
VAR_HSS_SPEED. In addition to the Data Graph Window’s toolbar and context menu, the
sampling frequency can also be edited via the System Variable Editor (see System Variable
Editor on page 56) or programmatically via user action Edit.SysVar (see Edit.SysVar on
page 203).

4.6.7.2    Timescale
The timescale input box allows users to adjust the signal plot’s x-axis scale. The timescale
is given as the time distance between adjacent vertical grid lines (time per div). The “+”
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and “-” buttons on the right side of the toolbar can be used to increase or decrease the
timescale as well.

4.6.7.3    Clear Event
The toolbar’s “clear event” input box selects the debugging event upon which all HSS sam-
pling data is automatically cleared. The available options are:

Clear On Resume

Sampling data is cleared when program execution resumes or when the program is reset.

Clear On Reset

Sampling data is cleared when the program is reset.

Clear Never

Sampling data is never cleared automatically.

4.6.8    Power Graph Synchronization
Ozone keeps the sample cursors of the Data Graph Window and the Power Graph Window
synchronized at all times. This allows users to get a quick sense about which parts of
program code use how much power (see Cursor Synchronization on page 111).
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4.7    Disassembly Window
Ozone’s Disassembly Window displays the assembly code interpretation of target memory
content. The window automatically scrolls to the position of the program counter when
the program is stepped; this allows users to follow program execution on the machine
instruction level.

4.7.1    Assembly Code
Each standard text line of the Disassembly Window displays information about a particular
machine instruction. The instruction information is divided into 4 parts:

Address Encoding Mnemonic Operand

0800297C B538 PUSH {R3-R5,LR}

Instruction Encoding

The encoding of a machine instruction is identical to the data stored at the instruction’s
memory address. It is possible to toggle the display of instruction encodings (see Disas-
sembly Window Settings on page 53).

Syntax Highlighting

The Disassembly Window applies syntax highlighting to assembly code. The syntax high-
lighting colors can be adjusted via user action Edit.Color (see Edit.Color on page 204) or
via the User Preference Dialog (see User Preference Dialog on page 52).

4.7.2    Execution Counters
Within its sidebar area on the left, the Disassembly Window displays the execution counts
of individual instructions (see Execution Counters on page 89).

4.7.3    Base Address
The address of the first instruction displayed within the Disassembly Window is referred to
as the window’s base address.

4.7.3.1    Setting the Base Address
The base address of the Disassembly Window can be modified in any of the following ways:
• via context menu action GoTo.
• via user action View.Disassembly (see View.Disassembly on page 211).
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Note that user action View.Disassembly is accessible from the context menus of most sym-
bol windows.

4.7.3.2    Scrolling the Base Address
The base address of the Disassembly Window may be scrolled in any of the following ways:

Mouse Wheel Arrow Keys Page Keys Scroll Bar

4 Lines 1 Line 1 Page 1 Line

4.7.4    Context Menu

The Disassembly Window’s context menu provides the
following actions:

Set/Clear/Edit Breakpoint

Sets/Clears or Edits a breakpoint on the selected machine
instruction (see Instruction Breakpoints on page 142).

Set Tracepoint (Start/Stop)

Sets a tracepoint on the selected machine instruction (see
Tracepoints on page 154).

Set Next PC

Specifies that the selected machine instruction should be
executed next. Any instructions that would usually exe-
cute when advancing the program to the selected instruc-
tion will be skipped.

Run To Cursor

Advances the program execution point to the current cur-
sor position. All code between the current PC and the cursor position is executed.

View Source

Displays the first source code line that is associated with the selected machine instruction
(as a result of code optimization during the compilation phase, a single machine instruction
might be affiliated with multiple source code lines).

Goto PC

Scrolls the viewport to the PC line.

Goto Address

Sets the viewport to an arbitrary memory address. The address is obtained via an input
dialog that pops up when executing this menu item.

Show Execution Counters

Toggles the display of Execution Counters (see Execution Counters on page 89).

4.7.5    Offline Functionality
The disassembly window is functional even when Ozone is not connected to the target. In
this case, machine instruction data is read from the program file. In fact, disassembly is
only performed on target memory when the program file does not provided data for the
requested address range.
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4.7.6    Mixed Mode
The Disassembly Window provides two display options − Show Source and Show Labels −
that augment assembly code text lines with source code and symbol information, respec-
tively. These display options can be adjusted via the context menu or the User Preference
Dialog (see User Preference Dialog on page 52).

4.7.7    Code Window
The Disassembly Window shares multiple features with Ozone’s second code window, the
Source Viewer. Refer to Code Windows (see Code Windows on page 45) for a shared de-
scription of these windows.
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4.8    Find Results Window
Ozone’s Find Results Window displays the results of previous text searches.

4.8.1    Search Results
The Find Results Window displays the results of text searches as a list of source code
locations that matched the search string. The search settings itself are displayed in the first
row of the search result text.

4.8.2    Text Search
A new text pattern search is performed using the Find Dialog (see Find Dialog on page 61).

4.8.3    Context Menu
The Find Results Window’s context menu provides the following actions:

Copy

Copies the selected text to the clipboard.

Show In Editor

Displays the selected match result in the Source Viewer. The same operation is performed
by double-clicking on a match result.

Select All

Selects all text lines.

Clear

Clears the Find Results Window.

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH



93 CHAPTER 4 Functions Window

4.9    Functions Window
Ozone’s Functions Window lists all functions linked to assemble the debuggee, including
functions implemented within external code.

4.9.1    Function Properties
The Functions Window displays the following information about functions:

Table Column Description

Name Name of the function.
Line Line number of the function’s first source code line.
File Source code document that contains the function.
Address Range Memory address range covered by the function’s machine code.

4.9.2    Inline Expanded Functions
A function that is inline expanded in one or multiple other functions can be expanded and
collapsed within the Functions Window to show or hide its expansion sites. As an example,
consider the figure above. Here, function _InlineMultiple has one expansion site: it is inline
expanded within function _DescentTree.

4.9.3    Breakpoint Indicators
A breakpoint icon proceeding a function name indicates that one or multiple breakpoints
are set within the function.

4.9.4    Context Menu
The Function Windows’ context menu hosts actions that navigate to a function’s source
code or assembly code line (see View Actions on page 195).

Set Clear Breakpoint

Sets or clears a breakpoint on the function’s first machine instruction.

View Source

Displays the first source code line of the selected function within the Source Viewer (see
Source Viewer on page 118). If an inline expansion site is selected, this site is shown
instead.

View Disassembly

Displays the first machine instruction of the selected function within the Disassembly Win-
dow (see Disassembly Window on page 89). If an inline expansion site is selected, this
site’s first machine instruction is displayed instead.
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View Call Graph

Displays the call graph of the function within the Call Graph Window (see Call Graph Window
on page 73).

4.9.5    Table Window
The Function Window shares multiple features with other table-based debug information
windows (see Table Windows on page 49).
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4.10    Global Data Window
Ozone’s Global Data Window displays global program variables.

4.10.1    Data Breakpoint Indicator
A breakpoint icon preceding a global variable’s name indicates that a data breakpoint is
set on the variable.

4.10.2    Context Menu
The Global Data Window’s context menu provides the following actions:

Set/Clear Data Breakpoint

Sets or clears a data breakpoint on the selected global
variable (see Data Breakpoints on page 144).

Edit Data Breakpoint

Opens the Data Breakpoint Dialog (see Data Breakpoint
Dialog on page 57).

Watch

Adds the selected global variable to the Watched Data
Window (see Watched Data Window on page 130).

View Source

Displays the source code declaration location of the selected global variable in the Source
Viewer (see Source Viewer on page 118).

View Data

Displays the data location of the selected local variable in either the Memory Window
(see Memory Window on page 104) or the Register Window (see Register Window on
page 113).

Display (All) As

Changes the display format of the selected global variable or of all global variables (see
Display Format on page 44).

Expand / Collapse All

Expands or collapses all top-level nodes.
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4.10.3    Table Window
The Global Data Window shares multiple features with other table-based debug information
windows provided by Ozone (see Table Windows on page 49).
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4.11    Instruction Trace Window
Ozone’s Instruction Trace Window displays the history of executed machine instructions.

4.11.1    Setup
Section Setting Up Trace on page 152 explains how to configure Ozone and the hardware
setup for trace, thereby enabling the Instruction Trace Window.

4.11.2    Instruction Row
The information displayed within a single text line of the Instruction Trace Window is par-
titioned in the following way:

Timestamp Address Encoding Mnemonic Operands

0.000 100 005 0800297C B538 PUSH {R3-R5,LR}

4.11.3    Instruction Stack
The Instruction Trace Window displays the program’s instruction execution history as a
stack of machine instructions. The instruction at the bottom of the stack has been executed
most recently. The instruction at the top of the stack was executed least recently. The
instruction stack is rebuilt when the program is stepped or halted. Please note that the
PC instruction is not the bottommost instruction of the stack, as this instruction has not
yet been executed.

4.11.4    Call Frame Blocks
The instruction stack is partitioned into call frame blocks. Each call frame block contains the
set of instructions that were executed between entry to and exit from a program function.
Call frame blocks can be collapsed or expanded to hide or reveal the affiliated instructions.
The number of instructions executed within a particular call frame block is displayed on the
right side of the block’s header.

4.11.5    Backtrace Highlighting
Both code windows highlight the instruction that is selected within the Instruction Trace
Window. This allows users to quickly understand past program flow while key-navigating
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through instruction rows. The default color used for backtrace highlighting is yellow and
can be adjusted via user action Edit.Color (see Edit.Color on page 204) or via the User
Preference Dialog (see User Preference Dialog on page 52).

4.11.6    Hotkeys
The Instruction Trace Window provides multiple hotkeys to navigate instruction rows. The
table below gives an overview.

Hotkey Function

Right or + Expands the currently selected function node.

Left or − Collapses the currently selected function node. If an instruction is se-
lected, the function containing the selected instruction is collapsed.

Up Selects and scrolls to the next instruction.
Down Selects and scrolls to the previous instruction.

Shift+Up Selects and scroll to the last (topmost) instruction of the currently se-
lected call frame block.

Shift+Down Selects and scroll to the first (bottommost) instruction of the current-
ly selected call frame block.

PgUp Scrolls one page up.
PgDn Scrolls one page down.

4.11.7    Context Menu

The context menu of the Instruction Trace Window pro-
vides the following operations:

Set / Clear Breakpoint

Sets or clears a breakpoint on the selected instruction.

Set Tracepoint (Start/Stop)

Sets a tracepoint on the selected machine instruction
(see Tracepoints on page 154).

View Source

Displays the source code line associated with the select-
ed instruction in the bref{Source Viewer}

View Disassembly

Displays the selected instruction in the Disassembly Win-
dow (see Disassembly Window on page 89)

Toggle Reference

Toggles the time reference point on the selected instruc-
tion.

Go To Reference

Scrolls to the time reference point preceding the selected instruction.

Clear All References

Clears all time reference points
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Block Start/End

Scrolls to the first/last instruction of the selected call frame.

Expand/Collapse All

Expands/Collapses all call frame blocks.

Instruction Encodings

Toggles the display of instruction encodings.

Timestamps

Selects the timestamp display format (nanoseconds, CPU cycles, instruction count or off).

Export

Opens a dialog that allows users to export the window contents to a CSV file.

4.11.8    Selective Tracing
Ozone can instruct the target to constrain trace data output to individual address ranges
(see Tracepoints on page 154). When selective tracing is active, it acts as a hardware
prefilter of trace data.

4.11.9    Export
Opens a dialog that can be used to export the contents of the Instruction Trace Window to
a CSV file. The same can be achieved programmatically by executing command Trace.Ex-
portCSV.

4.11.10    Automatic Data Reload
The Instruction Trace Window automatically adds more trace data to the instruction stack
each time the editor is scrolled up and the first row becomes visible.

4.11.11    Limitations
The Instruction Trace Window currently cannot be used in conjunction with the Terminal
Window’s printf via SWO feature.
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4.12    J-Link Control Panel
The J-Link Control Panel displays the state of the debug probe and the state of ongoing
data transmissions between the target and the host PC. The control panel also allows users
to edit basic debug probe settings.

4.12.1    Overview
The J-Link control panel categorizes J-Link settings into multiple groups as summarized
below.

Control Panel Group Description

General Displays J-Link status information

Settings Provides basic settings such as the log file and flash break-
points.

Breakpoints Displays the target’s breakpoint, data breakpoint, and vector
catch state.

RTT Displays RTT output and provides basic RTT control settings.
Log Displays the contents of the J-Link logfile.
CPU Regs Displays the state of the target’s core registers.

Target Power Allows users to configure power output to the target and
shows the power status of the target.

SWV Displays data that was received on the serial wire viewer
from the target.

RAWTrace Displays unprocessed ETM trace data received from the tar-
get.

STrace Displays processed ETM trace data.
LiveTrace Displays the streaming trace session status.
Flash Displays information about the target’s flash memory range.

Note

The control panel maintains a private communication channel with the debug probe. Ozone
is not notified about setting changes undertaken within the control panel. As Ozone main-
tains an internal state of J-Link settings, editing settings via the control panel may cause the
debugger to attain an inconsistent state and display erroneous behavior. For this reason,
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users are advised to edit J-Link settings via the J-Link Settings Dialog (see J-Link Settings
Dialog on page 59) or Ozone API commands (see User Actions on page 35) only.
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4.13    Local Data Window
Ozone’s Local Data Window displays local variables and function parameters.

4.13.1    Overview
The Local Data Window allows users to inspect the local variables of any function on the
call stack. To change the Local Data Window’s output to an arbitrary function on the call
stack, the function must be selected within the Source Viewer or the Call Stack Window.
Once the program is stepped, the output will switch back to the current function.

4.13.2    Auto Mode
The Local Data Window provides an “auto mode” display option; when this option is active,
the window displays all global variables referenced within the current function alongside
the function’s local variables. Auto mode is inactive by default and can be toggled from
the window’s context menu.

4.13.3    Context Menu

The Local Data Window’s context menu provides the fol-
lowing actions:

Set / Clear Data Breakpoint

Sets a data breakpoint on the selected symbol or clears
it (see Data Breakpoints on page 144).

Edit Data Breakpoint

Opens the Data Breakpoint Dialog (see Data Breakpoint
Dialog on page 57).

Watch

Adds the selected local variable to the Watched Data
Window (see Watched Data Window on page 130).

View Source

Displays the source code declaration location of the selected local variable in the Source
Viewer (see Source Viewer on page 118).

View Data

Displays the data location of the selected local variable in either the Memory Window
(see Memory Window on page 104) or the Register Window (see Register Window on
page 113).
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Display (All) As

Changes the display format of the selected symbol or of all symbols (see Display Format
on page 44).

Expand / Collapse All

Expands or collapses all top-level nodes.

Auto Mode

Specifies whether the “auto mode” display option is active (see Auto Mode on page 102).

4.13.4    Data Breakpoint Indicator
A breakpoint icon preceding a local variable’s name indicates that a data breakpoint is set
on the variable.

4.13.5    Table Window
The Local Data Window shares multiple features with other table-based debug information
windows provided by Ozone (see Table Windows on page 49).
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4.14    Memory Window
Ozone’s Memory Window displays target memory content.

4.14.1    Window Layout
The memory window displays target memory content in two different formats:

Hex Section

The central data section displays memory content as hexadecimal values. The value block
size can be adjusted to 1, 2 or 4 bytes. In the illustration above, the display mode is set
to 2 bytes per block value.

Text Section

The data section on the right side of the Memory Window displays the textual interpretation
(Latin1-decoding) of target memory data.

4.14.2    Base Address
The address of the first byte displayed within the Memory Window is referred to as the
window’s base address.

4.14.3    Setting the Base Address
The base address of the Memory Window can be set in any of the following ways:
• via user action View.Data (see View.Data on page 210).
• via the goto-dialog accessible from the context menu.
• via the toolbar’s input box.

In each case, the following input formats are understood:

Input Format Example

Address 0x20000000

Address range 0x20000000, 0x200
Symbol OS_Global

Register Name SP

Expression OS_Global->pTask + 0x4

For details on supported expressions, see Expressions on page 181. When the base ad-
dress input has a deducible byte size, the corresponding address range is selected and
highlighted.
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4.14.3.1    Scrolling the Base Address
The base address can be scrolled in any of the ways depicted in the table below.

Mouse Wheel Arrow Keys Page Keys Scroll Bar

4 Lines 1 Line 1 Page 1 Line

4.14.4    Symbol Drag & Drop
The Memory Window accepts drops of symbol and register window items. When an item is
dropped onto the window, the item’s address range is highlighted and scrolled into view.

4.14.5    Toolbar

The Memory Window’s toolbar provides quick access to the window’s options. All toolbar
actions can also be accessed via the window’s context menu. The toolbar elements are
described below.

Address Box

The toolbar’s address box provides a quick way of modifying the base address, i.e. the
memory address of the first byte that is displayed within the Memory Window. When a
pointer expression is input into the address box, the Memory Window automatically scrolls
to the address pointed to each time it changes.

Access Width

The blue tool buttons allow users to specify the memory access width. The access width
determines whether memory is accessed in chunks of bytes (access width 1), half words
(access width 2) or words (access width 4).

Display Mode

The red tool buttons let users choose the display mode. There are three display modes that
correspond to the byte size of each hexadecimal value displayed within the hex section.
The display mode can be set to 1, 2 or 4 bytes per value.

Fill Memory

Opens the Fill Memory Dialog (see Generic Memory Dialog on page 60)

Save Memory Data

Opens the Save Memory Dialog (see Generic Memory Dialog on page 60)

Load Memory Data

Opens the Load Memory Dialog (see Generic Memory Dialog on page 60)

Update Interval

Opens the Auto Refresh Dialog (see Periodic Update on page 106).

4.14.6    Generic Memory Dialog
The Fill Memory, Save Memory and Load Memory features of the Memory Window are
implemented by the Generic Memory Dialog (see Generic Memory Dialog on page 105).

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH



106 CHAPTER 4 Memory Window

4.14.7    Change Level Highlighting
The Memory Window employs change level highlighting (see Change Level Highlighting on
page 106).

4.14.8    Periodic Update
The Memory Window is capable of periodically updating the displayed memory area at
a fixed rate. The refresh interval can be specified via the Auto Refresh Dialog that can
be accessed from the toolbar or from the context menu. The periodic refresh feature is
automatically enabled when the program is resumed and is deactivated when the program
is halted. It is globally disabled by clicking on the dialog’s disable button.

4.14.9    User Input
The current input cursor is shown as a blue box highlight. By pressing a nibble or text key, an
edit box will pop up over the selected hexadecimal value that allows the value to be edited.
Pressing enter will accept the changes and write the modified value to target memory.

4.14.10    Copy and Paste
The Memory Window allows users to select memory regions and copy the selected content
into the clipboard in one of multiple formats (see Context Menu on page 102). The current
clipboard content can be pasted into a target memory by setting the cursor at the desired
base address and then pressing hotkey Ctrl+V.

4.14.11    Context Menu
The Memory Window’s context menu provides the following actions:

Copy

Copies the text selected within the hex-section to the clip-
board.

Copy Special

A submenu with 4 entries:
• Copy Text: copies the selected text-section content to

the clipboard.
• Copy Hex: copies the selected hexadecimals in textual

format to the clipboard.
• Copy Hex As C-Initializer: copies the selected

hexadecimals as comma separated list in textual
format to the clipboard (e.g. “0xAB, 0x23, 0x00”)

• Copy Binary: copies the selected hexadecimals as
octet-8 raw binary data to the clipboard.

Display Mode

Sets the display mode to either 1, 2 or 4 bytes per hexa-
decimal block.

Access Mode

Sets the memory access width to either byte (1), half-
word (2) or word (4) access.

Fill

Opens the Fill Memory Dialog (see Generic Memory Dialog on page 105).
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Save

Opens the Save Memory Dialog (see Generic Memory Dialog on page 105).

Load

Opens the Load Memory Dialog (see Generic Memory Dialog on page 105).

Go To

Opens an input dialog that allows users to change the base address (see Base Address
on page 104).

Periodic Refresh

Opens the Auto Refresh Dialog from which the window’s periodic update interval can be
set (see Periodic Update on page 106).

Toolbar

Toggles the display of the window’s toolbar.

4.14.12    Multiple Instances
Users may add as many Memory Windows to the Main Window as desired.
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4.15    Memory Usage Window
Ozone’s Memory Usage Window displays the type and content hierarchy of target memory.

4.15.1    Overview
The Memory Usage Window’s main areas
of application are:

Identifying invalid memory usage

A program data symbol may have been
erroneously stored to a special-purpose
RAM region
such as a trace buffer. Another example
would be a function that was downloaded
to a non-executable memory area.

Identifying erroneous build settings

A linker may have placed program func-
tions outside the target’s FLASH
address range or program variables out-
side the RAM address range.

4.15.2    Requirements
The Memory Usage Window requires the
program file to be of ELF or compatible
format.

4.15.3    Window Layout
Memory regions are grouped into three
columns: segments, data sections, and
symbols.

Segments

The first column shown within the Mem-
ory Usage Window displays the memory
type. Usually, the target will have a flash
and a RAM segment which are displayed
here. When no memory segment infor-
mation was made available to the win-
dow, the segment column will be invisi-
ble.

Data Sections

The central column of the Memory Us-
age Window displays the arrangement of ELF file data sections within the containing seg-
ment.

Symbols

The right-hand column of the Memory Usage Window displays the arrangement of program
symbols (functions and variables) within the containing data section.
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4.15.4    Setup
Section and symbol regions are automatically initialized from ELF program file data when
the program file is opened. Segment information must be supplied via a map file (see
below).

4.15.4.1    Supplying Segment Information
Ozone obtains memory segment information from the memory map file that was set via
command Target.LoadMemoryMap (see Target.LoadMemoryMap on page 238). Individual
segments can be added to the memory map via command Target.AddMemorySegment (see
Target.AddMemorySegment on page 239).

4.15.5    Interaction
The Memory Usage Window provides multiple interactive features that allow users to quickly
understand the target’s memory map on a broad and narrow scale. The interactive features
are described below.

4.15.5.1    Scrolling
The address range currently displayed within the Memory Usage Window can be scrolled
in any of the following ways:
• via the window’s scrollbars.
• via the horizontal or vertical mouse wheel
• by clicking somewhere and dragging the clicked spot to a new location.

4.15.5.2    Zooming
The vertical scale of the memory usage plot is given as the number of bytes that fit into
view. The vertical scale can be adjusted in the ways described below.

ROI Zooming

When the mouse cursor is moved over the memory usage
plot while the left mouse button is held down, a selection
rectangle is shown. Once the mouse button is released, the
view will be scaled up (zoomed in) in order to match the
selected region. The ROI selection process can be canceled
using the ESC key.

Mouse Zooming

The view can be scaled around the mouse cursor position by scrolling the vertical mouse
wheel while holding down a control key. Using mouse wheel zooming, the region under the
cursor will not change position while the plot’s zoom level is adjusted.

Zooming via Hotkey

The view can be zoomed in or out by pressing the plus or minus key.

Double-Click Zooming

A double-click on a region fits the region into view.

4.15.6    Context Menu
The Memory Usage Window’s context menu provides the following actions:
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View Source

Shows the source code location of the selected memory region within the Source Viewer
(see Source Viewer on page 118).

View Disassembly

Shows the disassembly of with the selected memory region within the Disassembly Window
(see Disassembly Window on page 89).

View Data

Shows the selected memory region within the Memory Win-
dow (see Memory Window on page 104).

Zoom In

Increases the zoom level.

Zoom Out

Decreases the zoom level.

Show All Regions

Resets the zoom level so that all memory regions are fully visible.

Goto...

Opens an input dialog that allows users to input the address range or symbol name to
scroll to.
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4.16    Power Graph Window
Ozone’s Power Graph Window tracks the current drawn by the target and displays the
resulting graph in an interactive signal plot.

4.16.1    Hardware Requirements
The Power Graph Window requires the target to be powered by J-Link (over the debug
interface). Please refer to your MCU model’s user manual or contact SEGGER if unsure
about the capabilities of your target.

In case your target does not support power via J-Link, you may still want to check out
the capabilities of the Power Graph Window using SEGGER’s lightweight Cortex-M trace
reference board.

4.16.2    Setup
J-Link power output to the target is switched off per default. Therefore, Ozone must be
instructed to activate power output to the target before a target connection is established.
To do this, system variable VAR_TARGET_POWER_ON is provided. The expected way to enable
power output to the target is to add the statement

Edit.SysVar(VAR_TARGET_POWER_ON,1);

to project file function OnProjectLoad (see Event Handler Functions on page 160).

4.16.3    Usage
The Power Graph Window’s user interface and interaction possibilities are identical to that
of the Data Graph Window (see Data Graph Window on page 83). Please refer to the Data
Graph Window’s section in order to learn about using the Power Graph Window.

4.16.4    Cursor Synchronization
The sample cursors of the Power Graph and Data Graph windows are automatically syn-
chronized. Moving one of the cursors will also move the other.
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The synchronization of sample cursors allows users to establish a link between target power
consumption and program execution. In the example above, the debuggee switched 3 LED’s
on and off in short succession. Global variable NumLEDs was incremented or decremented
each time an LED was switched on or off. As can be seen, the target’s power consumption
is directly proportional to the number of active LEDs. The power graph trails the data graph
by around 50 us, which is expected as the LED register is written shortly after the global
variable is updated.
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4.17    Register Window

Ozone’s Register Window displays the core, FPU
and peripheral registers of the target.

4.17.1    SVD Files
The Register Window relies on  System View De-
scription  files (*.svd) that describe the regis-
ter set of the target. The SVD standard is wide-
ly adopted − many MCU vendors provide SVD
register set description files for their models.

Core, FPU and CP15 Registers

Ozone ships with an SVD file for each supported
ARM architecture profile. When users select a
target within the debugger, the register window
is automatically initialized with the proper SVD
file so that core, FPU, and CP15 registers are
displayed correctly.

Peripheral Registers

The SVD file describing the peripheral regis-
ter set of the target must be specified manu-
ally. For this purpose, user action Project.Ad-
dSvdFile is provided (see Project.AddSvdFile on
page 227). Ozone does not ship with peripher-
al SVD files out of the box; users have to obtain
the file from their MCU vendor.

4.17.2    Register Groups
The Register Window partitions target registers
into multiple groups:

Current CPU Registers

CPU registers that are in use given the current
operating mode of the target.

All CPU Registers

All CPU registers, i.e. the combination of all operating mode registers.

FPU Registers

Floating point registers. This category is only available when the target possesses a floating
point unit.

CP15 Registers

Coprocessor-15 registers. This category is only available when the target core contains a
CP15 unit.

Peripheral Registers

Memory mapped registers. This category is only available when a peripheral register set
description file was specified. (see SVD Files on page 113).
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4.17.3    Bit Fields

A register that does not contain a single value but rather one or multiple bit fields can
be expanded or collapsed within the Register Window so that its bit fields are shown

or hidden. Bit fields can be edited just like normal register values.

Flag Strings

A bit field register that contains only bit fields of length 1 (flags) displays the state of it’s
flags as a symbol string. These symbol strings are composed in the following way: the first
letter of a flag’s name is displayed uppercase when the flag is set and lowercase when it
is not set.

Editable Registers and Bit-Fields

Both registers and bit fields that are not marked as read-only within the loaded SVD file
can be edited.

4.17.4    Processor Operating Mode
An ARM processor’s current operating mode is displayed as the value of the current CPU
registers group (compare with the title figure). An ARM processor can be in any of 7 op-
erating modes:

USR SVC ABT IRQ FIQ SYS UND

User Supervisor Abort Interrupt Fast IRQ System Undefined

ARM processor operating modes

4.17.5    Context Menu

The Register Windows’s context menu provides the follow-
ing actions:

View Source

Displays the source code line affiliated with the register val-
ue (interpreted as instruction address).

View Disassembly

Displays the disassembly at the register value.

View Disassembly

Displays the memory at the register value (interpreted as
a memory address).

Display (All) As

Sets the display format of the selected item or the whole window.

Expand / Collapse All

Expands or collapses all top-level nodes.

Find Name

Scrolls to and selects a particular register.
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4.17.6    Table Window
The Register Window shares multiple features with other table-based debug information
windows provided by Ozone (see Table Windows on page 49).

4.17.7    Multiple Instances
Users may add as many Register Windows to the Main Window as desired.
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4.18    Source Files Window
Ozone’s Source Files Window lists the source files that were used to generate the debuggee.

4.18.1    Source File Information
The Source Files Window displays the following information about source files:

File

Filename. An icon preceding the filename indicates the file status.

Status

Indicates how the compiler used the source file to generate the debuggee. A source file
that contains program code is displayed as a “compiled” file. A source file that was used to
extract type definitions is displayed as an “included” file.

Size

Byte size of the program machine code encompassed by the source file.

#Insts

The number of instructions encompassed by the source file.

Path

File system path of the source file.

4.18.2    Unresolved Source Files
A source file that the debugger could not locate on the file system is indicated by a
yellow icon within the Source Files Window. Ozone supplies users with multiple options
to locate missing source files (see Locating Missing Source Files on page 151). The

user may also edit and correct file paths directly within the Source Files Window.

4.18.3    Context Menu
The context menu of the Source Files Window adapts to the selected file.

Open File

Opens the selected file in the Source Viewer (see Source Viewer on page 118). The same
can be achieved by double-clicking on the file.

Locate File

Opens a file dialog that lets users locate the selected file on the file system. This context
menu is displayed when the selected source file is missing.
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4.18.4    Table Window
The Source Files Window shares multiple features with other table-based debug information
windows (see Table Windows on page 49).
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4.19    Source Viewer
The Source Code Viewer (or Source Viewer for short) allows users to observe program
execution on the source-code level, set source breakpoints and perform quick adjustment
of the program code. Individual source code lines can be expanded to reveal the affiliated
assembly code instructions.

4.19.1    Supported File Types
The Source Viewer is able to display documents of the following file types:
• C source code files: *.c, *.cpp, *.h, *.hpp
• Assembly code files: *.s

4.19.2    Execution Counters
Within its sidebar area on the left, the Source Viewer displays the execution counts of
individual source lines and instructions (see Execution Counters on page 118).

4.19.3    Opening and Closing Documents
Documents can be opened via the file dialog (see File Menu on page 38) or programmatically
via user actions File.Open and File.Close (see File Actions on page 192).

4.19.4    Editing Documents
Ozone’s Source Viewer provides all standard text editing capabilities and keyboard short-
cuts. Please refer to section Key Bindings on page 120 for an overview of the key bindings
available for editing documents. It is advised to recompile the program following source
code modifications as source-level debug information may otherwise be impaired.
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4.19.5    Document Tab Bar

The document tab bar hosts a tab for each source code document that has been opened
in the Source Viewer. The tab of the visible (or active) document is highlighted. Users can
switch the active document by clicking on its tab or by selecting it from the tab bar’s drop-
down button. The drop-down button is located on the right side of the tab bar.

4.19.5.1    Tab Bar Context Menu
The tab bar’s context menu hosts two actions that can be used to close the active document,
or all documents but the active one.

4.19.6    Document Header Bar

The document header bar provides users with the ability to quickly navigate to a particular
function within the active document. The header bar hosts two drop-down lists. The drop-
down list on the left side contains all function scopes (namespaces or classes) present
within the active document. The drop-down list on the right side lists all functions that are
contained within the selected scope. When a function is selected, the corresponding source
line is highlighted and scrolled into view.

4.19.7    Expression Tooltips
When text is selected within the Source Viewer, it is evaluated as an expression and the
result is displayed in a tooltip (see Expressions on page 181).

4.19.8    Symbol Tooltips
By hovering the mouse cursor over a variable, the variable’s value is displayed in a tooltip.
Please note that this feature only works for local variables when the function that contains
the local variable is the active function of the Local Data Window. A function can be activated
by selecting it within the Source Viewer.

4.19.9    Expandable Source Lines
Each text line of the active source code document that contains executable code can be
expanded or collapsed to reveal or hide the affiliated machine instructions. Each such text
line is preceded by an expansion indicator that toggles the line’s expansion state. Further-
more, when the PC Line is expanded, the debugger’s stepping behavior will be the same
as if the Disassembly Window was the active code window (see Stepping Expanded Source
Code Lines on page 140).
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4.19.10    Key Bindings
This section gives an overview of the special-purpose and standard keys that can be used
with the Source Viewer.

Hotkeys

The table below provides an overview of the Source Viewer’s special-purpose key bindings.

Hotkey Description

Ctrl+Tab Selects the next document in the list of open documents.
Ctrl+Plus Expands the current line.
Ctrl+Minus Collapses the current line.
Alt+Plus Expands all lines within the current document.
Alt+Minus Collapses all lines within the current document.
Alt+Left Shows the previous location in the text cursor history.
Alt+Right Shows the next location in the text cursor history.
Ctrl+Wheel Adjusts the font size.

Special-Purpose key bindings of the Source Viewer

Standard Keys The table below provides an overview of the Source Viewer’s standard key
bindings. The Shift key can be held together with any of the below accelerators to extend
the text selection to the new cursor position.

Arrow key Moves the text cursor in the specified direction.

Page Up Moves the text cursor one page up.
Page Down Moves the text cursor one page down.
Home Moves the text cursor to the start of the line.
End Moves the text cursor to the end of the line.
Ctrl+Left Moves the cursor to the previous word.
Ctrl+Right Moves the cursor to the next word.
Ctrl+Home Moves the text cursor to the start of the document.
Ctrl+End Moves the text cursor to the end of the document.
F3 Finds the next occurrence of the current search string.
Ctrl+F3 Finds the next occurrence of the word under the cursor.

Standard key bindings of the Source Viewer

4.19.11    Syntax Highlighting
The Source Viewer applies syntax highlighting to source code. The syntax highlighting colors
can be adjusted via user action Edit.Color (see Edit.Color on page 204) or via the User
Preference Dialog (see User Preference Dialog on page 52).

4.19.12    Source Line Numbers
The display of source line numbers can be toggled by executing user action Edit.Preference
using parameter PREF_SHOW_LINE_NUMBERS (see Edit.Preference on page 203) or via the
User Preference Dialog (see User Preference Dialog on page 52).
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4.19.13    Context Menu
The Source Viewer’s context menu provides the following actions:

Set / Clear / Edit Breakpoint

Sets, clears or edits a breakpoint on the selected
source code line.

Break On Change

Sets a data breakpoint on the variable under the cur-
sor. The breakpoint is triggered when the variable’s
value changes.

Set Tracepoint (Start/Stop)

Sets a tracepoint on the selected source code line
(see Tracepoints on page 154).

Set Next Statement

Sets the PC to the first machine instruction of the se-
lected source code line. Any code between the cur-
rent PC and the selected instruction will be skipped,
i.e. will not be executed.

Run To Cursor

Advances program execution to the current cursor
position. All code between the current PC and the
cursor position is executed.

View Source

Jumps to the source code declaration location of the
symbol under the cursor.

View Disassembly

Displays the first machine instruction of the selected source code line in the Disassembly
Window (see Disassembly Window on page 89).

View Data

Displays the data location of the symbol under the cursor within the Memory Window (see
Memory Window on page 104).

View Call Graph

Displays the call graph of the function under the cursor within the Call Graph Window (see
Call Graph Window on page 73).

Watch

Adds the symbol under the cursor to the Watched Data Window (see Watched Data Window
on page 130).

Goto PC

Displays the PC line. If the source code document containing the PC line is not open or
visible, it is opened and brought to the front.

Goto Line

Scrolls the active document to the line number obtained from an input dialog.
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Expand / Collapse All

Expands or Collapses all expandable lines within the current document.

Select All

Selects all text lines.

Find

Displays a search dialog that lets users search for text occurrences within the active doc-
ument.

Numbering

Displays a submenu that allows users to specify the line numbering frequency.

Show Execution Counters

Toggles the display of Execution Counters (see Execution Counters on page 118).

4.19.14    Font Adjustment
The Source Viewer’s font can be adjusted by executing user action Edit.Font (see Edit.Font
on page 204) or via the User Preference Dialog (see User Preference Dialog on page 52).

Quick Adjustment of the Font Size

The font size can be quick-adjusted by scrolling the mouse wheel while holding down the
control key.

4.19.15    Code Window
The Source Viewer shares multiple features with Ozone’s second code window, the Dis-
assembly Window. Refer to Code Windows on page 45 for a shared description of these
windows.
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4.20    Terminal Window
Ozone’s Terminal Window provides bi-directional text IO between the debugger and the
debuggee.

4.20.1    Supported IO Techniques
The Terminal Window supports three communication techniques for transmission of textual
data from the debugger to the debuggee and vice versa that are described in Terminal IO
on page 148.

4.20.2    Terminal Prompt
The Terminal Window’s input text box is used to send textual data to the debuggee. The
terminal prompt is located at the bottom of the Terminal Window.

Input Termination

A string-termination character or a line break may be automatically appended to terminal
input before the text is sent to the debuggee. Input termination behavior can be adjusted
via the context menu or via user action Edit.Preference (see Edit.Preference on page 203).

Asynchronous Input

Typically, the debuggee will request user input via the Semihosting or the RTT technique
upon which users reply via the terminal prompt. However, textual data can also be sent to
the debuggee when there is no pending input request. In this case, the text will be stored
at the next free RTT memory buffer location.

4.20.3    Context Menu

The Terminal Window’s context menu provides the follow-
ing actions:

Copy

Copies the selected text to the clipboard.

Select All

Selects all text lines.

Clear

Clears the Terminal Window.

Clear On Reset

When checked, the window’s text area is cleared following
each program reset.
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Capture RTT

Indicates whether the Terminal Window captures text messages that are output by the
debuggee via SEGGER’s RTT technique.

Capture SWO

Indicates whether the Terminal Window captures text messages that are output by the
debuggee via the SWO interface.

Capture Semihosting IO

Indicates whether the Terminal Window listens to the debuggee’s Semihosting requests.

Zero-Terminate Input

Indicates if a string termination character (\0) is appended to user input before the input
is sent to the debuggee.

Echo Input

When checked, each terminal input is appended to the terminal window’s text area.

End Of Line Input

Specifies the type of line break to be appended to terminal input before the input is send
to the debuggee (see Newline Formats on page 172).
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4.21    Timeline Window
Ozone’s Timeline Window visualizes the course of the program’s call stack over time.

4.21.1    Setup
Section Setting Up Trace on page 152 explains how to configure Ozone and the hardware
setup for trace, thereby enabling the Timeline Window. In order to obtain a consistent
output when debugging multi-threaded applications, an OS-awareness plugin must have
been specified (see RTOS Awareness Plugin on page 134).

4.21.2    Overview
Each horizontal bar of the timeline plot represents a function invocation, or call frame. The
left and right boundaries of a call frame denote the points in time when the program entered
and exited the called function.

The current program execution point (PC) is located at the right side of the timeline plot.
Similar to the Code Windows, the PC is scrolled into view each time the program was
stepped or halted. When the program is halted, users may scroll the timeline plot to the
left in order to observe the call stack and execution path of the program at increasingly
past points in time. Trace data is automatically reloaded when timeline plot does not wholly
cover the window.

4.21.3    Exception Frames
An exception handler or interrupt service routine frame is painted with rounded corners
and a deeper color saturation level (see PendSV_Handler in the title figure).

4.21.4    Frame Tooltips
When the mouse cursor hovers over a call frame of the timeline plot, a tooltip pops up that
informs about distinct frame properties such as the amount of encompassed instructions.

4.21.5    Timescale
The timeline’s x-axis scale provides an overview of the time distances between timeline
events. The unit of the timescale can be toggled between the following options (see Context
Menu on page 123):
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Timescale Unit Description

Time The distance between timescale ticks is displayed in a time unit with a
nanosecond resolution.

Cycles The distance between timescale ticks is displayed in CPU cycles.
Instruction
Count

The distance between timescale ticks is displayed in number of in-
structions.

A fourth option “off” allows to hide the timescale.

4.21.6    Sample Cursor
The sample cursor marks the backtrace context instruction (see Backtrace Highlighting on
page 97). It also defines the position of the timescale origin. Next to the sample cursor, a
label showing its absolute time position is displayed.

Positioning the Sample Cursor

The sample cursor can be positioned by:
• double-clicking on the timeline plot
• dragging it to a new position
• pressing the left or right arrow key (+/- 1 instruction)
• pressing the left or right arrow key while holding down the shift key

(+/- 1 div)
• pressing the page up or page down key (+/- 1 page)
• pressing the home or end key

Pinned Sample Cursor

The sample cursor can be pinned to a fixed window position (see Context Menu on
page 123). When pinned to the window, the sample cursor will always stay visible regard-
less of any view modification.

4.21.7    Hover Cursor

The hover cursor follows the movements of the mouse over the Time-
line Window. The time position of the hover cursor, as well as the
time distance to the sample cursor, are displayed next to the hover
cursor.

4.21.8    Instruction Ticks
At high levels of zoom, vertical line indicators are displayed inside
of all call frames. Each neighbouring pair of these instruction ticks bound the start and end
of a single instruction execution.

In the example illustration to the right, the first instruction required 3
cycles to execute, while the following instructions were all executed in
a single cycle.

4.21.9    Backtrace Highlighting
Whenever the position of the sample cursor changes, the selected instruction is highlighted
and scrolled into view within the Code Windows and the Instruction Trace Window. Users
thus get a complete insight into the source code, disassembly and call stack context of any
instruction that is selected within the timeline.
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The sample cursor is synchronized with Ozone’s code and instruction windows.

The default color used for backtrace highlighting is yellow and can be adjusted via user
action Edit.Color (see Edit.Color on page 204) or via the User Preference Dialog (see User
Preference Dialog on page 52).

4.21.10    Task Context Highlighting
Instruction blocks that were executed by different threads of the target application are
distinguishable through the window background color. The task context highlighting feature
requires an OS-awareness-plugin to have been specified (see RTOS Awareness Plugin on
page 134).

Task Context Highlighting.
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4.21.11    Interaction

4.21.11.1    Panning
The timeline plot can be shifted horizontally or vertically by using the scrollbars or by clicking
on a window position and dragging the clicked position to a new location.

4.21.11.2    Zooming
The horizontal scale of the timeline plot can be increased or decreased in any of the following
ways:
• by scrolling the mouse wheel up or down
• by using the toolbar’s zoom slider
• by using the plus and minus buttons displayed within the toolbar

The vertical scale of the timeline plot is fixed.

4.21.11.3    Measuring Time Distances
The time distance between two timeline events can be measured by first setting the sample
cursor onto one event and then pointing with the hover cursor at the other; the hover cursor
label will then display the time distance between the events in the selected timescale unit.

4.21.12    Time Reference Points

To ease the measurement of time distances, the context menu provides an option to toggle
a time reference point at the position of the sample cursor. For each time reference point,
an additional label will be displayed next to the hover cursor that shows the time distance
between the hover cursor and the time reference point.

4.21.13    Settings
The following system variable settings are evaluated by the Timeline Window (see Edit.Sys-
Var on page 203):

Variable Description

VAR_TRACE_MAX_INST_CNT
Maximum number of instructions that can be processed
and displayed by the Timeline Window.

VAR_TRACE_CORE_CLOCK
Conversion factor used to convert execution times be-
tween CPU cycles and time units.
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4.21.14    Context Menu
The Timeline window’s context menu hosts the following actions:

Goto start/end of frame

Scrolls to the first/last instruction of the selected frame.

Goto next/previous function on level

Scrolls to the first/last instruction of the previous/next frame.

Goto next/previous execution of frame

Scrolls to the next/previous execution of the selected frame

Toggle Reference

Toggles the time reference point at the position of the sample cursor.

Go To Reference

Scrolls to the nearest time reference point preceding the selected instruction.

Clear All References

Clears all time reference points.

Go To Cursor

Scrolls the sample cursor into view (see Sample Cursor on page 126).

Cursor

Pins the Sample Cursor to a fixed window position.

Timestamps

Selects the timescale unit (nanoseconds, CPU cycles, instruction count or off).

Toolbar

Toggles the toolbar.
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4.22    Watched Data Window
Ozone’s Watched Data Window tracks the values of C-style expressions that the user chose
for explicit observation (see Expressions on page 181).

4.22.1    Adding Expressions
An expression can be watched, i.e. added to the Watched Data Window, in any of the
following ways:
• via context menu entry Watch of any symbol window.
• via user action Window.Add (see Window.Add on page 207).
• via context menu entry “Watch…” that opens an input dialog.
• by dragging a symbol onto the window.

4.22.2    Local Variables
The Watched Data Window supports expressions that contain local variables. An expression
containing a local variable that is out of scope, i.e. whose parent function is not the current
function, displays the location text “out of scope” within the Watched Data Window.

4.22.3    Live Watches
The Watched Data Window supports live updating of hosted expressions while the program
is running. Each expression can be assigned an individual update frequency via the windows
context menu or programmatically via user action Edit.RefreshRate (see Edit.RefreshRate
on page 205).

Note

The live watches feature requires the target to support background memory access
or the connected J-Link debug probe to support BMA emulation.

4.22.4    Table Window
The Watched Data Window shares multiple features with other table-based debug informa-
tion windows provided by Ozone (see Table Windows on page 49).

4.22.5    Context Menu
The Watched Data Window’s context menu provides the following actions:

Remove

Removes an expression from the window.

Set/Clear Data Breakpoint

Sets a data breakpoint on the selected expression or clears it (see Data Breakpoints on
page 144).
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Edit Data Breakpoint

Opens the Data Breakpoint Dialog (see Data Breakpoint Dialog on page 57).

View Source

Displays the source code declaration location of the selected variable in the Source Viewer
(see Source Viewer on page 118).

View Data

Displays the data location of the selected variable in either the Memory Window (see Mem-
ory Window on page 104) or the Register Window (see Register Window on page 113).

Display (All) As

Changes the display format of the selected item or of all
items (see Display Format on page 44).

Refresh Rate

Sets the refresh rate of the selected expression (see Live
Watches on page 130).

Expand/Collapse All

Expands or collapses all top-level nodes.

Watch

Opens the Watch Dialog (see Expressions on page 181).

Clear

Removes all items from the Watched Data Window.
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Chapter 5
 
Debugging With Ozone

This chapter explains how to debug an embedded application using Ozone’s basic and ad-
vanced debugging features. The chapter covers all activities that incur during a typical de-
bugging session − from opening the project file to closing the debug session.
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5.1    Project Files
An Ozone project file (.jdebug) stores settings that configure the debugger so that it is ready
to debug a program on a particular hardware setup (microcontroller and debug interface).
When a project file is opened or created, the debugger is initialized with the project settings.

5.1.1    Project File Example
Illustrated below is an example project file that was created with the Project Wizard (see
Project Wizard on page 31). As can be seen, project settings are specified in a C-like syntax
and are placed inside a function. This is due to the fact that Ozone project files are in fact
programmable script files. Chapter 6 covers the scripting facility in detail.

/*********************************************************************
*
*   OnProjectLoad
*
* Function description
*  Executed when the project file is opened. Required.
*
**********************************************************************
*/
void OnProjectLoad (void) {
 Project.SetDevice (“STM32F103ZE”);
 Project.SetHostIF (“USB”, “0”);
 Project.SetTargetIF (“SWD”);
 Project.SetTIFSpeed (“2 MHz”);
 File.Open (“C:/Examples/Blinky_STM32F103_Keil/Blinky/RAM/Blinky.axf”);
}

5.1.2    Opening Project Files
A project file can be opened in any of the following ways:
• Main Menu (File → Open)
• Recent Projects List (File → Recent Projects)
• Hotkey Ctrl+O
• User action File.Open (see File.Open on page 197)

5.1.3    Creating Project Files
A project file can be created manually using a text editor or with the aid of Ozone’s Project
Wizard (see Project Wizard on page 31). The Project Wizard creates minimal project files
that specify only the required settings.

5.1.4    Project Settings
Any user action that configures the debugger in some way is a valid project setting − this
also includes user actions that alter the appearance of the debugger (see User Actions on
page 35).

5.1.4.1    Specifying Project Settings
Project settings are specified by inserting user action commands into the obligatory script
function “OnProjectLoad” (see Project File Example on page 133).

5.1.4.2    Program File
The program to be debugged can be specified via user action File.Open. The file path argu-
ment can be specified as an absolute path or relative to the project file directory, amongst
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others (see File.Open on page 197). Furthermore, please consider section Supported Pro-
gram File Types on page 135 for the list of supported program file types.

5.1.4.3    Hardware Settings
Hardware settings configure the debugger to be used with a particular target and debug
interface. The affiliated user actions belong to the “Project” category (see Project Actions
on page 193).

5.1.4.4    RTOS Awareness Plugin
The user action Project.SetOSPlugin specifies the file path or name of the plugin that adds
RTOS awareness to the debugger (see Project.SetOSPlugin on page 223). Ozone currently
ships with two RTOS awareness plugins - one for SEGGER’s embOS and one for FreeRTOS.

5.1.4.5    Target Support Plugin
The user action Project.SetCorePlugin specifies the file path of the plugin that adds support
for a particular MCU architecture to the debugger (see Project.SetCorePlugin on page 223).
Ozone currently ships with two target support plugins − one for ARM and one for RISC-V.

5.1.4.6    Source File Resolution Settings
Settings that allow Ozone to find source files that have been moved to a new location after
the program file was build are described in File Path Resolution on page 183.

5.1.4.7    Behavioral Settings
Settings that modify the behavior of debugging operations are referred to as “system vari-
ables”. System variables can be edited via user action Edit.SysVar (see Edit.SysVar on
page 203).

5.1.4.8    Required Project Settings
A valid project file must specify the following settings:

Setting Description

Project.SetDevice The name of the target device.

Project.SetHostIF Specifies how the J-Link debug probe is connected to the
Host-PC.

Project.SetTargetIF Specifies how the J-Link debug probe is connected to the
target.

Project.SetTifSpeed Specifies the data transmission speed.

5.1.5    User Files
When a project is closed, Ozone associates a user file (*.user) with the project and stores it
next to the project file. The user file contains window layout information and other appear-
ance settings in an editable format. The next time the project is opened, Ozone restores
the user interface layout from the user file. User files may be shared along with project
files in order to migrate the project-individual look and feel.
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5.2    Program Files
The program to be debugged is specified as part of the project settings or is opened man-
ually from the user interface.

5.2.1    Supported Program File Types
Ozone supports the following program file types:

• ELF or compatible files (*.elf, *.out, *.axf)
• Motorola s-record files (*.srec, *.mot)
• Intel hex files (*.hex)
• Binary data files (*.bin)

5.2.2    Symbol Information
Only ELF or compatible program files contain symbol information. When specifying a pro-
gram or data file of different type, source-level debugging features will be unavailable. In
addition, all debugger functionality requiring symbol information − such as the variable or
function windows − will be unavailable.

Debugging without Symbol Information

Ozone provides many facilities that allow insight into programs that do not contain symbol
information. With the aid of the Disassembly Window, program execution can be observed
and controlled on a machine code level. The target’s memory and register state can be ob-
served and modified via the Memory and Register Windows. Furthermore, many advanced
debugging features such as instruction trace and terminal IO are operational even when
the program file does not provide symbol information.

5.2.3    Opening Program Files
When the program file is not specified as part of the project settings (using action
File.Open), it needs to be opened manually. A program file can be opened via the Main Menu
(File → Open), or by entering user action command File.Open into the Console Window’s
command prompt (see File.Open on page 197).

Effects of opening a Program File

When an ELF- or compatible program file is opened, the program’s main function is dis-
played within the Source Viewer. Furthermore, all debug information windows that dis-
play static program entities are initialized. Specifically, these are the Functions Window
(see Functions Window on page 93), Source Files Window (see Source Files Window on
page 116), Global Data Window (see Global Data Window on page 95) and Code Profile
Window (see Code Profile Window on page 77).

5.2.4    Data Encoding
When an ELF or compatible program file is opened, Ozone senses the program file’s data
encoding (data endianness) and configures itself for that encoding. Additionally, the endi-
anness mode of the attached target is set to the program file’s data encoding if supported
by the target. The target’s endianness mode can also be specified independently via the J-
Link Settings Dialog (see J-Link Settings Dialog on page 59).
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5.3    Starting the Debug Session
After a project was opened or created and a program file was specified, the debug session
can be started. The debug session is started via user action Debug.Start (see Debug.Start
on page 215). This action can be triggered from the Debug Menu or by pressing the hotkey
F5.

5.3.1    Connection Mode
The operations that are performed during the startup sequence depend on the value of
the connection mode parameter (see Debug.SetConnectMode on page 216). The different
connection modes are described below.

5.3.1.1    Download & Reset Program
The default connection mode “Download & Reset Program” performs the following startup
operations:

Startup Phase Description

Phase 1: Connect A software connection to the target is established via J-Link.

Phase 2: Breakpoints Pending (data) breakpoints that were set in offline mode are
applied.

Phase 3: Reset A hardware reset of the target is performed.
Phase 4: Download The debuggee is downloaded to target memory.

Phase 5: Finish The initial program operation is performed (see Initial Pro-
gram Operation on page 136).

Flow Chart

Section Startup Sequence Flow Chart on page 184 provides a flow chart of the Download &
Reset Program startup sequence. This chart can be used as a reference when reprogram-
ming the sequence via the scripting interface.

5.3.1.2    Attach to Running Program
This connection mode attaches the debugger to the debuggee by performing phases 1 and
2 of the default startup sequence (see Download & Reset Program on page 136).

5.3.1.3    Attach & Halt Program
This connection mode performs the same operations as “Attach To Running Program” and
additionally halts the program.

5.3.1.4    Setting the Connection Mode

The connection mode can be set via user action Debug.Set-
ConnectMode (see Debug.SetConnectMode on page 216),
via the System Variable Editor (see System Variable Editor
on page 56) or via the Connection Menu (Debug → Start De-
bugging). The Connection Menu is illustrated on the right.

5.3.2    Initial Program Operation
When the connection mode is set to Download & Reset Program, the debugger finishes the
startup sequence in one of the following ways, depending on the reset mode (see Reset
Mode on page 140):
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Reset Mode Initial Program Operation

Reset & Break at Symbol The Program is reset and advanced to a particular function.
Reset & Halt The program is halted at the reset vector.
Reset & Run The program is restarted.

5.3.3    Reprogramming the Startup Sequence
Parts or all of the Download & Reset Program startup sequence can be reprogrammed. The
process is discussed in detail in DebugStart on page 162.

5.3.4    Visible Effects
When the start-up procedure is complete, the debug information windows that display
target data will be initialized and the code windows will display the program execution point
(PC Line).

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH



138 CHAPTER 5 Register Initialization

5.4    Register Initialization

5.4.1    Overview
Ozone initializes the program counter register (PC) and possibly also the stack pointer
register (SP) in an architecture-specific manner each time…
• a program file was downloaded to target memory.
• a hardware-reset of the target was performed.

In the download case, register initialization takes place after file contents have been written
to target memory and before the initial program operation is performed (see Initial Program
Operation on page 136).

Note

Ozone performs a hardware reset of the target…

• before a program file is downloaded
• when the program is user-reset

5.4.2    Register Reset Values
The standard register initialization values are depicted in the table below. The depicted
values apply for both download and hardware reset.

Architecture Initial PC Initial SP

Legacy ARM 0
Cortex-A/R 0
Cortex-M [0x4] [0x0]
RISCV-V 0

An empty table cell indicates that Ozone leaves the register uninitialized. A value in square
brackets means that the value is interpreted as a memory location from which the register
reset value is read.

5.4.3    Manual Register Initialization
Users are able to override Ozone’s default register initialization behaviour by implementing
script functions AfterTargetDownload and/or AfterTargetReset. When one of these script
functions is implemented, Ozone skips the standard register initialization procedure of the
named event. In this case, users are required to implement the script function in a manner
such that target registers are initialized according to their needs. Ozone’s scripting system
is discussed in detail in chapter Scripting Interface on page 20.

5.4.4    Project-Default Register Initialization
Ozone projects generated via the Project Wizard implement both script functions After-
TargetDownload and AfterTargetReset and therefore override Ozone’s default register
initialization behaviour per default (see Project Wizard on page 31). The register initializa-
tion scheme of wizard-generated projects is depicted in the table below. The depicted val-
ues apply for both download and hardware reset.
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Architecture Initial PC Initial SP

Legacy ARM <baseaddr>

Cortex-A/R <baseaddr>

Cortex-M [<baseaddr> + 4] [<baseaddr>]
RISCV-V <baseaddr>

<baseaddr> stands for the lowest memory address that was written to during download.
A value in square brackets means that the value is interpreted as a memory location from
which the register reset value is read.
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5.5    Debugging Controls
Ozone provides multiple debugging controls that modify the program execution point in a
defined way.

5.5.1    Reset
The program can be reset via user action Debug.Reset (see Debug.Reset on page 217).
The action can be executed from the Debug Menu (see Debug Menu on page 39) or by
pressing F4.

5.5.1.1    Reset Mode
The reset behavior depends on the value of the reset mode parameter (see Reset Modes
on page 171). The reset mode specifies which one of the three initial program operations
is performed after the target has been hardware-reset (see Initial Program Operation on
page 136).

Setting the Reset Mode

The reset mode can be set via user action Debug.SetReset-
Mode (see Debug.SetResetMode on page 217), via the Sys-
tem Variable Editor (see System Variable Editor on page 56)
or via the Reset Menu (Debug → Reset). The Reset Menu is
illustrated on the right. The symbol to break at can be specified
by settings System Variable VAR_BREAK_AT_THIS_SYMBOL.

5.5.2    Step
Ozone provides three user actions that step the program in defined ways. The debugger’s
stepping behavior also depends on whether the Source Viewer or the Disassembly Window
is the active code window (see Active Code Window on page 45). The table below considers
each situation and describes the resulting behavior.

Action
Source Viewer is

Active Code Window
Disassembly Window

is Active Code Window

Debug.StepInto

Steps the program to the next
source code line. If the current
source code line calls a function,
the function is entered.

Advances the program by a sin-
gle machine instruction by ex-
ecuting the current instruction
(single step).

Debug.StepOver

Steps the program to the next
source code line. If the current
source code line calls a function,
the function is overstepped, i.e.
executed but not entered

Performs a single step with the
particularity that branch with
link instructions (BL) are over-
stepped, i.e. instructions are
executed until the PC assumes
the address following that of the
branch.

Debug.StepOut

Steps the program out of the
current function to the source
code line following the function’s
call site.

Steps the program out of the
current function to the machine
instruction following the func-
tion’s call site.

5.5.2.1    Stepping Expanded Source Code Lines
When the Source Viewer is the active code window and the source line containing the PC
is expanded to reveal it’s assembly code instructions, the debugger will use its instruction
stepping mode instead of performing source line steps.
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5.5.3    Resume
The program can be resumed via user action Debug.Continue (see Debug.Continue on
page 216). The action can be executed from the Debug Menu or by pressing the hotkey F5.

5.5.4    Halt
The program can be halted via user action Debug.Halt (see Debug.Halt on page 216). The
action can be executed from the Debug Menu or by pressing the hotkey F6.

5.5.5    Run To
User action Debug.RunTo advances program execution to a particular function, source code
line or instruction address, depending on the command line parameter given (see De-
bug.RunTo on page 219). All instructions between the current PC and the destination are
executed. Both code windows provide a context menu entry “Run To Cursor” that advance
program execution to the selected code line.

5.5.6    Set Next Statement
User action Debug.SetNextStatement advances program execution to a particular source
code line or function. The action sets the execution point directly, i.e. all instructions be-
tween the current execution point and the destination location will be skipped (see De-
bug.SetNextStatement on page 218). The action is accessible from the context menu of
the Source Viewer.

5.5.7    Set Next PC
User action Debug.SetNextPC advances program execution to a particular instruction ad-
dress (see Debug.SetNextPC on page 218). The action sets the execution point directly,
i.e. all instructions between the current execution point and the destination execution point
will be skipped. The action is accessible from the context menu of the Disassembly Window.
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5.6    Breakpoints
Ozone provides many alternative ways of setting, clearing, enabling and disabling break-
points on machine instructions, source code lines, functions and program variables.

5.6.1    Source Breakpoints
A breakpoint that is set on a source code line is referred to as a source breakpoint. Tech-
nically, a source breakpoint is set on the memory addresses of one or multiple machine
instructions affiliated with the source code line.

5.6.1.1    Editing Source Breakpoints
Source breakpoints can be edited within the Source Viewer (see Source Viewer on
page 118), within the Breakpoints/Tracepoints Window (see Breakpoints/Tracepoints Win-
dow on page 71) or via user actions Break.SetOnSrc, Break.ClearOnSrc, Break.En-
ableOnSrc, Break.DisableOnSrc and Break.ClearAll (see Breakpoint Actions on page 190.
Source code locations are specified in a predefined format (see Source Code Location De-
scriptor on page 168).

5.6.2    Instruction Breakpoints
A breakpoint that is set on the memory address of a machine instruction is referred to as
an instruction breakpoint.

5.6.2.1    Editing Instruction Breakpoints
Instruction breakpoints can be edited within the Disassembly Window (see Disassembly
Window on page 89), within the Breakpoints/Tracepoints Window (see Breakpoints/Tra-
cepoints Window on page 71) or via user actions Break.Set, Break.Clear, Break.Enable,
Break.Disable and Break.ClearAll (see Breakpoint Actions on page 190).

5.6.3    Derived Breakpoints

An instruction breakpoint that was set implicitly by Ozone in
order to implement a source breakpoint is referred to as a de-
rived breakpoint. As a fixed part of their parent source break-
point, derived breakpoints cannot be cleared individually. De-
rived breakpoints can be distinguished from user-set breakpoints by their smaller diameter
icon as depicted on the right.

5.6.4    Advanced Breakpoint Properties
Each breakpoint can be assigned a set of advanced (“extra”) properties that are evaluat-
ed/performed when the breakpoint is hit. The advanced properties of a breakpoint can be
edited via the Breakpoint Properties Dialog (see Breakpoint Properties Dialog on page 58)
or programmatically via user action Break.Edit (see Break.Edit on page 244). Please re-
fer to section Breakpoint Properties on page 71 for an overview of all available advanced
breakpoint properties.

5.6.5    Permitted Implementation Types
Each breakpoint can be assigned a permitted implementation type (see Breakpoint Imple-
mentation Types on page 171). The permitted implementation type of a breakpoint can be
edited via the Breakpoint Properties Dialog (see Breakpoint Properties Dialog on page 58),
via the Breakpoints/Tracepoints Window (see Breakpoints/Tracepoints Window on page 71)
or programmatically via user action Break.SetType (see Break.SetType on page 242).
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Default Permitted Implementation Type

For all breakpoints that have not been assigned a permitted implementation type, the val-
ue of system variable VAR_BREAKPOINT_TYPE is used (see System Variable Identifiers on
page 177).

5.6.6    Flash Breakpoints
All J-Link/J-Trace debug probes come with a unique feature that allows the user to set an
unlimited number of software breakpoints when debugging in flash memory. Without this
feature, the user would be limited to the number of breakpoints supported by the target
CPU.

Note

For J-Link base debug probes, the “unlimited flash breakpoints” feature requires a
separate software license from SEGGER.

5.6.7    Breakpoint Callback Functions
Each breakpoint can be assigned a script function that is executed when the breakpoint
is hit. The script callback function can be assigned via the Breakpoint Properties Dia-
log (see Breakpoint Properties Dialog on page 58) or programmatically via commands
Break.SetCommand (see Break.SetCommand on page 250) and Break.SetCmdOnAddr
(see Break.SetCmdOnAddr on page 250).

5.6.8    Offline Breakpoint Modification
All types of breakpoints can be modified both while the debugger is online and offline. Any
modifications made to breakpoints while the debugger is disconnected from the target will
be applied when the debug session is started.
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5.7    Data Breakpoints
Data breakpoints monitor memory areas for specific types of IO accesses. When a memory
access occurs that matches the data breakpoint’s trigger condition, the program is halted.
Data breakpoints are most commonly used to monitor accesses to global program variables.

5.7.1    Data Breakpoint Attributes
A data breakpoint is defined by the following attributes:

Attribute Description

Address Memory address that is monitored for IO (access) events.

Mask

Specifies which bits of the address are ignored when monitoring ac-
cess events. By means of the address mask, a single data breakpoint
can be set to monitor accesses to several individual memory address-
es. More precisely, when n bits are set in the address mask, the data
breakpoint monitors 2n many memory addresses.

Symbol Variable or function parameter whose data location corresponds to
the memory address of the data breakpoint.

On Indicates if the data breakpoint is enabled or disabled.

Access Type Type of IO access that is monitored by the data breakpoint (see Ac-
cess Types on page 171).

Access Size

Number of bytes that need to be accessed in order to trigger the da-
ta breakpoint (see Memory Access Widths on page 171. As an exam-
ple, a data breakpoint with an access size of 4 bytes (word) will only
be triggered when a word is written to one of the monitored memory
locations. It will not be triggered when, say, a byte is written.

Match Value
Value condition required to trigger the data breakpoint. A data break-
point will only be triggered when the match value is written to or read
from one of the monitored memory addresses.

Value Mask
Indicates which bits of the match value are ignored when monitoring
access events. A value mask of 0xFFFFFFFF disables the value condi-
tion.

5.7.2    Editing Data Breakpoints
Data breakpoints can be set, cleared and edited via the Data Breakpoint Dialog (see Data
Breakpoint Dialog on page 57). This dialog is accessible from the context menus of the
Code Windows and the Breakpoints/Tracepoints Window.

Data breakpoints can also be manipulated inside script functions. For this, the actions listed
in Breakpoint Actions on page 190 that end on either “Data” or “Symbol” are provided.

Note

The amount of data breakpoints that can be set, as well as the supported values of
the address mask parameter, depend on the capabilities of the target.
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5.8    Program Inspection
This section explains how users can inspect and modify the state of the debuggee when it
is halted at an arbitrary execution point.

5.8.1    Execution Point
Users may navigate to the current position of program execution, also called the PC line,
via user actions View.PC (see View.PC on page 212) and View.PCLine (see View.PCLine
on page 212).

5.8.2    Static Program Entities
Ozone provides 4 debug windows allowing users to inspect static program content that does
not change with the execution point. The capabilities of these windows are summarized
below.

Debug Window Description

Functions Window Lists all functions linked to assemble the debuggee, including
functions implemented within external code.

Source Files Window Displays the source code files that were used to build the de-
buggee.

Memory Usage Window
Displays the partitioning of target memory into Flash, RAM
and other memory areas as well as the usage of these areas
by the debuggee.

Call Graph Window Displays all possible function call paths, giving the user a
clear picture on the possible execution flow.

5.8.3    Data Symbols
Ozone provides 3 symbol windows that allow users to observe, edit and modify program
variables and function parameters. The capabilities of these windows are summarized be-
low.

Debug Window Description

Local Data Window

Allows users to observe and manipulate the local variables
and function parameters that are in scope at the execution
point. Furthermore, the Local Data Window is able to dis-
play the variables and parameters of any function on the call
stack. By selecting a called function within the Call Stack
Window or within the Source Viewer, the local symbols of
that function are displayed.

Global Data Window Allows users to observe and edit global program variables

Watched Data Window

Any program variable can be put under, and removed from,
explicit observation via user actions Window.Add and Win-
dow.Remove (see Window Actions on page 195). Observed
variables are displayed within the Watched Data Window
(see Watched Data Window on page 130).

5.8.4    Symbol Data Navigation
The data location of a variable or function parameter can be navigated-to by executing
the user action View.Data (see View.Data on page 210). This action is available from the
context menu of all symbol windows.
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5.8.5    Symbol Tooltips

When hovering the mouse cursor over a data symbol within the
Source Viewer, a tooltip will pop up that displays the symbol’s
value (see Expression Tooltips on page 119).

5.8.6    Call Stack
The sequence of function calls that led to the current execution
point can be observed within the Call Stack Window (see Call
Stack Window on page 75).

5.8.7    Target Registers
The current state of the target’s core and peripheral registers can
be inspected and edited via Ozone’s Register Window (see Register Window on page 113).
The user actions Target.GetReg and Target.SetReg are provided to read and write core and
peripheral registers inside script functions or at the command prompt (see Target Actions
on page 194).

5.8.8    Target Memory
The current state of target memory can be inspected and edited via Ozone’s Memory Win-
dow (see Memory Window on page 104).

The user actions:
• Target.ReadU8
• Target.ReadU16
• Target.ReadU32
• Target.WriteU8
• Target.WriteU16
• Target.WriteU32

are provided to read and write target memory inside script functions or at the command
prompt (see Target Actions on page 194). These actions access memory byte (U8), half-
word (U16) and word-wise (U32).

5.8.8.1    Default Memory Access Width
The default access width that Ozone employs when reading or writing memory strides of
arbitrary size can be specified via the user action Target.SetAccessWidth (see Target.Se-
tAccessWidth on page 236).

5.8.9    Inspecting a Running Program
When the debuggee is running, program inspection and manipulation is limited in the fol-
lowing ways:

Limitation Description

Frozen CPU registers CPU registers are not updated and cannot be edit-
ed.

Frozen symbol windows Values within symbol windows are not updated and
cannot be edited.

Deactivated debugging controls All debug controls except “halt” and “disconnect”
are deactivated.

No execution point context
Debug windows that show execution point context
when the program is halted (Callstack, Local Da-
ta,…) are empty.
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All other features, such as terminal-IO and breakpoint manipulation, remain operational
while the debuggee is running.

5.8.9.1    Live Watches
In situations where the value of a data symbol needs to be monitored while the program
is running, users can resort to Ozone’s Watched Data Window (see Watched Data Window
on page 130). The Watched Data Window allows users to set refresh rates between 1 and
5 Hz for each watched item individually.

5.8.9.2    Symbol Trace
In situations where a high-resolution trace of a data symbol is required, users can resort
to Ozone’s Data Graph Window (see Data Graph Window on page 83). The Data Graph
Window supports sampling rates of up to 1 MHz and provides advanced navigation tools
for exploring the resulting data graph.

5.8.9.3    Streaming Trace
When used in conjunction with a SEGGER J-Trace PRO debug probe on hardware that sup-
ports instruction tracing, Ozone is able to update the application’s code profile statistics
continuously while the program is running. In contrast to non-streaming trace, the trace
data is recorded and sent continuously to the host PC, instead of being limited by the trace
probe buffer size. This allows “endless” recording of trace data and real-time analysis of
the execution trace while the target is running. For use-cases of streaming trace, refer to
Advanced Program Analysis And Optimization Hints on page 155. For further information
on streaming trace, please consult the  J-Link User Guide  or  SEGGER’s website .

5.8.9.4    Power Trace
The Power Graph Window tracks the current drawn by the target while executing the de-
buggee and displays the resulting graph in an interactive signal plot.
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5.9    Terminal IO
Ozone supports printf-style debugging of the debuggee. A debuggee may send text mes-
sages to the debugger by employing one or multiple of the IO techniques described below.
Text output from the debuggee is shown within the Terminal Window (see Terminal Window
on page 123).

5.9.1    Real-Time Transfer
SEGGER’s Real-Time Transfer (RTT) is a bi-directional data transmission technique based
on a shared target memory buffer. Compared to SWO and Semihosting, RTT provides a
significantly higher data transmission speed. For further information on Real-Time Transfer,
please refer to  SEGGER’s website .

5.9.1.1    RTT Configuration
Ozone will automatically sense whether the debuggee supports Text-IO via RTT. If RTT
support is detected, the debugger automatically starts to capture data on the RTT interface.
Text-IO via RTT generally does not need to be configured within Ozone. However, when
no program file download is performed on debug start, it may be necessary to supply
RTT buffer location information (see Project.AddRTTSearchRange on page 224). On the
application program side, a special global program variable must be provided. Please refer
to  SEGGER’s website  for further information on how to set up and use RTT within your
debuggee.

5.9.2    SWO
The Terminal Window can capture and display textual data that is sent by the debuggee to
the debugger via the target’s Serial Wire Output (SWO) interface. SWO is a unidirectional
technology; it cannot be used to send data from the debugger to a debuggee.

5.9.2.1    SWO Configuration
Text-IO via SWO must be configured both within the debuggee and within Ozone. Within
the debugger, it is enabled and configured via the Trace Settings Dialog (see Trace Set-
tings Dialog on page 67) or programmatically via user actions Project.SetTraceSource (see
Project.SetTraceSource on page 224) and Project.ConfigSWO (see Project.ConfigSWO on
page 226). The SWO interface can also be enabled by checking the Terminal Window’s
context menu item “Capture SWO IO”. Please refer to the ARM Information Center for de-
tails on how to set up and use printf via SWO in your application.

5.9.3    Semihosting
Ozone is able to communicate with the debuggee via the Semihosting mechanism. Next
to providing bi-directional text I/O via the Terminal Window, the debuggee can employ
Semihosting to perform advanced operations on the Host-PC such as reading from files.
For a complete discussion on Semihosting, please refer to the  ARM information center .

5.9.3.1    Semihosting Configuration
The Semihosting interface can be enabled or disabled via user action Project.SetSemihost-
ing (see Project.SetSemihosting on page 225) or via the Terminal Window’s context menu
item “Capture Semihosting IO”. Semihosting configuration parameters can be edited via
command Project.ConfigSemihosting (see Project.ConfigSemihosting on page 225). The
debuggee must also apply special assembly code to emit semihosted text messages. Please
refer to the ARM Information Center for details on how to set up and use semihosting within
your debuggee.

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH

https://www.segger.com
https://www.segger.com
http://infocenter.arm.com/help/index.jsp


149 CHAPTER 5 Downloading Program Files

5.10    Downloading Program Files
For the purpose of downloading program files to target memory, Ozone provides four dis-
tinct user actions:

• File.Open: (see File.Open on page 197)
• File.Load: (see File.Load on page 198)
• Exec.Download: (see Exec.Download on page 240)
• Target.LoadMemory: (see Target.LoadMemory on page 238)

These actions differ in the way the download is performed in regards to the following as-
pects:

• HWRESET: is a hardware reset of the target performed prior to download?
• SCRIPT: are script functions called at specific moments of the download?
• REGINIT: are registers initialized after download?
• FINISH: is the initial program operation performed after download?
• SYMBOLS: are program symbols loaded into Ozone’s symbol windows when the

program file is opened for download?

5.10.1    Download Behaviour Comparision
The table below compares the mentioned actions regarding the named aspects. Only user
action File.Open triggers the standard download sequence that is also performed during
debug session startup (see Starting the Debug Session on page 136). The hardware re-
set is identical to the operation performed by user action Exec.Reset (see Exec.Reset on
page 239). For a description of the initial program operation, please refer to section Initial
Program Operation on page 136.

User Action HWRESET SCRIPT REGINIT FINISH SYMBOLS

File.Open x x x x x
File.Load x x x
Exec.Download
Target.LoadMemory

5.10.2    Script Callback Behaviour Comparision
Ozone’s download actions furthermore differ in regards to the script functions executed
during the download sequence. The table below gives an overview.

Script Function File.Open File.Load Exec.Download Target.LoadMemory

BeforeTargetReset x x
TargetReset x
AfterTargetReset x x
BeforeTargetDownload x x
TargetDownload x
AfterTargetDownload x x

5.10.3    Avoiding Script Function Recursions
In order to avoid infinite script function recursions, users are advised to not use actions
File.Open and File.Load within any script function that is itself an event handler for the
command. Users are advised to use actions Exec.Download and Target.LoadMemory in
these places instead.
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5.10.4    Downloading Bootloaders
For details on how to configure Ozone for the download and execution of a bootloader prior
to the download of the debuggee, please refer to section Incorporating a Bootloader into
Ozone’s Startup Sequence on page 165.
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5.11    Locating Missing Source Files
This section discusses the handling of source code files that Ozone could not locate on the
file system.

5.11.1    Causes for Missing Source Files
When a source code file has been moved from its compile-time location to a different
directory on the file system, the debugger is (in most cases) not able to locate the file
anymore. Due to performance reasons, Ozone only performs a limited file system search
to locate unresolved source code files.

Invalid Root Path

A second reason why one or multiple source files might be missing is that the debugger
was not able to determine the program’s root path correctly. The program’s root path is
defined as the common directory prefix that needs to be prepended to relative file paths
specified within the program file.

5.11.2    Missing File Indicators
A missing source file is marked with a yellow warning sign within the Source Files Window.
Additionally the Source Viewer will display an informative text instead of file contents when
the program’s execution point is within a missing source code file. The context menu of
missing source files provide an entry that lets users open a file dialog to locate the file (see
Unresolved Source Files on page 116.

5.11.3    Configuration Options
Ozone provides multiple configuration options that allow users to correct the file paths of
missing source code files. Please refer to section File Path Resolution on page 183 for
further details.
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5.12    Setting Up Trace
This section describes the configuration of trace within Ozone. For a general overview on
trace with J-Link and J-Trace, please refer to the  J-Link User Guide  and  SEGGER’s website .

5.12.1    Trace Features Overview
Ozone’s trace features consist of the following elements:

• Instruction Trace Window (see Instruction Trace Window on page 97)
• Timeline Window (see Timeline Window on page 125)
• Code Profile Window (see Code Profile Window on page 77)
• Execution Counters (see Execution Counters on page 118)

5.12.2    Target Requirements
Ozone currently supports trace on the following MCU architectures:

• Cortex-M
• Cortex-A

ARM’s Cortex MCU architecture principally allows two ways how trace data may be moved
from the target to the PC: in a buffered (ETB) and a streaming (ETM) fashion. ETM trace
has many advantages over ETB trace but also an extended hardware requirement (see
Streaming Trace on page 147).

5.12.2.1    Target Requirements for ETB Trace
Buffered trace requires the target to contain an embedded trace buffer (ETB). The trace
buffer must be accessible to J-Link, i.e. accessible via the selected target interface. ETB-
Trace otherwise poses no additional requirements on the hardware setup.

5.12.2.2    Target Requirements for ETM Trace
Streaming trace requires the target CPU to contain an embedded trace macrocell (ETM) or
a program trace macrocell (PTM). The trace data generated by these units is emitted via
dedicated CPU pins. It is target dependent if these trace pins are present and to what type
of debug header they are connected, if any. Most commonly, the trace pins are routed to
a 19-pin Samtec FTSH “trace” header.

5.12.3    Debug Probe Requirements
• ETB trace is supported by all J-Link and J-Trace models.
• ETM trace requires a J-Trace PRO model to be employed.

5.12.4    Trace Settings
• ETB trace does not need to be configured in Ozone.
• ETM trace has multiple configuration settings in the form of Ozone system variables

which are summarized below.

System Variable Description Default

VAR_TRACE_SOURCE
Selects the trace source to use. See Trace
Sources on page 172 for the list of valid val-
ues.

none

VAR_TRACE_PORT_WIDTH
Specifies the number of trace pins provided by
the target. Permitted values are 1, 2 and 4. 4

VAR_TRACE_PORT_DELAY_n
Configures the sampling delay of trace pin
n (n=1…4). The valid value range is -5 to 2.0ns
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System Variable Description Default

+5 nanoseconds at steps of 50 ps. See
Project.SetTraceTiming on page 226 for fur-
ther information.

VAR_TRACE_MAX_INST_CNT
Specifies the maximum amount of instruc-
tions that Ozone can process and store during
a streaming trace session.

1M

VAR_TRACE_TIMESTAMPS_EN-
ABLED

Specifies wether the target is to output (and
J-Link/Ozone is to process) PC timestamps
multiplexed into the trace data stream.

1

VAR_TRACE_CORE_CLOCK

CPU frequency in Hz. Ozone uses this vari-
able to convert instruction timestamps
from CPU cycle count to time format (see
VAR_TRACE_TIMESTAMPS_ENABLED).

100kHz

All of the above system variables can be edited via the Trace Settings Dialog (see Trace
Settings Dialog on page 67) or programmatically via user action Edit.SysVar (see Edit.Sys-
Var on page 203). Most system variables pertaining to instruction trace are accompanied
by a project setting that accomplishes the same task (see Project Actions on page 193).

Note

When instruction timestamps are not required, the option should be disabled to en-
hance the overall tracing performance.

5.12.5    Instruction Cache
All instruction-trace and disassembly related features of Ozone require the prior initialization
of the instruction cache with the program code to be debugged. In case a download is
performed on debug session start, Ozone automatically initializes the instruction cache with
the downloaded bytes. In situations where the instruction cache is not fully initialized from
the downloaded bytes, e.g. when:
• program code areas are initialized at runtime (e.g. RAM-Debug)
• no program file is specified
• attaching to a running program

the instruction cache has to be initialized manually via command Debug.ReadIntoInstCache
(see Debug.ReadIntoInstCache on page 219). When the instruction cache is not initial-
ized, Ozone will display a warning message indicating that debugging information will be
inaccurate.
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5.13    Selective Tracing

5.13.1    Overview
Many ARM-Cortex targets allow trace data output to be limited to a set of user-defined
program address ranges. When selective tracing is active, the target’s trace buffer is only
filled with trace data that matches the configured constraints. This makes selective tracing
particularly valuable on hardware setups with limited trace buffer size and no streaming
trace capability.

5.13.2    Requirements
It is to a high degree target dependant if selective tracing is supported and to what extent.
A generic requirements guideline cannot be given. Instead, refer to your MCU model’s user
manual or contact the manufacturer when unsure about the capabilities of your target.

5.13.3    Tracepoints

Selective tracing is implemented in Ozone using start and stop-
type tracepoints. Tracepoints can be toggled on program instruc-
tions and source lines just like ordinary breakpoints. Each matching
pair of start and stop tracepoints marks an address range whose
instructions are included in the target’s trace output. All instruction
fetches occurring outside of tracepoint-configured address ranges
will not generate trace data.

Tracepoint Imprecision

An MCU possibly commands its tracepoints hardware unit asyn-
chronously to its instruction execution unit. This means that trace data capture may be
started and stopped a few cycles after the affiliated instruction has been fetched for exe-
cution.

5.13.4    Scope
All of the features summarized in Trace Features Overview on page 152 are affected by
selective tracing.
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5.14    Advanced Program Analysis And Optimization
Hints

This section describes use-cases of advanced program analysis using the (streaming) in-
struction trace and code profiling capabilities of Ozone. For code profiling hardware require-
ments, see Hardware Requirements on page 111.

5.14.1    Program Performance Optimization

5.14.1.1    Scenario
The user wants to optimize the runtime performance of the debuggee.

To get an overview of the program functions in which most CPU time is spent, it is usually
good to start by looking at the Code Profile Window and to sort its functions list according
to CPU load:

Filtering Functions

In this example, the program spends 99% of its CPU time in the idle loop, which is not
relevant for optimizations. To get a clear picture about where the rest of the CPU time
is spent, the idle loop can be filtered from the code profile statistic. This can be done by
selecting function OS_Idle and clicking on the context menu entry “Exclude”.

Filtering Instructions

A compiler may furthermore emit code alignment instructions (NOP’s) that are likewise
not relevant for code optimization. NOP Instructions can be filtered from the code profile
statistic by clicking on context menu entry “Exclude NOP Instructions” or programmatically
via user action Coverage.ExcludeNOPs (see Coverage.ExcludeNOPs on page 233).

After filtering, the Code Profile Window shows where the application spends the remaining
CPU time. Other functions which affect the CPU load but cannot be optimized any further
can be filtered accordingly in order to find remaining functions worth optimizing. In this
example, a quarter of the remaining CPU time is spend in function vTraceStoreEvent1. Let’s
now assume the user wants to optimize the runtime of this function. By double-clicking on
the function, the function is displayed within the Source Viewer.
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Evaluating Execution Counters

The Source Viewer’s execution counters indi-
cate that an assertion macro within function
vTraceStoreEvent1 has been executed a signif-
icant amount of times. The Source Viewer also
indicates that the last 3 instructions of the as-
sertion macro have never been executed. This
means that the assertion was always true when
it was evaluated.

Deriving Improvement Concepts

At this point, the user could think about remov-
ing the assertion or ensuring that the assertion is
only evaluated when the program is run in debug
mode.

Impact Estimation

To get an idea of the impact of the optimization, the execution counters may provide a first
idea. In general, optimizing source lines which are executed more often can result in higher
optimization. If the function code is fully sequential, i.e. if there are no loops or branches
in the code, the impact can be estimated exactly.

Code Profile Status Information

The status information of the Code Profile Window displays the target’s actual instruction
execution frequency. An instructions per second value that is significantly below the target’s
core frequency may indicate that the target is thwarted by an excessive hardware IRQ load.
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5.15    Other Debugging Activities
This section describes all debugging activities that were not covered by the previous sec-
tions.

5.15.1    Finding Text Occurrences
Ozone’s Find Dialog allows users to search for text patterns within source code documents
(see Find Dialog on page 61). The Find Dialog supports regular expressions and can be
opened via user action Edit.Find or via the Source Viewer’s context menu (see Edit.Find
on page 203).

5.15.2    Configuring Message Logging
Refer to section Application Messages on page 69 for details on how to enable message
logging to the application and console log files.

5.15.3    Evaluating Expressions
C-style expressions that perform some kind of computation on program symbols and num-
bers can be evaluated by adding them to the Watched Data Window (see Watched Data
Window on page 130) or programmatically via user action Elf.GetExprValue (see Elf.Get-
ExprValue on page 251). Please refer to Expressions on page 181 for more information
on Ozone expressions.

5.15.4    Saving And Loading Memory
Ozone allows users to store target memory content to a binary data file and vice versa.

Memory-To-File

Target memory blocks can be saved (dumped) to a binary data file via user action- Tar-
get.SaveMemory (see Target.SaveMemory on page 237) or via the Save Memory Dialog
(see Generic Memory Dialog on page 105).

File-To-Memory

File contents can be downloaded to target memory via user action Target.LoadMemory (see
Target.LoadMemory on page 238) or via the Load Memory Dialog (see Generic Memory
Dialog on page 105).

5.15.5    Relocating Symbols
To allow the debugging of runtime-relocated programs such as bootloaders, Ozone provides
user action Project.RelocateSymbols (see Project.RelocateSymbols on page 230). This
command shifts the absolute addresses of a set of program symbols by a constant offset.
It can thus be used to realign symbol addresses to a modified program base address.

5.15.6    Terminal Input Requests
The debuggee (debuggee) can request user input via the Semihosting or RTT data IO tech-
niques (see Terminal IO on page 148). This common debugging technique allows users to
manipulate the program state at application-defined execution points and to observe the
resulting runtime behavior. Ozone provides the Terminal Prompt for answering user input
requests (see Terminal Prompt on page 123).
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5.15.7    Stopping the Debug Session
The debug session can be stopped via user action Debug.Stop (see Debug.Stop on
page 215). The action can be executed from the Debug Menu or by pressing the hotkey
Shift-F5.
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Scripting Interface

This chapter describes Ozone’s scripting interface. The scripting interface allows users to
reprogram key operations within Ozone.
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6.1    Script Files
Ozone project files (*.jdebug) contain user-implemented script functions that the debugger
executes upon entry of defined events or debug operations. By implementing script func-
tions, users are able to reprogram key operations within Ozone such as the hardware reset
sequence that puts the target into its initial state.

6.1.1    Scripting Language
Project files are written in a simplified C language that supports most C language constructs
such as functions and control structures. Ozone currently requires all script code to be
contained within functions. Statements and declarations occurring outside of function bod-
ies are invalid syntax. However, global constants can be defined using action Script.De-
fineConst (see Script.DefineConst on page 214).

6.1.2    Script Functions
Project file script functions belong to three different categories: event handler functions,
process replacement functions and user functions. Each script function may contain simpli-
fied C code that configures the debugger in some way or replaces a default operation of
the debugging workflow. The different function categories are described below.

6.1.3    Event Handler Functions
Ozone defines a set of 11 event handler functions that the debugger executes upon the
entry of defined debugging events. The Table below lists the event handler functions and
their associated events. The event handler function OnProjectLoad is obligatory, i.e. it
must be present in the project file.

Event Handler Function Description

void OnProjectLoad(); Executed when the project file is opened.
void BeforeTargetReset(); Executed before the target is reset.
void AfterTargetReset(); Executed after the target was reset.

void BeforeTargetDownload();
Executed before the program file is down-
loaded.

void AfterTargetDownload();
Executed after the program file was down-
loaded.

void BeforeTargetConnect();
Executed before a J-Link connection to the tar-
get is established.

void AfterTargetConnect();
Executed after a J-Link connection to the target
was established.

void BeforeTargetDisconnect();
Executed before the debugger disconnects from
the target.

void AfterTargetDisconnect();
Executed after the debugger disconnected from
the target.

void AfterTargetHalt(); Executed after the target processor was halted.

void BeforeTargetResume();
Executed before the target processor is re-
sumed.
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Example Event Handler Implementation

Illustrated below is an example implementation of the event handler function AfterTarge-
tReset. In this example, a peripheral register at memory address 0x40004002 is initialized
after the target was reset.

/*********************************************************************
*
*   AfterTargetReset
*
* Function description
*  Executed after the target was reset.
*
**********************************************************************
*/
void AfterTargetReset(void) {
 Target.WriteU32(0x40004002, 0xFF);
}

6.1.3.1    User Functions
Users are free to add custom functions to the project file. These “helper” or user functions
are not called by the debugger directly; instead, user functions need to be called from other
script functions.

6.1.3.2    Process Replacement Functions
Ozone defines 4 script functions that can be implemented within the project file to replace
the default implementations of certain debugging operations. The behavior that is expected
from process replacement functions is described in section Process Replacement Functions
on page 161. The table below gives an overview:

Process Replacement Function Description

void DebugStart(); Replaces the default debug session startup routine.
void TargetReset(); Replaces the default target hardware reset routine.
void TargetConnect(); Replaces the default target connection routine.
void TargetDownload(); Replaces the default program download routine.

6.1.4    API Functions
In the context of Ozone’s scripting functionality, any user action that has a text command is
referred to as an API function (see Action Tables on page 35). API functions can be used to
trigger debugging operations or to send and receive data to/from the debugger. In short,
API functions resemble the debugger’s programming interface (or API).

6.1.5    Executing Script Functions
Ozone provides user action Script.Exec (see Script.Exec on page 214) that allows users
to execute individual script functions from the Command Prompt (see Command Prompt
on page 81).
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6.2    Process Replacement Functions
This section describes how users are expected to implement each of the four process re-
placement functions defined within Ozone’s scripting interface.

6.2.1    DebugStart
When the script function DebugStart is present in the project file, the default startup se-
quence of the debug session is replaced with the operation defined by the script function.

6.2.1.1    Startup Sequence
The table below lists the different phases of Ozone’s default debug session startup sequence
(see Download & Reset Program on page 136). The last column of the table indicates the
process replacement function that can be implemented to replace a particular phase of the
startup sequence. The complete startup sequence can be replaced by implementing the
script function DebugStart.

Startup Phase Description
Process Replacement

Function

Phase 1: Connect A software connection to the target is
established via J-Link. TargetConnect

Phase 2: Breakpoints Pending (data) breakpoints that were
set in offline mode are applied.

Phase 3: Reset A hardware reset of the target is per-
formed. TargetReset

Phase 4: Download The debuggee is downloaded to target
memory. TargetDownload

Phase 5: Finish
The initial program operation is per-
formed (see Initial Program Operation
on page 136).

Flow Chart

Appendix Startup Sequence Flow Chart on page 184 provides a graphical flowchart of
the startup sequence. Most notably, the flowchart illustrates at what points during the
startup sequence certain event handler functions are called (see Event Handler Functions
on page 160).

Breakpoint Phase

Phase 2 (Breakpoints) of the default startup sequence is always executed implicitly after
the connection to the target was established.

6.2.1.2    Writing a Custom Startup Routine
A custom startup routine that performs all phases of the default sequence but the initial
program operation is displayed below.
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/**********************************************************************
*
*   DebugStart
*
* Function description
*  Custom debug session startup routine that skips phase 5
*
**********************************************************************
*/
void DebugStart (void) {
 Exec.Connect();
 Exec.Reset();
 Exec.Download(“c:/examples/keil/stm32f103/blinky.axf”);
}

6.2.2    TargetConnect
When the script function TargetConnect is present in the project file, the debugger’s default
target connection behavior is replaced with the operation defined by the script function.

6.2.3    TargetDownload
When the script function TargetDownload is present in the project file, the debugger’s
default program download behavior is replaced with the operation defined by the script
function.

6.2.3.1    Writing a Multi-Image Download Routine
An application that requires the implementation of a custom download routine is when
one or multiple additional program images (or data files) need to be downloaded to target
memory along with the debuggee. A corresponding implementation of the script function
TargetDownload is illustrated below.

/*********************************************************************
*
*   TargetDownload
*
* Function description
*   Downloads an additional program image to target memory
*
**********************************************************************
*/
void TargetDownload(void) {

 Util.Log(“Downloading Program.”);

 /* 1. Download the debuggee */
 Debug.Download();

 /* 2. Download the additional program image */
 Target.LoadMemory(“C:/AdditionalProgramData.hex”, 0x20000400);
}

6.2.4    TargetReset
When the script function ttTargetReset} is defined within the project file, the debugger’s
default target hardware reset operation is replaced with the operation defined by the script
function.
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6.2.4.1    J-Link Reset Routine
Ozone’s default hardware reset routine is based on the J-Link firmware routine “JLINKAR-
M_Reset”. Please refer to the  J-Link User Guide  for details on this routine and its tar-
get-dependant behavior.

6.2.4.2    Writing a Reset Routine for RAM Debug
A typical example where the J-Link hardware reset routine must be replaced with a custom
reset routine is when the debuggee is downloaded to a memory address other than zero,
for example the RAM base address.

Problem

The standard reset routine of the firmware assumes that the debugee’s vector table is
located at address 0 (Cortex-M) or that the initial PC is 0 (Cortex-A/R, Legacy ARM). As this
is not true for RAM debug, the reset routine must be replaced with a custom implementation
that initializes the PC and SP registers to correct values.

Solution

A custom reset routine for RAM debug typically first executes the default J-Link hardware
reset routine. This ensures that tasks such as pulling the target’s reset pin and halting the
processor are performed. Next, a custom reset routine needs to initialize the PC and SP
registers so that the target is ready to execute the first program instruction.

Example

The figure below displays the typical implementation of a custom hardware reset routine
for RAM debug on a Cortex-M target. This implementation is included in all project files
generated by the Project Wizard that are set up for a Cortex-M target device.

/*********************************************************************
*
*   TargetReset
*
* Function description
*  Resets a program downloaded to a Cortex-M target’s RAM section
*
**********************************************************************
*/
void TargetReset(void) {
 unsigned int SP;
 unsigned int PC;
 unsigned int ProgramAddr;

 Util.Log(“Performing custom hardware reset for RAM debug.”);

 ProgramAddr = 0x20000000;

 /* 1. Perform default hardware reset operation */
 Exec.Reset();

 /* 2. Initialize SP */
 SP = Target.ReadU32(ProgramAddr);
 Target.SetReg(“SP”, SP);

 /* 3. Initialize PC */
 PC = Target.ReadU32(ProgramAddr + 4);
 Target.SetReg(“PC”, PC);
}
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6.3    Incorporating a Bootloader into Ozone's Startup
Sequence

An important use case of Ozone’s scripting system is to configure the debug session startup
sequence in a manner such that a hardware initialization program (bootloader) is executed
before download of the debuggee. This section explains how users are expected to write an
Ozone script that serves this particular purpose. The following example is written for the
Cortex-M architecture but the demonstrated concepts are universally valid.

OnProjectLoad

/*********************************************************************
*
*  OnProjectLoad
*
* Function description
*   Project load routine. Required.
*
**********************************************************************
*/
void OnProjectLoad (void)
{
 …
 File.Open(“debuggee.elf”); // open main image
}

The script’s entry point function loads the debuggee instead of the bootloader. This ensures
that the debug windows that show static program information are initialized even when the
debug session was not yet started.

TargetDownload

/*********************************************************************
*
*   TargetDownload
*
* Function description
*  Downloads the bootloader instead of the main image.
*
**********************************************************************
*/
void TargetDownload (void)
{
 Exec.Download(“Bootloader.hex”);
}

Script function TargetDownload instructs Ozone to download the bootloader instead of the
main image when the debug session is started. Note that command Exec.Download is used
to download the bootloader. The reason for this is that this command does not trigger any
other script functions when executed (see Download Behaviour Comparision on page 149).
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AfterTargetDownload

/*********************************************************************
*
*   AfterTargetDownload
*
* Function description
*  Initializes PC and SP for either bootloader or debuggee execution
*
**********************************************************************
*/
void AfterTargetDownload (void)
{
 unsigned int Addr;

 if (TargetIsHaltedAtBootloaderEnd()) {
  Addr = <main_image_download_address>; // init regs for debuggee exec.
 } else {
  Addr = <bootloader_download_address>; // init regs for bootloader exec.
 }
 Target.SetReg(“SP”, Target.ReadU32(Addr));
 Target.SetReg(“PC”, Target.ReadU32(Addr + 4));
}

Script function AfterTargetDownload instructs Ozone to initialize the PC and SP registers
to the required values for either bootloader or main image execution, depending on which
file was downloaded.

AfterTargetHalt

/*********************************************************************
*
*   AfterTargetHalt
*
* Function description
*  Checks if the bootloader finished execution and if so, loads the debuggee
*
**********************************************************************
*/
void AfterTargetHalt (void)
{
 if (TargetIsHaltedAtBootloaderEnd())
 {
  File.Load(“debuggee.elf”, 0);
 }
}

The key to incorporating a bootloader into Ozone’s debug session startup sequence is to
detect the point in time when the bootloader has finished execution. The expected way to
do this is to have the bootloader run into a software breakpoint instruction at the end of
its execution. Once the bootloader hits this breakpoint, Ozone senses that the target has
halted and executes script function AfterTargetHalt. Helper function TargetIsHaltedAt-
BootloaderEnd tests if the current PC is identical to the PC of the software breakpoint. If
the test succeeds, the download of the main image is performed. A key aspect here is that
command “File.Load” is used to perform the download of the main image. This way, the
target is not hardware-reset prior to the download (which would possibly revert changes
performed by the bootloader) and script function AfterTargetDownload is executed after
the download. For an overview of the behavioral differences of Ozone’s downloading user
actions, please refer to section Download Behaviour Comparision on page 149.
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Appendix

The Appendix provides descriptions on all Ozone API commands (user actions) and informs
about Ozone system variables and constants.
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7.1    Value Descriptors
This section describes how certain objects such as fonts and source code locations are
specified textually to be used as arguments for user actions and script functions.

7.1.1    Frequency Descriptor
Frequency parameters need to be specified in any of the following ways:
• 103000
• 103000 Hz
• 103.5 kHz (or 103.5k)
• 0.13 MHz (or 0.13M)
• 1.1 GHz (or 1.1G)

A frequency parameter without a dimension is interpreted as a Hz value. The permitted
dimensions to be used with frequency descriptors are Hz, kHz, MHz and GHz. The capital-
ization of the dimension is irrelevant. The dimensions can also be specified using the letters
h, k, M and G. The decimal point can also be specified as a comma.

7.1.2    Source Code Location Descriptor
A source code location descriptor defines a character position within a source code docu-
ment. It has the following format:

“File name: line number: [column number]”

Thus, a valid source location descriptor might be “main.c: 100: 1”.

File Name

The file name of the source file (e.g. “main.c”) or its complete file path (e.g.“c:/exam-
ples/blinky/source/main.c”).

Line Number

The line number of the source code location.

Column Number

The column number of the source code location. This parameter can be omitted in situations
where it suffices to specify a source code line.

7.1.3    Color Descriptor
Color parameters are specified in any of the following ways:
• steel-blue (SVG color keyword)
• #RRGGBB (hexadecimal triple)

Thus, any SVG color keyword name is a valid color descriptor. In addition, a color can be
blended manually by specifying three hexadecimal values for the red, green and blue color
components.

7.1.4    Font Descriptor
Font parameters must be specified in the following format (please note the comma sepa-
ration):

“Font Family, Point Size [pt], Font Style”

Thus, a valid font descriptor might be “Arial, 12pt, bold”.
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Font Family

Ozone supports a wide variety of font families, including common families such as Arial,
Times New Roman, and Courier New. When using font descriptors, the family name must
be capitalized correctly.

Point Size

The point size attribute specifies the point size of the font and must be followed by the
measurement unit. Currently, only the measurement unit “pt” is supported.

Font Style

Permitted values for the style attribute are: normal, bold and italic.

7.1.5    Coprocessor Register Descriptor
A coprocessor register descriptor (CPRD) is a string that identifies a coprocessor register.

7.1.5.1    ARM
A CPRD on ARM can be specified in the following way:

“<CpNum> , <CRn> , <CRm> , <Op1> , <Op2>”

Values enclosed by “<>” denote numbers. These numbers are the fields of the ARM MRC or
MCR instruction that is used to read the coprocessor register. For details, please refer to the
ARM architecture reference manual applicable to your target. Note that the field “CpNum”
is currently limited to the value 15 (Coprocessor-15).
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7.2    System Constants
Ozone defines a set of global integer constants that can be used as parameters for script
functions and user actions.

7.2.1    Host Interfaces
The table below lists permitted values for the host interface parameter (see
Project.SetHostIF on page 221.

Constant Description

USB Use this value when the J-Link debug probe is connected to the host-PC
via USB.

IP Use this value when the J-Link debug probe is connected to the host-PC
via Ethernet.

7.2.2    Target Interfaces
The table below lists permitted values for the target interface parameter (See Project.Set-
TargetIF on page 221).

Constant Description

JTAG Use this value when the J-Link debug probe is connected to the target via
JTAG.

cJTAG Use this value when the J-Link debug probe is connected to the target via
cJTAG.

SWD Use this value when the J-Link debug probe is connected to the target via
SWD.

7.2.3    Boolean Value Constants
The table below lists the boolean value constants defined within Ozone. Please note that
the capitalization is irrelevant.

Constant Description

Yes, True, Active, On, Enabled The option is set.
No, Off, False, Inactive, Disabled The option is not set.

7.2.4    Value Display Formats
The table below lists permitted values for the display format parameter (see Window.Set-
DisplayFormat on page 207).

Constant Description

DISPLAY_FORMAT_AUTO Displays values in the format that is best suited.
DISPLAY_FORMAT_BINARY Displays integer values in binary notation.
DISPLAY_FORMAT_DECIMAL Displays integer values in decimal notiation.
DISPLAY_FORMAT_HEXADECIMAL Displays integer values in hexadecimal notation.
DISPLAY_FORMAT_CHARACTER Displays the text representation of the value.

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH



171 CHAPTER 7 System Constants

7.2.5    Memory Access Widths
The table below lists permitted values for the memory access width parameter (see Tar-
get.SetAccessWidth on page 236).

Constant Description

AW_AUTO Automatic access.
AW_BYTE Byte access.
AW_HALF_WORD Half word access.
AW_WORD Word access.

7.2.6    Access Types
The table below lists permitted values for the access type parameter (see Break.SetOnData
on page 245).

Constant Description

AT_READ_ONLY Read-only access.
AT_WRITE_ONLY Write-only access.
AT_READ_WRITE Read and write access.
AT_NO_ACCESS Access not permitted.

7.2.7    Connection Modes
The table below lists permitted values for the connection mode parameter (see Debug.Set-
ConnectMode on page 216).

Constant Description

CM_DOWNLOAD_RESET
The debugger connects to the target and resets it. The pro-
gram is downloaded to target memory and program execu-
tion is advanced to the main function.

CM_ATTACH
The debugger connects to the target and attaches itself to
the executing program.

CM_ATTACH_HALT
The debugger connects to the target, attaches itself to the
executing program and halts program execution.

7.2.8    Reset Modes
The table below lists permitted values for the reset mode parameter (see Debug.SetReset-
Mode on page 217).

Constant Description

RM_RESET_HALT Resets the target and halts the program at the reset vector.

RM_BREAK_AT_SYMBOL
Resets the target and advances program execu-
tion to the function specified by system variable
VAR_BREAK_AT_THIS_SYMBOL.

RN_RESET_AND_RUN Resets the target and starts executing the program.

7.2.9    Breakpoint Implementation Types
The table below lists permitted values for the breakpoint implementation type parameter
(see Break.SetType on page 242).
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Constant Description

BB_TYPE_ANY The debugger chooses the implementation type.

BP_TYPE_HARD
The breakpoint is implemented using the target’s hardware
breakpoint unit.

BP_TYPE_SOFT
The breakpoint is implemented in software (by amending the
program code with particular instructions).

For breakpoints that have not been assigned a permitted implementation type, the sys-
tem variable default VAR_BREAKPOINT_TYPE is used (see System Variable Identifiers on
page 177).

7.2.10    Trace Sources
The Table below lists permitted values for the trace source parameter (see Project.Set-
TraceSource on page 224).

Constant Display Name Description

TRACE_SOURCE_NONE None All trace features of Ozone are disabled.

TRACE_SOURCE_ETM Trace Pins

Instruction trace data is read from the tar-
get’s trace pins (in realtime) and provided to
Ozone’s trace windows. This mode requires a
J-Trace debug probe.

TRACE_SOURCE_ETB Trace Buffer Instruction trace data is read from the tar-
get’s embedded trace buffer (ETB).

TRACE_SOURCE_SWO SWO Printf data is read via the Serial Wire Output
interface and output to the Terminal Window.

Only one trace source can be active at any given time. The J-Link team plans to remove this
constraint in the near future. Please consult the  J-Link User Guide  for further information
about tracing with J-Link or J-Trace debug probes.

7.2.11    Tracepoint Operation Types
The table below lists permitted values for the tracepoint operation parameters required by
tracepoint manipulating actions (see Trace Actions on page 194).

Constant Description

TP_OP_START_TRACE Trace is started when the tracepoint is hit.
TP_OP_STOP_TRACE Trace is stopped when the tracepoint is hit.

7.2.12    Newline Formats
The table below lists supported newline formats.

Constant Description

EOL_FORMAT_WIN Text lines are terminated with “\r\n”
EOL_FORMAT_UNIX Text lines are terminated with “\n”
EOL_FORMAT_MAC Text lines are terminated with “\r”
EOL_FORMAT_NONE No line break.

7.2.13    Trace Timestamp Formats
The table below lists supported units for trace timestamps.
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Constant Description

TIMESTAMP_FORMAT_OFF Timestamps are not displayed
TIMESTAMP_FOR-
MAT_INST_CNT

Selects “number of instructions” as timestamp unit

TIMESTAMP_FORMAT_CY-
CLES

Selects CPU cycles as timestamp unit

TIMESTAMP_FORMAT_TIME Selects nanoseconds as timestamp unit

7.2.14    Code Profile Export Formats
The table below lists formats that can be specified when exporting code profile data to
CSV files.

Constant Description

CSV_FUNCS Export all program functions.
CSV_LINES Export all executable source code lines.
CSV_INSTS Export all program instructions.

7.2.15    Session Save Flags
The following flags identify session information that can be disabled within User Files (see
User Files on page 134).

Flag Description

DISABLE_SAVE_WINDOW_LAYOUT
Do not save the layout of debug information win-
dows.

DISABLE_SAVE_TABLE_LAYOUT
Do not save argangments of table columns and sort
indicators.

DISABLE_SAVE_OPEN_FILES Do not save the list of open source files.
DISABLE_SAVE_BREAKPOINTS Do not save breakpoints.
DISABLE_SAVE_EXPRESSIONS Do not save watched and graphed expressions.

DISABLE_SAVE_SELECTED_REGS
Do not save the register window’s display configu-
ration.

7.2.16    Font Identifiers
The following constants identify application fonts within Ozone (see Edit.Font on
page 204).

Constant Description

FONT_APP Default application font.
FONT_APP_MONO Default monospace application font.
FONT_ITEM_NAME Symbol name text font.
FONT_ITEM_VALUE Symbol value text font.
FONT_TABLE_HEADER Table header text font.
FONT_SRC_CODE Source code text font.
FONT_ASM_CODE assembly code text font.
FONT_CONSOLE Console Window text font.
FONT_LINE_NUMBERS Line number text font.
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Constant Description

FONT_SRC_ASM_CODE Source-inlined assembly code font.
FONT_EXEC_COUNTERS Font used for execution counters.

7.2.17    Color Identifiers
The following constants identify application colors within Ozone (see Edit.Color on
page 204).

Constant Description

COLOR_SELECTION_HIGHLIGHT Selection highlight color.

COLOR_CHANGE_LEVEL_1_BG
Change Level 1 background color (see Change Level
Highlighting on page 106).

COLOR_CHANGE_LEVEL_2_BG
Change Level 2 background color (see Change Level
Highlighting on page 106).

COLOR_CHANGE_LEVEL_3_BG
Change Level 3 background color (see Change Level
Highlighting on page 106).

COLOR_CHANGE_LEVEL_1_FG
Change Level 1 foreground color (see Change Level
Highlighting on page 106).

COLOR_CHANGE_LEVEL_2_FG
Change Level 2 foreground color (see Change Level
Highlighting on page 106).

COLOR_CHANGE_LEVEL_3_FG
Change Level 3 foreground color (see Change Level
Highlighting on page 106).

COLOR_PC_ACTIVE PC Line highlight (active window).
COLOR_PC_INACTIVE PC Line highlight (inactive window).

COLOR_PC_BACKTRACE
Color used for highlighting the PC line when the in-
struction trace window is focused.

COLOR_CALL_SITE_ACTIVE Function call site highlight (active window).
COLOR_CALL_SITE_INACTIVE Function call site highlight (inactive window).
COLOR_SIDEBAR_BACKGROUND Sidebar background color.
COLOR_TABLE_GRID_LINES Table grid color.
COLOR_SYNTAX_REGNAME Syntax color of assembly code register operands.
COLOR_SYNTAX_LABEL Syntax color of assembly code labels.
COLOR_SYNTAX_MNEMONIC Syntax color of assembly code mnemonics.
COLOR_SYNTAX_IMMEDIATE Syntax color of assembly code immediates.
COLOR_SYNTAX_INTEGER Syntax color of assembly code integer values.
COLOR_SYNTAX_KEYWORD Syntax color of source code keywords.
COLOR_SYNTAX_DIRECTIVE Syntax color of source code directives.
COLOR_SYNTAX_STRING Syntax color of source code strings.
COLOR_SYNTAX_COMMENT Syntax color of source code comments.
COLOR_SYNTAX_TEXT Source code text color.
COLOR_LINE_NUMBERS Color of source code line numbers.
COLOR_LINE_NUMBER_SEPARATOR Color of the line number separator bar.

COLOR_LOGGING_SCRIPT
Console Window script message color (see Console
Window on page 81).

COLOR_LOGGING_USER
Console Window command feedback message color
(see Console Window on page 81).
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Constant Description

COLOR_LOGGING_ERROR
Console Window error message color (see Console
Window on page 81).

COLOR_LOGGING_JLINK
Console Window J-Link message color (see Console
Window on page 81).

COLOR_PROGRESS_BAR_PROGRESS
Color used for drawing a progress bar’s progress
portion.

COLOR_PROGRESS_BAR_REMAINING
Color used for drawing a progress bar’s remaining
portion.

COLOR_TABLE_ITEM_INACTIVE Text color of inactive table items.
COLOR_EXEC_PROFILE_GOOD_INST Code profile highlighting − good instruction.
COLOR_EXEC_PROFILE_GOOD_INST Code profile highlighting − bad instruction.
COLOR_INLINE_ASM_BACKG Source Viewer − assembly code fill color.
COLOR_INLINE_ASM_BACKG_ALT Source Viewer − alternate assembly code fill color.
COLOR_ASM_LABEL_BACKG Disassembly Window − symbol label fill color.
COLOR_TIMESTAMP_DARK Timestamp color.
COLOR_TIMESTAMP_LIGHT Interpolated timestamp color.

Color identifiers

7.2.18    User Preference Identifiers
The following constants identify user preferences within Ozone (see Edit.Preference on
page 203).

Constant Description

PREF_SHOW_LINE_NUMBERS
Specifies whether the Source Viewer displays
line numbers.

PREF_SHOW_EXPANSION_BAR
Specifies whether the Source Viewer displays
source line expansion indicators.

PREF_SHOW_SIDEBAR_SRC
Specifies whether the Source Viewer displays
its sidebar.

PREF_SHOW_SIDEBAR_ASM
Specifies whether the Disassembly Window dis-
plays its sidebar.

PREF_SHOW_SRC_CODE_PROFILE
Specifies if execution counters are displayed
within the Source Viewer

PREF_SHOW_ASM_CODE_PROFILE
Specifies if execution counters are displayed
within the Disassembly Window.

PREF_SHOW_SYMBOL_ICONS
Specifies if symbol names are preceded by an
icon.

PREF_INDENT_INLINE_ASSEMBLY
Specifies whether the Source Viewer aligns in-
line assembly code to source code statements.

PREF_LINE_NUMBER_FREQ

Specifies the Source Viewer’s line number fre-
quency. Possible values are: off (0), current
line (1), all lines (2), every 5 lines (3) and
every 10 lines (4).

PREF_LOCK_HEADER_BAR
Specifies whether the Source Viewer header
bar’s auto-hide feature is disabled.

PREF_ASM_SHOW_SOURCE
Specifies whether the Disassembly Window
augments assembly code with source code (see
Mixed Mode on page 91).
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Constant Description

PREF_ASM_SHOW_LABELS
Specifies whether the Disassembly Window
augments assembly code with symbol labels.

PREF_TAB_SPACING Source Viewer tabulator spacing.

PREF_START_WITH_MOST_RECENT_PROJ
Specifies if the most recent project is automati-
cally opened on application start.

PREF_PREPEND_FUNC_CLASS_NAMES
Specifies if the class name should be prepend-
ed to C++ member functions.

PREF_SHOW_EXPANSION_BAR
Specifies whether the Source Viewer displays
source line expansion indicators.

PREF_SHOW_SIDEBAR_SRC
Specifies whether the Source Viewer displays
its sidebar.

PREF_SHOW_SIDEBAR_ASM
Specifies whether the Disassembly Window dis-
plays its sidebar.

PREF_SHOW_PROGBAR_WHILE_RUNNING
Specifies if a moving progress indicator is dis-
played within the status bar while the program
is running.

PREF_SHOW_CHAR_TEXT
Specifies whether values of (u)char-type sym-
bols are display as “value (character)”.

PREF_SHOW_SHORT_TEXT
Specifies whether values of (u)short-type sym-
bols are display as “value (character)”.

PREF_SHOW_INT_TEXT
Specifies whether values of (u)int-type symbols
are display as “value (character)”.

PREF_SHOW_CHAR_PTR_TEXT
Specifies whether values of (u)char*-type sym-
bols are display as “value (text)”.

PREF_SHOW_SHORT_PTR_TEXT
Specifies whether values of (u)short*-type
symbols are display as “value (text)”.

PREF_SHOW_INT_PTR_TEXT
Specifies whether values of (u)int*-type sym-
bols are display as “value (text)”.

PREF_DIALOG_SHOW_DNSA
Indicates if a checkbox should be added to
popup dialogs that allows users to prevent the
dialog from popping up.

PREF_SHOW_HEX_BLOCKS
Specifies whether large hexadecimal numbers
are divided into two blocks for better readabili-
ty.

PREF_SHOW_SYMBOL_TOOLTIPS Specifies whether symbol tooltips are enabled.

PREF_FILTER_BARS_DISABLED
Specifies whether table filter bars are globally
disabled.

PREF_MAX_SYMBOL_MEMBERS
Specifies the maximum amount of members to
be displayed for expanded symbol items.

PREF_SHOW_ENCODINGS_ITRACE
Toggles the display of instruction encodings
within the Instruction Trace Window.

PREF_SHOW_ENCODINGS_ASM
Toggles the display of instruction encodings
within the Disassembly Window.

PREF_RESTRICT_SRC_EDIT
Specifies the editing restriction that applies to
source files (0: no restriction, 1: editing disal-
lowed when debugging, 2: never allowed)

PREF_TERMINAL_EOL_FORMAT

Specifies the linebreak characters that the Ter-
minal Window appends to user input before
the input is send to the debuggee (see Newline
Formats on page 172).
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Constant Description

PREF_TERMINAL_ECHO_INPUT
Specifies if terminal window input is appended
to Terminal Window output.

PREF_TERMINAL_ZERO_TERM_INPUT
Specifies if the string termination character (0)
is appended to Terminal Window input before
the input is send to the debuggee.

PREF_TERMINAL_CLEAR_ON_RESET
When set, the terminal window is cleared each
time the program is reset.

PREF_TERMINAL_NO_CONTROL_CHARS
Specifies whether the Terminal Window outputs
printable ASCII characters only.

PREF_RESIZE_COL_ON_EXPAND
Specifies whether table columns resize to con-
tents after item expansions.

PREF_RESIZE_COL_ON_COLLAPSE
Specifies whether table columns resize to con-
tents after item collapses.

PREF_TIMESTAMP_FORMAT

Specifies the format of the time-axis scales
shown within Ozone’s trace windows. For the
list of supported values, refer to Trace Time-
stamp Formats on page 172.

PREF_CG_GROUP_BY_ROOT_FUNCS
Specifies if the call graph window displays root
functions on the top level only (1) or all pro-
gram functions (0).

PREF_CALLSTACK_LAYOUT

Specifies if the current frame is displayed at
the top or at the bottom of the call stack. Pos-
sible values are LAYOUT_CURR_FRAME_ON_TOP
(0) and LAYOUT_CURR_FRAME_ON_BOTTOM (1).

PREF_CALLSTACK_DEPTH_LIMIT
Selects the maximum amount of frames the
call stack can hold.

PREF_TIMELINE_TOOLTIPS
Enables/disables tooltips within the Timeline
Window.

User Preferences

7.2.19    System Variable Identifiers
The following constants identify system variables within Ozone (see Edit.SysVar on
page 203).

Constant Description

VAR_RESET_MODE
Program reset mode (see Reset Modes on page 171 for
permitted values).

VAR_CONNECT_MODE
Connection mode (see Connection Modes on page 171
for permitted values).

VAR_SEMIHOSTING_ENABLED
Specifies whether the Terminal Window captures Semi-
hosting IO (see Terminal IO on page 148).

VAR_RTT_ENABLED
Specifies whether the Terminal Window captures Re-
al-Time Transfer IO (see Terminal IO on page 148).

VAR_TIF_SPEED
Target interface speed (see Project Wizard on page 31
for details and Frequency Descriptor on page 168 for
permitted values).

VAR_TIF_SCAN_CHAIN_POS
Position of the target device on the JTAG scan chain. 0 is
closest to TDO.

VAR_TIF_SCAN_CHAIN_LEN
Sum of IR-Lens of devices that are positioned closer to
TDO on the JTAG scan chain. IRLen of ARM targets is 4.
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Constant Description

VAR_SWO_CPU_SPEED
SWO calibration parameter: target processor frequen-
cy (see Frequency Descriptor on page 168 for permitted
values).

VAR_SWO_SPEED
SWO calibration parameter: data transmission frequen-
cy (see Frequency Descriptor on page 168 for permitted
values).

VAR_ACCESS_WIDTH
Memory access width (see Memory Access Widths on
page 171 for permitted values).

VAR_BREAKPOINT_TYPE
Specifies the default breakpoint implementation type to
use when setting breakpoints.

VAR_VERIFY_DOWNLOAD
Specifies if a program data should be read-back from
target memory and compared to original file contents to
detect download errors.

VAR_BREAK_AT_THIS_SYMBOL
Specifies the function where program execution should
be stopped when reset mode “Reset & Break at Symbol”
is used.

VAR_HSS_SPEED

Specifies the sampling frequency of expressions added
to the Data Graph Window (see Data Graph Window on
page 83). The allowed value range is 1 Hz to 10 kHz.
When set to 0, the maximum frequency supported by
the hardware is used.

VAR_TRACE_SOURCE
Selects the trace source to use. See Trace Sources on
page 172 for the list of valid values.

VAR_TRACE_PORT_WIDTH
Configures the trace port width in bits. Permitted values
are 1, 2 and 4.

VAR_TRACE_PORT_DELAY_n
Configures the sampling delay of trace pin n (n=1…4).
The valid value range is -5 to +5 nanoseconds at steps
of 50 ps.

VAR_TRACE_PORT_WIDTH
Configures the trace port width in bits. Permitted values
are 1, 2 and 4.

VAR_TRACE_INIT_ON_ATTACH

Specifies whether Ozone should initialize the trace in-
struction cache when attaching to a program that al-
ready resides in target memory. The trace instruction
cache is automatically initialized by J-Link at the mo-
ment the program file is downloaded.

VAR_TRACE_CORE_CLOCK
Ozone uses this variable to convert CPU cycle counts to
CPU times in all applications related to trace timestamps
(see VAR_TRACE_TIMESTAMPS_ENABLED).

VAR_TRACE_TIMESTAMPS_EN-
ABLED

Specifies whether the target is to output (and J-Link/
Ozone is to process) PC timestamps multiplexed into the
trace data stream.

VAR_TRACE_MAX_INST_CNT
Specifies the maximum amount of instructions that
Ozone can process and store during a live trace session.

VAR_MAX_POWER_SAMPLES
Specifies the maximum amount of power trace samples
that Ozone can process and store.

VAR_POWER_SAMPLING_SPEED
Specifies the rate in Hz at which J-Link power-samples
the target.

VAR_TARGET_POWER_ON
Specifies whether J-Link supplies power to the target via
a dedicated target interface pin. This setting must be
active in order to use Ozone’s power profiling features.

VAR_MEM_ZONE_RUNNING
Selects the default memory zone to be accessed when
the program is running.
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System Variables
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7.3    Command Line Arguments
When Ozone is started from the command line, it is possible to specify additional parameters
that configure the debugger in a certain way. The list of available command line arguments
is given below.

Please note that all arguments containing white spaces must be quoted.

7.3.1    Project Generation
Command line arguments that generate a startup project. The device, target interface and
host interface settings are mandatory.

Parameter Description

–device <device> Selects the target device (for example ST-
M32F407IG).

–if <IF> Assigns the target interface (SWD or JTAG).
–speed <speed> Specifies the target interface speed in kHz.

–select <hostif>[=<ID>]

Assigns the host interface. <hostif> can be set to
either USB or IP. The optional parameter <ID> can
be set to the serial number or SP address of the J-
Link to connect to.

–usb [<SN>] Sets the host interface to USB and optionally speci-
fies the serial number of the J-Link to connect to.

–ip <IP> Sets the host interface to IP and specifies the IP ad-
dress of the J-Link to connect to.

–programfile Sets the program file to open on startup.

–project

Specifies the file path of the generated project. If
the project already exists, the new settings are ap-
plied to it. If the project does not exist, it is creat-
ed.

–jlinkscriptfile Specified the file path to the J-Link script that is ex-
ecuted when the debug session is started.

–jtagconfig <DRPre>,<IRLen> Configures the JTAG interface (see Project.SetJTAG-
Config on page 222).

7.3.2    Appearance and Logging
Command line arguments that adjust appearance and logging settings.

Argument Description

–style <style>
Sets Ozone’s GUI theme. Possible values for
<style> “windows”, “cleanlooks”, “plastique”, “mo-
tif” and “macintosh”.

–logfile <filepath> When set, Ozone outputs all application-generated
messages to the specified text file.

–loginterval <bytes> The byte interval at which the log file is updated.
–debug Opens a debug console window along with Ozone.
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7.4    Expressions
In Ozone, an expression is a term that combines symbol identifiers or numbers via arith-
metic and non-arithmetic operators and that computes to a single value or symbol. Ozone-
style expressions are for the most part C-language conformant with certain limitations as
described below.

7.4.1    Areas of Application
Ozone employs expressions in the following areas:
• As monitorable entities within the Watched Data Window

(see Watched Data Window on page 130).
• As monitorable entities within the Data Graph Window

(see Data Graph Window on page 83).
• As specifiers for the data locations of data breakpoints

(see Data Breakpoints on page 144).
• As specifiers for the trigger conditions of conditional breakpoints

(see Advanced Breakpoint Properties on page 142).

7.4.2    Operands
The following list gives an overview of valid expression operands:

• Global and local variables (e.g. OS_Global, PixelSizeX)
• Variable members (e.g. OS_Global.pTask->ID, OS_Global.Time)
• Numbers (e.g. 0xAE01, 12.4567, 1000)
• Program defines (e.g. MAX_SPEED)
• Ozone variables & constants (e.g. VAR_TIF_SPEED, FREQ_1_MHZ)
• User-defined constants (see Script.DefineConst on page 214)

7.4.3    Operators
The following list gives an overview of valid expression operators:

• Number arithmetic (+, -, *, /, %)
• Bitwise arithmetic (~, &, |, ^)
• Logical comparison (&&, ||)
• Bit-shift (>>, <<)
• Address-of (&)
• Size-of (sizeof)
• Number comparison (>, <, ≥, ≤, =, ≠)
• Pointer-operations (*, [], ->)
• Integer-operations (++, −−)
• Type-casts (see Type Casts on page 181)

The evaluation order of an expression can be controlled by bracketing sub-expressions.

7.4.4    Type Casts
The typecast operator “(<dest>)<src>” supports the following source and destination
types:

<src>

• Integers (e.g. 0x20000000)
• Program Variables (e.g. OS_Global)

<dest>

• Pointers and References (e.g. int* / Type& / Type*)
• Arrays (e.g. char[128] / Type[20])
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7.5    Directory Macros
The following macros can be used as placeholders for certain directory names wherever
file path arguments are required:

$(DocDir) The document directory. Expands to “${InstallDir}/doc”.
$(PluginDir) The plugin directory. Epxands to “${InstallDir}/plugins”.
$(ConfigDir) The configuration directory. Expands to “${InstallDir}/config”.
$(LibraryDir) The library directory. Expands to “${InstallDir}/lib”.
$(ProjectDir) The Ozone project file directory.
$(InstallDir) The directory where Ozone was installed to.
$(AppDir) The directory of the program file / debuggee.
$(ExecutableDir) The directory of Ozone’s executable file.
$(AppBundleDir) The application bundle directory (macOS).

7.5.1    Environment Variables
Ozone allows file path arguments to contain environment variables. The following environ-
ment variable formats are understood:

Format Operating System(s)

%<varname>% windows
$<varname> unix
$(<varname>) all plattforms

<varname> stands for the name of the environment variable (e.g. HOMEPATH on windows
or HOME on Unix).
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7.6    File Path Resolution
This section describes Ozone’s automatic file path resolution mechanism that is employed
whenever a file path argument is encountered that does not point to a valid file on the file
system. File path resolution is employed for all file types and is not restricted to source
files. The sequence of operations and its configuration options are described below.

7.6.1    File Path Resolution Sequence

Step 1 - Path Substitution

This step is applied to source file paths only. Any parts of the unresolved file path that match
a user-set path substitute are replaced with the substitute (see Project.AddPathSubstitute
on page 228). If the file path obtained from path substitution points to a valid file on the
file system, resolution is complete.

Step 2 - Alias Name Substitution

If the user has specified an alias for the file path to resolve, the path is replaced with the
alias (see Project.AddFileAlias on page 228). If the alias points to a valid file on the file
system, resolution is complete.

Step 3 - Path Expansion

All directory macros and environment variables contained within the file path are expanded
(see Directory Macros on page 182). If the expanded file path points to a valid file on the
file system, resolution is complete.

Step 4 - Source File Root Paths

Step 4 of file path resolution is only applied to relative file paths. Unresolved relative file
paths are appended successively to each source file root path (see Project.AddRootPath on
page 228). If any of the so-obtained file paths points to a valid file on the file system,
resolution is complete.

Step 5 - Application Directories

Step 5 of file path resolution is only applied to relative file paths. Unresolved relative file
paths are appended successively to each of the application directories listed in Directory
Macros on page 182. If any of the so-obtained file paths points to a valid file on the file
system, resolution is complete.

Step 6 - Search Directories

Step 6 of file path resolution is applied to both absolute and relative file paths. The file
name of unresolved file paths is searched within all user-specified search directories (see
Project.AddSearchPath on page 229). If any of the search directories contains a file with
the sought name, resolution is complete.

7.6.2    Operating System Specifics
File path arguments are case-insensitive on Windows and case sensitive on Linux and ma-
cOS. When debugging an application on a system that differs from the build platform, ad-
justments to the project file’s path resolution settings might be required in order for the
debugger to be able to locate all files.
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7.7    Startup Sequence Flow Chart
The figure below illustrates the different phases of the “Debug & Download Program” startup
sequence and how it interoperates with script functions (see Download & Reset Program on
page 136). Please note that Phases 2 (Breakpoints) and 5 (Initial Program Operation) of the
startup sequence are not displayed in the chart as these phases cannot be reimplemented
and do not trigger any event handler functions.

Startup Sequence Flow Chart.
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7.8    Errors and Warnings
This section lists all application errors and warnings that may occur during the debugging
workflow. For each exception, possible causes and solutions are summarized.

For details on how to conduct solution proposals that contain toolchain (compiler/linker/IDE)
settings, please refer to the user guide of the concerning software tool.

Follow the instructions in Support on page 256 when the problem persists.

Note

Work on the application message tables is currently ongoing.

Code Description Possible Causes Solution Proposals

1000 The ELF parser is out of
memory.

The ELF file contains
more debug symbols
than fit into Host PC
RAM.

Reduce the amount of
debugging information
emitted to the program
file (e.g. use -g1 instead
of -g3 on GCC and simi-
lar measures).

1001

The ELF parser encoun-
tered an internal error
while parsing a data sec-
tion.

Software bug in the em-
ployed toolchain or in
Ozone’s ELF parser.

Contact SEGGER sup-
port (see Support on
page 256).

1002
The ELF parser encoun-
tered an empty data sec-
tion.

Incorrect toolchain set-
tings. Check toolchain settings.

1003

The ELF parser encoun-
tered an invalid debug
symbol reference (spec-
ified as file offset). The
file offset does not point
to the base of a debug
symbol.

1. Unsupported debug
symbol format or exten-
sion. 2. Software bug in
the employed toolchain
or in Ozone’s ELF parser.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).

1004

The ELF parser encoun-
tered an invalid symbol
location reference (spec-
ified as file offset). The
file offset does not point
to the base of a symbol
location record.

1. Unsupported debug
symbol format or exten-
sion. 2. Software bug in
the employed toolchain
or in Ozone’s ELF parser.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).

1005
The ELF parser encoun-
tered an unsupported
symbol attribute format.

Unsupported debug sym-
bol format or extension.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).

1006
The program file does
not contain debug infor-
mation.

The toolchain settings
are not set to not gener-
ate DWARF debug infor-
mation.

Change toolchain set-
tings to generate DWARF
debug information.

1007

The ELF parser encoun-
tered a compilation unit
whose byte size is less
than expected from the
unit’s header informa-
tion.

Software bug in the em-
ployed toolchain or in
Ozone’s ELF parser.

Contact SEGGER sup-
port (see Support on
page 256).

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH



186 CHAPTER 7 Errors and Warnings

Code Description Possible Causes Solution Proposals

1008

The ELF parser encoun-
tered a debug symbol
encoded in an unsup-
ported format.

Unsupported debug sym-
bol format or extension.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).

1009
The symbol location de-
coder encountered an
unsupported operand.

Unsupported debug sym-
bol format or extension.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).

1010
ELF data section de-
bug_loc has an unex-
pected byte size.

1. Unsupported debug
symbol format or exten-
sion. 2. Software bug in
the employed toolchain
or in Ozone’s ELF parser.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).

1011
ELF data section de-
bug_line has an unex-
pected byte size.

1. Unsupported debug
symbol format or exten-
sion. 2. Software bug in
the employed toolchain
or in Ozone’s ELF parser.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).

1012
ELF data section de-
bug_frame has an unex-
pected byte size.

1. Unsupported debug
symbol format or exten-
sion. 2. Software bug in
the employed toolchain
or in Ozone’s ELF parser.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).

1013
The address mapping ta-
ble decoder encountered
an invalid file index.

Software bug in the em-
ployed toolchain or in
Ozone’s ELF parser.

Contact SEGGER sup-
port (see Support on
page 256).

1014

The address mapping ta-
ble decoder encountered
an invalid directory in-
dex.

Software bug in the em-
ployed toolchain or in
Ozone’s ELF parser.

Contact SEGGER sup-
port (see Support on
page 256).

1015

ELF data section de-
bug_frame contains an
unsupported address
size field.

1. Unsupported debug
symbol format or exten-
sion. 2. Software bug in
the employed toolchain
or in Ozone’s ELF parser.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).

1016

ELF data section de-
bug_frame contains an
unsupported segment
size field.

1. Unsupported debug
symbol format or exten-
sion. 2. Software bug in
the employed toolchain
or in Ozone’s ELF parser.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).

1017

The ELF parser encoun-
tered an inconsistency
within call frame infor-
mation data.

Software bug in the em-
ployed toolchain.

Contact SEGGER sup-
port (see Support on
page 256).

1018

ELF data section de-
bug_frame contains an
unsupported data aug-
mentation.

Unsupported debug sym-
bol format or extension.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).

1019

The call frame informa-
tion decoder encoun-
tered an internal error
state.

1. Unsupported debug
symbol format or exten-
sion. 2. Software bug in
the employed toolchain
or in Ozone’s ELF parser.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).
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Code Description Possible Causes Solution Proposals

1020
ELF data section de-
bug_frame is encoded in
an unsupported format.

1. Unsupported debug
symbol format or exten-
sion. 2. Software bug in
the employed toolchain
or in Ozone’s ELF parser.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).

1021

The ELF parser encoun-
tered an invalid address
range reference (spec-
ified as file offset). The
file offset does not point
to the base of an ad-
dress range record.

1. Unsupported debug
symbol format or exten-
sion. 2. Software bug in
the employed toolchain
or in Ozone’s ELF parser.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).

1022

The program macro in-
formation decoder en-
countered an internal er-
ror state.

1. Unsupported debug
symbol format or exten-
sion. 2. Software bug in
the employed toolchain
or in Ozone’s ELF parser.

Change the debug in-
formation output format
(e.g. from DWARF-5 to
DWARF-4).

1023

The ELF parser attempt-
ed to load an ELF file
that does not contain the
ELF file byte identifica-
tion pattern.

1. Wrong file selected 2.
File corrupted. Rebuild the ELF file.

1024

The ELF parser attempt-
ed to load an ELF file
that is not an executable
program (instead, the
file is most likely a
shared object).

Incorrect toolchain set-
tings or build target. Check toolchain settings.

1025

The ELF parser attempt-
ed to load an ELF file
having an unspecified
class (ELF_CLASS_NONE).

Incorrect toolchain set-
tings or build target. Check toolchain settings.

1026

The ELF parser attempt-
ed to load an ELF file
having an unspecified
data encoding (ELF_DA-
TA_NONE).

Incorrect toolchain set-
tings or build target. Check toolchain settings.

1027

The ELF parser attempt-
ed to load an ELF file
whose header version
number is not EV_CUR-
RENT.

Incorrect toolchain set-
tings or build target. Check toolchain settings.

1028

The ELF parser attempt-
ed to load an ELF file
that has an unsupported
file version number.

Incorrect toolchain set-
tings or unsupported file
format.

Check toolchain settings.

1029

The ELF parser attempt-
ed to load an ELF file but
the maximum number of
ELF files that can be si-
multaneously opened is
already open.

ELF files previously
opened in Ozone were
not closed correctly.

Contact SEGGER sup-
port (see Support on
page 256).

1030 The ELF parser attempt-
ed to load an ELF file but

1. Incorrect file access
permissions. 2. Corrupt
file header.

1. Check your file sys-
tem access permissions
2. Check that the file is
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Code Description Possible Causes Solution Proposals

could not open the file
for reading.

not in use by another
process 3. contact the
system administrator.

1031

The ELF parser attempt-
ed to load an ELF file
whose internal file size
information does not
match the actual file
size.

1. File was binary mod-
ified by an external tool
(e.g. readelf or instal-
l_name_tool).

Rebuild the ELF file.

1032 Not enough free memory
to load the ELF file. Insufficient target RAM. Upgrade RAM.

1033

The ELF parser attempt-
ed to load an ELF file but
encountered an error
while reading file con-
tents from the hard disk.

1. Incorrect file access
permissions. 2. Corrupt
file header.

1. Check your file sys-
tem access permissions
2. Check that the file is
not in use by another
process 3. contact the
system administrator.

1034

The ELF parser failed to
parse all of the DWARF
debug symbols provided
by the ELF file correctly.

Unsupported debug sym-
bol format.

Contact SEGGER sup-
port (see Support on
page 256).

1035

The ELF parser attempt-
ed to load an ELF file
that cannot be executed
on the selected target.

Incorrect toolchain set-
tings or build target,
e.g. word size mismatch
(32-bit/64-bit) or tar-
get processor type mis-
match.

1 Check toolchain set-
tings.

1036

The ELF parser attempt-
ed to load an ELF file
whose data endianess
does not match the tar-
get settings.

1. Project setting “Tar-
get.SetEndianess” not
present or set incorrect-
ly 2. Incorrect toolchain
settings pertaining to the
byte order of the output
file.

1. Project setting “Tar-
get.SetEndianess” not
present or set incorrect-
ly 2. Incorrect toolchain
settings pertaining to the
byte order of the output.

1037

The ELF parser attempt-
ed to load an ELF file
whose instruction endi-
aness does not match
the target settings.

1. Project setting “Tar-
get.SetEndianess” not
present or set incorrect-
ly 2. Incorrect toolchain
settings pertaining to the
byte order of the output
file.

1. Project setting “Tar-
get.SetEndianess” not
present or set incorrect-
ly 2. Incorrect toolchain
settings pertaining to the
byte order of the output.

2000
An incorrect memory
zone name was input by
the user.

1. Incorrect user input.
2. Ozone failed to deter-
mine the names of the
target’s memory zones.

The list of available
memory zones is print-
ed along with this warn-
ing. If an incorrect input
can be ruled out, contact
SEGGER support (see
Support on page 256).

3000

A requested power sam-
pling frequency is not
supported by the hard-
ware setup.

J-Link/J-Trace debug
probes currently support
power sampling rates of
up to 100 khz, depend-
ing on the model.

1. Update J-Link soft-
ware drivers (e.g. by us-
ing the J-Link DLL Up-
dater tool).

3001 Power sampling could
not be started.

1. Power output to the
target is not enabled

1. Enable power output
(see Power Graph Win-
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Code Description Possible Causes Solution Proposals

(see System Variable
Identifiers on page 177).
2. The hardware setup
does not support power
sampling.

dow on page 111). 2.
Update J-Link software
drivers (e.g. by using the
J-Link DLL Updater tool).
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7.9    Action Tables
The following tables provide a quick reference on user actions provided by Ozone (see User
Actions on page 35).

7.9.1    Breakpoint Actions
Actions that modify the debugger’s breakpoint state.

Action Description

Break.Set Sets an instruction breakpoint.
Break.SetEx Sets an instruction breakpoint.
Break.Clear Clears an instruction breakpoint.
Break.Enable Enables an instruction breakpoint.
Break.Disable Disables an instruction breakpoint.
Break.SetOnSrc Sets a source breakpoint.
Break.SetOnSrcEx Sets a source breakpoint.
Break.ClearOnSrc Clears a source breakpoint.
Break.EnableOnSrc Enables a source breakpoint.
Break.DisableOnSrc Disables a source breakpoint.
Break.ClearAll Clears all instruction and source breakpoints.
Break.Edit Edits a breakpoints advanced properties.
Break.SetType Sets a breakpoint’s implementation type.
Break.SetCommand Assigns a script callback function to a breakpoint.
Break.SetCmdOnAddr Assigns a script callback function to a breakpoint.
Break.SetOnData Sets a data breakpoint.
Break.ClearOnData Clears a data breakpoint.
Break.EnableOnData Enables a data breakpoint.
Break.DisableOnData Disables a data breakpoint.
Break.EditOnData Edits a data breakpoint.
Break.SetOnSymbol Sets a data breakpoint on a symbol.
Break.ClearOnSymbol Clears a data breakpoint on a symbol.
Break.EnableOnSymbol Enables a data breakpoint on a symbol.
Break.DisableOnSymbol Disables a data breakpoint on a symbol.
Break.EditOnSymbol Edits a data breakpoint on a symbol.
Break.ClearAllOnData Clears all data breakpoints.

7.9.2    Code Profile Actions
Code profile related actions.

Action Description

Profile.Export Exports the current code profile data to a text file.
Profile.ExportCSV Exports the current code profile data to a CSV file.
Profile.Exclude Filters program entities from the code profile statistic.
Profile.Include Re-adds program entities to the code profile statistic.
Coverage.Exclude Filters program entities from the code coverage statistic.
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Action Description

Coverage.Include Re-adds program entities to the code coverage statistic.
Coverage.ExcludeNOPs Filters NOP instructions from the code coverage statistic.

7.9.3    Debug Actions
Actions that modify the program execution point and that configure the debugger’s con-
nection, reset and stepping behavior.

Action Description

Debug.Start Starts the debug session.
Debug.Stop Stops the debug session.
Debug.Connect Establishes a J-Link connection to the target.
Debug.Disconnect Disconnects the J-Link connection to the target.
Debug.Download Downloads the program file to the target.
Debug.Continue Resumes program execution.
Debug.Halt Halts program execution.
Debug.Reset Reset the program.
Debug.StepInto Steps into the current function.
Debug.StepOver Steps over the current function.
Debug.StepOut Steps out of the current function.
Debug.SetNextPC Sets the next machine instruction to be executed.
Debug.SetNextStatement Sets the next source statement to be executed.
Debug.RunTo Advances program execution to a particular location.
Debug.SetResetMode Sets the reset mode.
Debug.SetConnectMode Sets the connection mode.

Debug.ReadIntoInstCache Initializes the instruction cache with target memory da-
ta.

7.9.4    Edit Actions
Actions that edit behavioral and appearance settings of the debugger.

Action Description

Edit.Preference Edits a user preference.
Edit.SysVar Edits a system variable.
Edit.Color Edits an application color.
Edit.Font Edits an application font.
Edit.DisplayFormat Edits an object’s value display format.
Edit.RefreshRate Edits a watched expression’s refresh rate.
Edit.MemZone Edits a watched expression’s memory zone.
Edit.Find Displays the Find Dialog.

7.9.5    ELF Actions
Actions for retrieving ELF program file information.
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Action Description

Elf.GetBaseAddr Returns the program file’s download address.
Elf.GetEntryPointPC Returns the initial value of the program counter.
Elf.GetEntryFuncPC Returns the first PC of the program’s entry function.
Elf.GetExprValue Evaluates a symbol expression.
Elf.GetEndianess Returns the program file’s byte order.

7.9.6    File Actions
Actions that perform file system and related operations.

Action Description

File.NewProject Creates a new project.
File.NewProjectWizard Opens the Project Wizard.
File.Open Opens a file.
File.OpenRecent Reopens a recently opened program file.
File.Load Loads a file.
File.Close Closes a source code document.
File.CloseAll Closes all open source code documents.
File.CloseAllButThis Closes all but the active source code document.
File.Find Searches for a text pattern.
File.SaveProjectAs Saves the project file under a new file path.
File.SaveAll Saves all modified files.
File.Exit Closes the application.

7.9.7    Find Actions
Actions that locate program entities.

Action Description

Find.Text Opens the Find Dialog.
Find.Function Locates a program function.
Find.GlobalData Locates a global symbol.

7.9.8    Help Actions
Actions that display help related information.

Action Description

Help.About Shows the About Dialog.
Help.Commands Prints the command help to the Console Window.
Help.Manual Displays the user manual.

7.9.9    J-Link Actions
Actions that perform J-Link operations.

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH



193 CHAPTER 7 Action Tables

Action Description

Exec.Connect Establishes the connection between J-Link and target.

Exec.Reset Hardware-resets the target (in a default, target-specific
way).

Exec.Download Downloads a program or a data file to target memory.
Exec.Command Executes a J-Link command.

7.9.10    Project Actions
Actions that configure the debugger for operation in a particular software and hardware
environment.

Action Description

Project.SetDevice Specifies the target device.
Project.AddSvdFile Adds a register set description file.
Project.SetHostIF Specifies the host interface.
Project.SetTargetIF Specifies the target interface.
Project.SetTIFSpeed Specifies the target interface speed.
Project.SetJTAGConfig Configures the JTAG target interface.
Project.SetTraceSource Selects the trace source to use.
Project.SetTracePortWidth Specifies the number of trace pins comprising the TP.
Project.SetTraceTiming Configures the trace pin sampling delays.
Project.SetTraceFile Specifies the file to which target trace data is stored to.
Project.ConfigSWO Configures the Serial Wire Output (SWO) interface.
Project.SetSemihosting Enables or disables the Semihosting IO interface.
Project.ConfigSemihosting Configures the Semihosting IO interface.
Project.SetRTT Configures the Real-Time Transfer (RTT) IO interface.
Project.AddRTTSearchRange RTT configuration command.
Project.AddFileAlias Sets a file path alias.
Project.AddPathSubstitute Replaces substrings within source file paths.
Project.AddRootPath Specifies the program’s root path.
Project.AddSearchPath Adds a path to the program’s list of search paths.
Project.SetCorePlugin Specifies the file path of the target support plugin.
Project.SetOSPlugin Specifies the RTOS awareness plugin to be used.
Project.SetBPType Sets the allowed breakpoint implementation type.
Project.SetMemZoneRunning Sets the default zone accessed when the CPU is running.
Project.SetJLinkScript Sets the J-Link-Script to be executed on debug start.
Project.SetJLinkLogFile Sets the text file that receives J-Link logging output.
Project.RelocateSymbols Relocates one or multiple symbols.
Project.SetConsoleLogFile Sets the text file that receives console window output.
Project.SetTerminalLogFile Sets the text file that receives terminal window output.
Project.DisableSessionSave Disables saving of individual session information.

7.9.11    Script Actions
Actions that perform script operations.
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Action Description

Script.Exec Executes a project file script function.
Script.DefineConst Defines an integer constant to be used within scripts.

7.9.12    Target Actions
Actions that perform target memory and register IO.

Action Description

Target.SetReg Writes a target register.
Target.GetReg Reads a target register.
Target.WriteU32 Writes a word to target memory.
Target.WriteU16 Writes a half word to target memory.
Target.WriteU8 Writes a byte to target memory.
Target.ReadU32 Reads a word from target memory.
Target.ReadU16 Reads a half word from target memory.
Target.ReadU8 Reads a byte from target memory.
Target.FillMemory Fills a block of target memory with a particular value.
Target.SaveMemory Saves a block of target memory to a binary data file.
Target.LoadMemory Downloads the contents of a data file to target memory.
Target.SetAccessWidth Specifies the memory access width.
Target.SetEndianess Configures the debugger for a particular data endianess.
Target.LoadMemoryMap Initializes the target’s memory map from file contents.
Target.AddMemorySegment Adds a memory segment to the memory map.

7.9.13    Tools Actions
Actions that open tool dialogs.

Action Description

Tools.JLinkSettings Opens the J-Link Settings Dialog.
Tools.TraceSettings Opens the Trace Settings Dialog.
Tools.Preferences Opens the User Preference Dialog.
Tools.SysVars Displays the System Variable Editor.

7.9.14    Toolbar Actions
Actions that modify the state of toolbars.

Action Description

Toolbar.Show Displays a toolbar.
Toolbar.Close Hides a toolbar.

7.9.15    Trace Actions
Trace-related actions.
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Action Description

Trace.SetPoint Sets a tracepoint.
Trace.ClearPoint Clears a tracepoint.
Trace.EnablePoint Enables a tracepoint.
Trace.DisablePoint Disables a tracepoint.
Trace.ClearAllPoints Clears all tracepoints.
Trace.ExportCSV Exports trace data to a CSV file.

7.9.16    Utility Actions
Script function utility actions.

Action Description

Util.Sleep Pauses the current operation for a given amount of time.
Util.Log Prints a message to the console window.
Util.LogHex Prints a formated message to the console window.

7.9.17    View Actions
Actions that navigate to particular objects displayed on the graphical user interface.

Action Description

View.Data Displays the data location of a program variable.
View.Source Displays the source code location of an object.
View.Disassembly Displays the assembly code of an object.
View.CallGraph Displays the call graph of a function.
View.InstTrace Displays a position in the instruction execution history.
View.Memory Displays a memory location.
View.Line Displays a text line in the active document.
View.PC Displays the PC instruction in the Disassembly Window.
View.PCLine Displays the PC line in the Source Viewer.
View.NextResult Displays the next search result item.
View.PrevResult Displays the previous search result item.

7.9.18    Window Actions
Actions that edit the state of debug information windows.

Action Description

Window.Show Shows a window.
Window.Close Closes a window.
Window.SetDisplayFormat Sets a window’s item display format.
Window.Add Adds a symbol to a window.
Window.Remove Removes a symbol from a window.
Window.Clear Clears a window.
Window.ExpandAll Expands all items of a window.
Window.CollapseAll Collapses all items of a window.
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7.9.19    Watch Actions
Actions affiliated with the Watched Data Window.

Action Description

Watch.Add Adds an expression to the Watched Data Window
Watch.Insert Inserts an expression into the Watched Data Window
Watch.Remove Removes an expression from the Watched Data Window
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7.10    User Actions

7.10.1    File Actions

7.10.1.1    File.NewProject
Creates a new project (see File Menu on page 38).

Prototype

int File.NewProject();

Return Value

-1: error
0: success

GUI Access

Main Menu → File → New → New Project (Ctrl+N)

7.10.1.2    File.NewProjectWizard
Opens the Project Wizard (see Project Wizard on page 31).

Prototype

int File.NewProjectWizard();

Return Value

-1: error
0: success

GUI Access

Main Menu → File → New → New Project Wizard (Ctrl+Alt+N)

7.10.1.3    File.Open
Opens a file (see File Menu on page 38). When a program file is opened and the debug
session is running, the program is automatically downloaded to target memory.

Note

Special care must be taken when placing this command within script functions (see
Avoiding Script Function Recursions on page 149).

Prototype

int File.Open(const char* sFilePath);

Argument Meaning

sFilePath File path of a project-, source- or program-file. The file path may con-
tain directory macros (see Directory Macros on page 182).

Return Value

-1: error
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0: success

GUI Access

Main Menu → File → Open (Ctrl+O)

7.10.1.4    File.OpenRecent
Reopens a recently opened program file.

Prototype

int File.OpenRecent(int Index);

Argument Meaning

Index Position of the file within the file menu’s recent programs list, starting
at index 0.

Return Value

-1: error
0: success

GUI Access

Main Menu → File → Recent Programs

7.10.1.5    File.Find
Searches a text pattern in source code documents (see Find Dialog on page 61).

Prototype

int File.Find(const char* sFindWhat);

Return Value

-1: error
0: success

GUI Access

Source Viewer → Context Menu → Find (Ctrl+F)

7.10.1.6    File.Load
Downloads a program or data file to target memory. This command essentially performs
the same operation as File.Open, but it does not reset the target prior to download and
does not perform the initial program operation (see Download Behaviour Comparision on
page 149). When an ELF or compatible program file is specified, its debug symbols replace
any previously loaded debug symbols.

Note

Special care must be taken when placing this command within script functions (see
Avoiding Script Function Recursions on page 149).

Prototype

int File.Load(const char* sFilePath, U32 Address);
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Argument Meaning

sFilePath Path to a program or data file. The file path may contain directory
macros (see Directory Macros on page 182).

Address Memory address to download the data contents to. In case the ad-
dress is provided by the file itself, 0 can be specified.

Return Value

-1: error
0: success

GUI Access

None

7.10.1.7    File.Close
Closes a document (see Source Viewer on page 118).

Prototype

int File.Close(const char* sFilePath);

Argument Meaning

sFilePath File path (or name) of a source file. The file path may contain directo-
ry macros (see Directory Macros on page 182).

Return Value

-1: error
0: success

GUI Access

Document Tab → Context Menu → Close (Ctrl+F4)

7.10.1.8    File.CloseAll
Closes all open documents (see File Menu on page 38).

Prototype

int File.CloseAll();

Return Value

-1: error
0: success

GUI Access

Hotkey (Ctrl+Alt+F4)

7.10.1.9    File.CloseAllButThis
Closes all but the active document (see Source Viewer on page 118).

Prototype

int File.CloseAllButThis();
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Return Value

-1: error
0: success

GUI Access

Document Tab → Context Menu → Close All But This (Ctrl+Shift+F4)

7.10.1.10    File.SaveAll
Saves all modified files.

Prototype

int File.SaveAll();

Return Value

-1: error
0: success

GUI Access

Main Menu → File → Save all

7.10.1.11    File.SaveProjectAs
Saves the project file under a new file path.

Prototype

int File.SaveProjectAs(const char* sFilePath);

Argument Meaning

sFilePath File path (or name) of a .jdebug file. The file path may contain direc-
tory macros (see Directory Macros on page 182).

Return Value

-1: error
0: success

GUI Access

Main Menu → File → Save Project as (Ctrl+Shift+S)

7.10.1.12    File.Exit
Closes the application (see File Menu on page 38).

Prototype

int File.Exit();

Return Value

-1: error
0: success
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GUI Access

Main Menu → File → Exit (Alt+F4)

7.10.2    Find Actions

7.10.2.1    Find.Text
Searches a text pattern in the current document (see Find Dialog on page 61).

Prototype

int Find.Text(const char* sText);

Return Value

-1: error
0: success

GUI Access

Main Menu → Find → Find Text (Ctrl+F)

7.10.2.2    Find.Function
Locates a program function.

Prototype

int Find.Function(const char* sFunction);

Return Value

-1: error
0: success

GUI Access

Main Menu → Find → Find Function (Ctrl+M)

7.10.2.3    Find.GlobalData
Locates a global data symbol.

Prototype

int Find.GlobalData(const char* sSymbol);

Return Value

-1: error
0: success

GUI Access

Main Menu → Find → Find Global Data (Ctrl+L)

7.10.3    Tools Actions
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7.10.3.1    Tools.JLinkSettings
Opens the J-Link Settings Dialog (see J-Link Settings Dialog on page 59).

Prototype

int Tools.JLinkSettings();

Return Value

-1: error
0: success

GUI Access

Main Menu → Tools → J-Link Settings (Ctrl+Alt+J)

7.10.3.2    Tools.TraceSettings
Opens the Trace Settings Dialog (see Trace Settings Dialog on page 67).

Prototype

int Tools.TraceSettings();

Return Value

-1: error
0: success

GUI Access

Main Menu → Tools → Trace-Settings (Ctrl+Alt+T)

7.10.3.3    Tools.Preferences
Displays the User Preference Dialog (see User Preference Dialog on page 52).

Prototype

int Tools.Preferences();

Return Value

-1: error
0: success

GUI Access

Main Menu → Tools → Preferences (Ctrl+Alt+P)

7.10.3.4    Tools.SysVars
Displays the System Variable Editor (see System Variable Editor on page 56).

Prototype

int Tools.SysVars();

Return Value

-1: error
0: success
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GUI Access

Main Menu → Tools → System Variables (Ctrl+Alt+V)

7.10.4    Edit Actions

7.10.4.1    Edit.Preference
Edits a user preference.

Prototype

int Edit.Preference(int ID, int Value);

Argument Meaning

ID User preference identifier (see User Preference Identifiers on
page 175).

Value User preference value. Certain user preferences are specified in a
predefined format (see Value Descriptors on page 168).

Return Value

-1: error
0: success

GUI Access

None.

7.10.4.2    Edit.SysVar
Edits a system variable (see System Variable Identifiers on page 177).

Prototype

int Edit.SysVar(int ID, int Value);

Argument Meaning

ID System variable identifier (see System Variable Identifiers on
page 177).

Value System variable value. Certain system variable values are specified in
a predefined format (see Value Descriptors on page 168).

Return Value

-1: error
0: success

GUI Access

None.

7.10.4.3    Edit.Find
Searches a text pattern in the active document (see Source Viewer on page 118). Once
executed, hotkey F3 can be used to locate the next occurrence.
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Prototype

int Edit.Find(const char* sFindWhat);

Return Value

-1: error
0: success

GUI Access

Source Viewer → Context Menu → Find (Ctrl+F)

7.10.4.4    Edit.Color
Edits an application color (see Color Identifiers on page 174).

Prototype

int Edit.Color(int ID, int Value);

Argument Meaning

ID Color identifier (see Color Identifiers on page 174).
Value Color descriptor (see Color Descriptor on page 168).

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → Preferences → Appearance

7.10.4.5    Edit.Font
Edits an application font (see Font Identifiers on page 173).

Prototype

int Edit.Font(int ID, const char* sFont);

Argument Meaning

ID Font identifier (see Font Identifiers on page 173).
sFont Font descriptor (see Font Descriptor on page 168).

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → Preferences → Appearance

7.10.4.6    Edit.DisplayFormat
Edits an object’s value display format.
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Prototype

int Edit.DisplayFormat(const char* sObject, int Format);

Argument Meaning

sObject Name of a debug information window, program variable or register.
Format Value Display Formats (see Value Display Formats on page 170).

Return Value

-1: error
0: success

GUI Access

Window → Context Menu → Display As

7.10.4.7    Edit.RefreshRate
Sets the refresh rate of a watched expression (see Live Watches on page 147).

Prototype

int Edit.RefreshRate (const char* sExpression, int Freqency);

Argument Meaning

sExpression C-Language expression (see Expressions on page 181).
Frequency Update frequency in Hz (see Frequency Descriptor on page 168).

Return Value

-1: error
0: success

GUI Access

Watched Data Window → Context Menu → Refresh Rate

7.10.4.8    Edit.MemZone
Assigns a memory zone to a watched expression (see Live Watches on page 147). Whenever
an update of the expression’s value is requested, the specified memory zone is accessed.

Prototype

int Edit.MemZone (const char* sExpression, const char* sMemZone);

Argument Meaning

sExpression C-Language expression (see Expressions on page 181).
sMemZone Memory zone name

Return Value

-1: error
0: success

GUI Access

Watched Data Window → Context Menu → Memory Zone
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7.10.5    Window Actions

7.10.5.1    Window.Show
Shows a window (see Window Layout on page 108).

Prototype

int Window.Show(const char* sWindow);

Argument Meaning

sWindow Name of the window (e.g. “Source Files”). See View Menu on
page 38.

Return Value

-1: error
0: success

GUI Access

Main Menu → View → Window Name (Shift+Alt+Letter)

7.10.5.2    Window.Close
Closes a window (see Window Layout on page 108).

Prototype

int Window.Close(const char* sWindow);

Argument Meaning

sWindow Name of the window (e.g. “Source Files”). See View Menu on
page 38.

Return Value

-1: error
0: success

GUI Access

Close handle on window title bar (Alt+X)

7.10.5.3    Window.CloseAll
Closes all windows (see Window Layout on page 108).

Prototype

int Window.CloseAll();

Return Value

-1: error
0: success
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GUI Access

Main Menu → Window → Close All Window (Alt+Shift+X)

7.10.5.4    Window.SetDisplayFormat
Set’s a window’s value display format (see Display Format on page 44).

Prototype

int Window.SetDisplayFormat(const char* sWindow, int Format);

Argument Meaning

sWindow Name of the window (e.g. “Source Files”). See View Menu on
page 38.

Format Value display format (see Value Display Formats on page 170).

Return Value

-1: error
0: success

GUI Access

Window → Context Menu → Display All As (Alt+Number)

7.10.5.5    Window.Add
Adds a symbol to a debug window (see Debug Information Windows on page 70).

Prototype

int Window.Add(const char* sWindow, const char* sSymbol);

Return Value

-1: error
0: success

GUI Access

Window → Context Menu → Add (Alt+Plus)

7.10.5.6    Window.Insert
Inserts a symbol into a debug window (see Debug Information Windows on page 70).

Prototype

int Window.Insert (const char* sWindow, const char* sSymbol, const char*
sSymbolBefore);

Argument Meaning

sWindow Name of the window (e.g. “Source Files”). See View Menu on
page 38.

sSymbol Name of the symbol to insert.
sSymbolBefore Insert before this symbol. When emtpty, append the symbol.
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Return Value

-1: error
0: success

GUI Access

None

7.10.5.7    Window.Remove
Removes a symbol from a debug window (see Debug Information Windows on page 70).

Prototype

int Window.Remove(const char* sWindow, const char* sSymbol);

Return Value

-1: error
0: success

GUI Access

Window → Context Menu → Remove (Del)

7.10.5.8    Window.Clear
Clears a window.

Prototype

int Edit.TerminalSettings();

Return Value

-1: error
0: success

GUI Access

Window → Context Menu → Clear (Alt+Del)

7.10.5.9    Window.ExpandAll
Expands all expandable window items.

Prototype

int Window.ExpandAll();

Return Value

-1: error
0: success

GUI Access

Window → Context Menu → Expand All (Shift+Plus)
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7.10.5.10    Window.CollapseAll
Collapses all collapsible window items.

Prototype

int Window.CollapseAll();

Return Value

-1: error
0: success

GUI Access

Window → Context Menu → Clear (Shift+Minus)

7.10.6    Toolbar Actions

7.10.6.1    Toolbar.Show
Displays a toolbar (see Showing and Hiding Toolbars on page 42).

Prototype

int Toolbar.Show(const char* sToolbar);

Return Value

-1: error
0: success

GUI Access

Main Menu → View → Toolbars → Toolbar Name

7.10.6.2    Toolbar.Close
Hides a toolbar (see Showing and Hiding Toolbars on page 42).

Prototype

int Toolbar.Show(const char* sToolbar);

Return Value

-1: error
0: success

GUI Access

Main Menu → View → Toolbars → Toolbar Name

7.10.7    View Actions

7.10.7.1    View.Memory
Displays a memory location within the Memory Window (see Memory Window on page 104).
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Prototype

int View.Memory(unsigned int Address);

Return Value

-1: error
0: success

GUI Access

Memory Window → Context Menu → Goto Address (Ctrl+G)

7.10.7.2    View.Source
Displays the source code location of a variable, function or machine instruction within the
Source Viewer (see Source Viewer on page 118).

Prototype

int View.Source(const char* sLocation);

Argument Meaning

sLocation

Variable Name: displays a variable’s source location.
Function Name: displays the first source line of a function.
Memory Address: displays the source line affiliated with an instruc-
tion.
Source Location: displays a particular source location (see Source
Code Location Descriptor on page 168).

Return Value

-1: error
0: success

GUI Access

Symbol Windows → Context Menu → View Source (Ctrl+U)

7.10.7.3    View.Data
Displays the data location of a global or local program variable within the Register Win-
dow (see Register Window on page 113) or the Memory Window (see Memory Window on
page 104).

Prototype

int View.Data(const char* sVariable);

Return Value

-1: error
0: success

GUI Access

Symbol Windows → Context Menu → View Data (Ctrl+T)
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7.10.7.4    View.Disassembly
Displays the assembly code of a function or source code statement within the Disassembly
Window (see Disassembly Window on page 89).

Prototype

int View.Disassembly(const char* sLocation);

Argument Meaning

sLocation

Function Name: displays the first source line of a function.
Memory Address: displays the source line affiliated with an instruc-
tion.
Source Location: displays a particular source location (see Source
Code Location Descriptor on page 168).

Return Value

-1: error
0: success

GUI Access

Symbol Windows → Context Menu → View Disassembly (Ctrl+D)

7.10.7.5    View.CallGraph
Displays the call graph of a function.

Prototype

int View.CallGraph (const char* sFuncName);

Return Value

-1: error
0: success

GUI Access

→ Source Viewer → Context Menu → View Call Graph (Ctrl+H)

7.10.7.6    View.InstTrace
Displays a position in the history (stack) of executed machine instructions.

Prototype

int View.InstTrace (int StackPos);

Argument Meaning

StackPos Position 1 = most recently executed machine instruction.

Return Value

-1: error
0: success

GUI Access

→ Context Menu → Goto Position
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7.10.7.7    View.Line
Displays a text line in the active document.

Prototype

int View.Line(unsigned int Line);

Return Value

-1: error
0: success

GUI Access

Source Viewer → Context Menu → Goto Line (Ctrl+L)

7.10.7.8    View.PC
Displays the program’s execution point within the Disassembly Window (see Disassembly
Window on page 89).

Prototype

int View.PC();

Return Value

-1: error
0: success

GUI Access

Disassembly Window → Context Menu → Goto PC (Ctrl+P)

7.10.7.9    View.PCLine
Displays the program’s execution point within the Source Viewer (see Source Viewer on
page 118).

Prototype

int View.PCLine();

Return Value

-1: error
0: success

GUI Access

Source Viewer → Context Menu → Goto PC (Ctrl+P)

7.10.7.10    View.NextResult
Displays the next search result.

Prototype

int View.NextResult();
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Return Value

-1: error
0: success

GUI Access

None.

7.10.7.11    View.PrevResult
Displays the previous search result.

Prototype

int View.PrevResult();

Return Value

-1: error
0: success

GUI Access

None.

7.10.8    Utility Actions

7.10.8.1    Util.Sleep
Pauses the current operation for a given amount of time.

Prototype

int Util.Sleep(int milliseconds);

Return Value

-1: error
0: success

GUI Access

None

7.10.8.2    Util.Log
Prints a message to the Console Window (see Console Window on page 81).

Prototype

int Util.Log(const char* sMessage);

Return Value

-1: error
0: success

GUI Access

None
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7.10.8.3    Util.LogHex
Appends an integer value to a text message and prints the result to the Console Window
(see Console Window on page 81).

Prototype

int Util.LogHex(const char* sMessage, unsigned int IntValue);

Return Value

-1: error
0: success

GUI Access

None

7.10.9    Script Actions

7.10.9.1    Script.Exec
Executes a project file script function. The command currently only supports script functions
with void parameter or with up to seven arguments of type __int64.

Prototype

int Script.Exec(const char* sFuncName, __int64 Para1, __int64 Para2,..);

Return Value

Return value of the executed function (-1 if execution failed).

GUI Access

None

7.10.9.2    Script.DefineConst
Defines a constant integer value to be used within the project file script.

Prototype

int Script.DefineConst(const char* sName, const char* sExpression);

Argument Meaning

sName Name of the constant.

sExpression
Symbol expression that evaluates to a numeric value of size ≤ 8
bytes (see Expressions on page 181). The symbol expression cannot
contain local variables.

Return Value

-1: error
0: success

GUI Access

None
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7.10.10    Debug Actions

7.10.10.1    Debug.Start
Starts the debug session (see Starting the Debug Session on page 136). The startup routine
can be reprogrammed (see TargetConnect on page 163).

Prototype

int Debug.Start();

Return Value

-1: error
0: success

GUI Access

Main Menu → Debug → Start Debugging (F5)

7.10.10.2    Debug.Stop
Stops the debug session (see Stopping the Debug Session on page 158).

Prototype

int Debug.Stop();

Return Value

-1: error
0: success

GUI Access

Main Menu → Debug → Stop Debugging (Shift+F5)

7.10.10.3    Debug.Disconnect
Disconnects the debugger from the target.

Prototype

int Debug.Disconnect();

Return Value

-1: error
0: success

GUI Access

None

7.10.10.4    Debug.Connect
Establishes a J-Link connection to the target and starts the debug session in the default way.
A reprogramming of the startup procedure via script function “Target- Connect” is ignored.

Prototype

int Debug.Connect();
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Return Value

-1: error
0: success

GUI Access

None

7.10.10.5    Debug.SetConnectMode
Sets the connection mode (see Connection Mode on page 136).

Prototype

int Debug.SetConnectMode(int Mode);

Argument Meaning

Mode Connection mode (see Connection Modes on page 171).

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → System Variables (Ctrl+Alt+V)

7.10.10.6    Debug.Continue
Resumes program execution (see Resume on page 141).

Prototype

int Debug.Continue();

Return Value

-1: error
0: success

GUI Access

Main Menu → Debug → Continue (F5)

7.10.10.7    Debug.Halt
Halts program execution (see Halt on page 141).

Prototype

int Debug.Halt();

Return Value

-1: error
0: success

GUI Access

Main Menu → Debug → Halt (Ctrl+F5)
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7.10.10.8    Debug.Reset
Resets the target and the debuggee (see Reset on page 140). The reset operation can be
customized via the scripting interface (see TargetReset on page 163).

Prototype

int Debug.Reset();

Argument Meaning

Mode Reset mode (see Reset Modes on page 171).

Return Value

-1: error
0: success

GUI Access

Main Menu → Debug → Reset (F4)

7.10.10.9    Debug.SetResetMode
Sets the reset mode. The reset mode determines how the program is reset (see Reset Mode
on page 140).

Prototype

int Debug.SetResetMode(int Mode);

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → System Variables (Ctrl+Alt+V)

7.10.10.10    Debug.StepInto
Steps into the current subroutine (see Step on page 140).

Prototype

int Debug.StepInto();

Return Value

-1: error
0: success

GUI Access

Main Menu → Debug → Step Into (F11)

7.10.10.11    Debug.StepOver
Steps over the current subroutine (see Step on page 140).
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Prototype

int Debug.StepOver();

Return Value

-1: error
0: success

GUI Access

Main Menu → Debug → Step Over (F12)

7.10.10.12    Debug.StepOut
Steps out of the current subroutine. (see Step on page 140).

Prototype

int Debug.StepOut();

Return Value

-1: error
0: success

GUI Access

Main Menu → Debug → StepOut (Shift+F11)

7.10.10.13    Debug.SetNextPC
Sets the execution point to a particular machine instruction (see Execution Point on
page 145).

Prototype

int Debug.SetNextPC(unsigned int Address);

Return Value

-1: error
0: success

GUI Access

Disassembly Window → Context Menu → Set Next PC (Shift+F10)

7.10.10.14    Debug.SetNextStatement
Sets the execution point to a particular source code line (see Execution Point on page 145).

Prototype

int Debug.SetNextStatement(const char* sStatement);

Argument Meaning

sStatement
Function Name: displays the first source line of a function.
Source Location: displays a particular source location (see Source
Code Location Descriptor on page 168).
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Return Value

-1: error
0: success

GUI Access

Source Viewer → Context Menu → Set Next Statement (Shift+F10)

7.10.10.15    Debug.RunTo
Advances the program execution point to a particular source code line, function or instruc-
tion address (see Execution Point on page 145).

Prototype

int Debug.RunTo(const char* sLocation);

Argument Meaning

sStatement

Function Name: advances program execution to the first source line
of a function.
Memory Address: advances program execution to a particular instruc-
tion address.
Source Location: advances program execution to a particular source
code line (see Source Code Location Descriptor on page 168).

Return Value

-1: error
0: success

GUI Access

Code Window → Context Menu → Run To Cursor (Ctrl+F10)

7.10.10.16    Debug.Download
Downloads the debuggee to the target (see Program Files on page 135). The download
operation can be reprogrammed (see TargetDownload on page 163).

Prototype

int Debug.Download();

Return Value

-1: error
0: success

GUI Access

None

7.10.10.17    Debug.ReadIntoInstCache
Initializes the instruction cache with target memory data (see Instruction Cache on
page 153).

Prototype

int Debug.ReadIntoInstCache(U32 Address, U32 Size);
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Argument Meaning

Address Start address of the target memory block to be read into the instruc-
tion cache.

Size Byte size of the target memory block to be read into the instruction
cache.

Return Value

-1: error
0: success

GUI Access

None

7.10.11    Help Actions

7.10.11.1    Help.About
Shows the About Dialog.

Prototype

int Help.About();

Return Value

-1: error
0: success

GUI Access

Main Menu → Help → About

7.10.11.2    Help.Manual
Opens Ozone’s user manual within the default PDF viewer.

Prototype

int Help.Manual();

Return Value

-1: error
0: success

GUI Access

Main Menu → Help → User Guide (F1)

7.10.11.3    Help.Commands
Prints the command help to the Console Window (see Command Help on page 82)

Prototype

int Help.Commands();
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Return Value

-1: error
0: success

GUI Access

Console Window → Context Menu → Help (Shift+F1)

7.10.12    Project Actions

7.10.12.1    Project.SetDevice
Specifies the target device (see J-Link Settings Dialog on page 59).

Prototype

int Project.SetDevice(const char* sDeviceName);

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → J-Link Settings (Ctrl+Alt+J)

7.10.12.2    Project.SetHostIF
Specifies the host interface (see Host Interfaces on page 170).

Prototype

int Project.SetHostIF(const char* sHostIF, const char* sHostID);

Argument Meaning

sHostIF Host interface (see Host Interfaces on page 170).
sHostID Host identifier (USB serial number or IP address).

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → J-Link Settings (Ctrl+Alt+J)

7.10.12.3    Project.SetTargetIF
Specifies the target interface (see Target Interfaces on page 170).

Prototype

int Project.SetTargetIF(const char* sTargetIF);
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Argument Meaning

sTargetIF Target interface (see Target Interfaces on page 170).

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → J-Link Settings (Ctrl+Alt+J)

7.10.12.4    Project.SetTIFSpeed
Specifies the target interface speed (see J-Link Settings Dialog on page 59).

Prototype

int Project.SetTIFSpeed(const char* sFrequency);

Argument Meaning

sFrequency Frequency Descriptor (see Frequency Descriptor on page 168).

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → J-Link Settings (Ctrl+Alt+J)

7.10.12.5    Project.SetJTAGConfig
Configures the JTAG target interface scan chain parameters.

Prototype

int Project.SetJTAGConfig(int DRPre, int IRPre);

Argument Meaning

DRPre Position of the target in the JTAG scan chain. 0 is closest to TDO.
IRPre Sums of IR-Lens of devices closer to TDO. IRLen of ARM devices is 4.

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → J-Link Settings (Ctrl+Alt+J)

7.10.12.6    Project.SetBPType
Sets the permitted breakpoint implementation type, i.e. restricts breakpoints to be imple-
mented in the way specified by the command argument.
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Prototype

int Project.SetBPType(int Type);

Argument Meaning

Type Breakpoint Implementation Types (see Breakpoint Implementation
Types on page 171).

Return Value

-1: error
0: success

GUI Access

Code Window → Context Menu → Edit Breakpoint (F8)

7.10.12.7    Project.SetCorePlugin
Overrides the default file path of the target support plugin (see Target Support Plugins on
page 24.

Prototype

int Project.SetCorePlugin(const char* sFilePath);

Argument Meaning

sFilePath
Plugin file path or name. Valid plugin file extensions are .dll on Win-
dows, .so on linux and .dylib on macOS. The file path may be speci-
fied case-insensitively.

Return Value

-1: error
0: success

GUI Access

None

7.10.12.8    Project.SetOSPlugin
Specifies the file path or name of the plugin that adds RTOS awareness to the debugger.

Prototype

int Project.SetOSPlugin(const char* sFilePath);

Argument Meaning

sFilePath

Plugin file path or name. Use argument “embosPlugin” to config-
ure embOS awareness and “FreeRTOSPlugin” to configure FreeRTOS
awareness. Valid plugin file extensions are .dll on Windows, .so on
Linux and .dylib on macOS. The file path may be specified case-insen-
sitively. The file extension may be omitted.

Return Value

-1: error
0: success
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GUI Access

None

7.10.12.9    Project.SetRTT
Enables or disables the Real-Time Transfer (RTT) IO interface (see Real-Time Transfer on
page 148).

Prototype

int Project.SetRTT(int OnOff);

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → System Variables (Ctrl+Alt+V)

7.10.12.10    Project.AddRTTSearchRange
Configures the Real-Time Transfer (RTT) IO interface (see Real-Time Transfer on page 148).
This command makes it possible to use RTT (and only needs to be supplied) when both:
• Ozone (J-Link) has no information about the target’s data memory address range and
• the connection mode is “ATTACH” or “ATTACH_HALT”.

For further details, refer to the  J-Link User Guide .

Prototype

int Project.AddRTTSearchRange(U32 StartAddr, U32 Size);

Argument Meaning

StartAddr −
Size Address range to be considered in the RTT buffer localization routine.

Return Value

-1: error
0: success

GUI Access

None

7.10.12.11    Project.SetTraceSource
Selects the trace source to be used.

Prototype

int Project.SetTraceSource(const char* sTraceSrc);

Argument Meaning

sTraceSrc Display name of the trace source to be used (see Trace Sources on
page 172).

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH

https://www.segger.com/jlink-sdk.html


225 CHAPTER 7 User Actions

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → Trace Settings (Ctrl+Alt+T)

7.10.12.12    Project.SetSemihosting
Enables or disables the Semihosting IO interface (see Semihosting on page 148).

Prototype

int Project.SetSemihosting(int OnOff);

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → System Variables (Ctrl+Alt+V)

7.10.12.13    Project.ConfigSemihosting
Configures the Semihosting IO interface (see Semihosting on page 148).

Prototype

int Project.ConfigSemihosting(const char* sConfig);

Argument Meaning

sConfig Configuration string of the format “setting1=value,setting2=value…”.
The valid settings are architecture-dependant and described below.

ARM

Setting Meaning

Vector

Semihosting vector address. The debugger will set a breakpoint on
this address in order to catch Semihosting requests by the debuggee
via the SWI instruction. The default value for this parameter is the
SWI exception vector (0x8). In case the debuggee makes pronounced
use of SWI’s that are not Semihosting requests, it will be advanta-
geous to set the Semihosting vector to an instruction within a cus-
tomized SWI handler. Please refer to the ARM ADS debug target
guide for further information.

UseSVC

Indicates if the debuggee issues Semihosting requests via SWI. The
default value of this parameter is 1. When set to 0, the debugger will
not set a breakpoint on the Semihosting vector. This can potentially
improve the run performance of the debuggee whilst using Semihost-
ing.

Return Value

-1: error
0: success
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GUI Access

None

7.10.12.14    Project.SetTracePortWidth
Specifies the number of trace pins (data lines) comprising the target’s trace port. This set-
ting is only relevant when the selected trace source is “Trace Pins” / ETM (see Project.Set-
TraceSource on page 224).

Prototype

int Project.SetTracePortWidth(int PortWidth);

Argument Meaning

PortWidth Number of trace data lines provided by the target. Possible values are
1, 2 or 4.

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → Trace Settings (Ctrl+Alt+T)

7.10.12.15    Project.SetTraceTiming
This command adjusts the trace pin sampling delays. The delays may be necessary in case
the target hardware does not provide sufficient setup and hold times for the trace pins.
In such cases, delaying TCLK can compensate this and make tracing possibly anyhow.
This setting is only relevant when the selected trace source is “Trace Pins” / ETM (see
Project.SetTraceSource on page 224).

Prototype

int Project.SetTraceTiming(int d1, int d2, int d3, int d4);

Argument Meaning

dn Trace data pin n sampling delay in picoseconds. Only the first para-
meters are relevant when your hardware has less than 4 trace pins.

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → Trace Settings (Ctrl+Alt+T)

7.10.12.16    Project.ConfigSWO
Configures the Serial Wire Output (SWO) IO interface (see SWO on page 148). This setting
is only relevant when the selected trace source is SWO (see Project.SetTraceSource on
page 224).
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Prototype

int Project.ConfigSWO(const char* sSWOFreq, char* sCPUFreq);

Argument Meaning

sSWOFreq Specifies the data transmission speed on the SWO interface (see Fre-
quency Descriptor on page 168).

sCPUFreq Specifies the target’s processor frequency (see Frequency Descriptor
on page 168).

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → Trace Settings (Ctrl+Alt+T)

7.10.12.17    Project.SetMemZoneRunning
Specifies the default memory zone that is accessed when the program is running. The de-
bugger uses this memory zone for any memory access that has not been explicitly assigned
to a particular memory zone.

Prototype

int Project.SetMemZoneRunning(const char* sMemoryZone);

Argument Meaning

sMemoryZone Name of the default memory zone

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → System Variables (Ctrl+Alt+T)

7.10.12.18    Project.AddSvdFile
Adds a register set description file to be loaded by the Register Window (see SVD Files
on page 113).

Prototype

int Project.AddSvdFile(const char* sFilePath);

Argument Meaning

sFilePath
Path to a CMSIS-SVD file. Both .svd and .xml file extensions are sup-
ported. The file path may contain directory macros (see Directory
Macros on page 182).

Return Value

-1: error
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0: success

GUI Access

None

7.10.12.19    Project.AddFileAlias
Adds a file path alias (see File Path Resolution Sequence on page 183).

Prototype

int Project.AddFileAlias(const char* sFilePath, const char* sAliasPath);

Argument Meaning

sFilePath Original file path as it appears within the program file or elsewhere.
sAliasPath Replacement for the original file path.

Return Value

-1: error
0: success

GUI Access

Source Files Window → Context Menu → Locate File (Space)

7.10.12.20    Project.AddRootPath
Adds a source file root path. The root path helps the debugger resolve relative file path
arguments (see File Path Resolution on page 183). Typically a project will have a single
source file root path.

Prototype

int Project.SetRootPath(const char* sRootPath);

Argument Meaning

sRootPath Fully qualified path of a file system directory.

Return Value

-1: error
0: success

GUI Access

None

7.10.12.21    Project.AddPathSubstitute
Replaces a substring within unresolved source file path arguments (see File Path Resolution
on page 183).

Prototype

int Project.AddPathSubstitute(const char* sSubStr, const char* sAlias);
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Argument Meaning

sSubStr Substring of the original file path.
sAlias Replacement for the given substring.

Return Value

-1: error
0: success

GUI Access

None

7.10.12.22    Project.AddSearchPath
Adds a directory to the list of search directories. Search directories help the debugger
resolve invalid file path arguments (see File Path Resolution on page 183).

Prototype

int Project.AddSearchPath(const char* sSearchPath);

Argument Meaning

sSearchPath Fully qualified path of a file system directory.

Return Value

-1: error
0: success

GUI Access

None

7.10.12.23    Project.SetJLinkScript
Specifies the J-Link script file that is to be executed at the moment the debug session is
started. Refer to the  J-Link User Guide  for on overview on J-Link script files.

Prototype

int Project.SetJLinkScript(const char* sFilePath);

Argument Meaning

sFilePath Path to a J-Link script file. The file path may contain directory macros
(see Directory Macros on page 182).

Return Value

-1: error
0: success

GUI Access

None
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7.10.12.24    Project.SetJLinkLogFile
Specifies the text file that receives J-Link logging output.

Prototype

int Project.SetJLinkLogFile(const char* sFilePath);

Argument Meaning

sFilePath Path to a text file. The file path may contain directory macros (see Di-
rectory Macros on page 182).

Return Value

-1: error
0: success

GUI Access

None

7.10.12.25    Project.RelocateSymbols
Relocates one or multiple symbols.

Prototype

int Project.RelocateSymbols(const char* sSymbols, int Offset);

Argument Meaning

sSymbols
Specifies the symbols to be relocated. The wildcard character “*” se-
lects all symbols. A symbol name specifies a single symbol. A section
name such as “.text” specifies a particular ELF data section.

Offset The offset that is added to the base addresses of all specified sym-
bols.

Return Value

-1: error
0: success

GUI Access

None

7.10.12.26    Project.SetConsoleLogFile
Sets the text file to which Console Window messages are logged.

Prototype

int Project.SetConsoleLogFile(const char* sFilePath);

Argument Meaning

sFilePath Logfile. The file path may contain directory macros (see Directory
Macros on page 182).

Return Value

-1: error
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0: success

GUI Access

None

7.10.12.27    Project.SetTerminalLogFile
Sets the text file to which Terminal Window messages are logged.

Prototype

int Project.SetTerminalLogFile(const char* sFilePath);

Argument Meaning

sFilePath Logfile. The file path may contain directory macros (see Directory
Macros on page 182).

Return Value

-1: error
0: success

GUI Access

None

7.10.12.28    Project.DisableSessionSave
Selects the session information that is not to be saved to the user file.

Prototype

int Project.DisableSessionSave(unsigned int Flags);

Argument Meaning

Flags

Bitwise-OR combination of individual flags. Each flag specifies a ses-
sion information that is not to be saved to (and restored from) the
user file. Refer to Session Save Flags on page 173 for the list of sup-
ported flags.

Return Value

-1: error
0: success

GUI Access

None

7.10.13    Code Profile Actions

7.10.13.1    Profile.Exclude
Filters program entities from the code profile (load) statistic. The code profile statistic is
re-evaluated as if the filtered items had never belonged to the program.
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Prototype

int Profile.Exclude (const char* sFilter);

Argument Meaning

sFilter

Specifies the items to be filtered. All items that exactly match the fil-
ter string are moved to the filtered set. Wildcard (*) characters can
be placed at the front or end of the filter string to perform partial
match filtering.

Return Value

-1: error
0: success

GUI Access

Code Profile Window → Context Menu → Exclude…

7.10.13.2    Profile.Include
Re-adds filtered items to the code profile load statistic.

Prototype

int Profile.Include (const char* sFilter);

Argument Meaning

sFilter

Specifies the items to be unfiltered. All items that exactly match the
filter string are removed from the filtered set. Wildcard (*) characters
can be placed at the front or end of the filter string to perform partial
match unfiltering.

Return Value

-1: error
0: success

GUI Access

Code Profile Window → Context Menu → Include…

7.10.13.3    Coverage.Exclude
Filters program entities from the code coverage statistic. The code coverage statistic is re-
evaluated as if the filtered items had never belonged to the program.

Prototype

int Coverage.Exclude (const char* sFilter);

Argument Meaning

sFilter

Specifies the items to be filtered. All items that exactly match the fil-
ter string are moved to the filtered set. Wildcard (*) characters can
be placed at the front or end of the filter string to perform partial
match filtering.

Return Value

-1: error

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH



233 CHAPTER 7 User Actions

0: success

GUI Access

Code Profile Window → Context Menu → Exclude…

7.10.13.4    Coverage.Include
Re-adds filtered items to the code coverage statistic.

Prototype

int Coverage.Include (const char* sFilter);

Argument Meaning

sFilter

Specifies the items to be unfiltered. All items that exactly match the
filter string are removed from the filtered set. Wildcard (*) characters
can be placed at the front or end of the filter string to perform partial
match unfiltering.

Return Value

-1: error
0: success

GUI Access

Code Profile Window → Context Menu → Include…

7.10.13.5    Coverage.ExcludeNOPs
Excludes instructions without operation (alignment instructions) from the code coverage
statistics.

Prototype

int Coverage.ExcludeNOPs ();

Return Value

-1: error
0: success

GUI Access

Code Profile Window → Context Menu → Exclude All NOP Instructions…

7.10.13.6    Profile.Export
Exports the current code profile dataset to a text file (as a human-readable report).

Prototype

int Profile.Export (const char* sFilePath);

Argument Meaning

sFilePath Destination text file.

Return Value

-1: error
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0: success

GUI Access

Code Profile Window → Context Menu → Export…

7.10.13.7    Profile.ExportCSV
Exports the current code profile dataset to a CSV file.

Prototype

int Profile.ExportCSV (const char* sFilePath, int Format);

Argument Meaning

sFilePath Destination CSV file.

Format Specifies which program entities are be exported to the CSV file (see
Code Profile Export Formats on page 173)

Return Value

-1: error
0: success

GUI Access

Code Profile Window → Context Menu → Export…

7.10.14    Target Actions

7.10.14.1    Target.SetReg
Writes a target register (see Target Registers on page 146).

Prototype

int Target.SetReg(const char* sRegName, unsigned int Value);

Argument Meaning

sRegName Name of a core, FPU or coprocessor register (see Coprocessor Regis-
ter Descriptor on page 169).

Value Register value to write.

Return Value

-1: error
0: success

GUI Access

None

7.10.14.2    Target.GetReg
Reads a target register (see Target Registers on page 146).
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Prototype

U32 Target.GetReg(const char* RegName);

Argument Meaning

sRegName Name of a core, FPU or coprocessor register (see Coprocessor Regis-
ter Descriptor on page 169).

Return Value

-1: error
register value: success

GUI Access

None

7.10.14.3    Target.WriteU32
Writes a word to target memory (see Target Memory on page 146).

Prototype

int Target.WriteU32(U32 Address, U32 Value);

Return Value

-1: error
0: success

GUI Access

None

7.10.14.4    Target.WriteU16
Writes a half word to target memory (see Target Memory on page 146).

Prototype

int Target.WriteU16(U32 Address, U16 Value);

Return Value

-1: error
0: success

GUI Access

None

7.10.14.5    Target.WriteU8
Writes a byte to target memory (see Target Memory on page 146).

Prototype

int Target.WriteU8(U32 Address, U8 Value);

Return Value

-1: error
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0: success

GUI Access

None

7.10.14.6    Target.ReadU32
Reads a word from target memory (see Target Memory on page 146).

Prototype

U32 Target.ReadU32(U32 Address);

Return Value

-1: error
Memory value: success

GUI Access

None

7.10.14.7    Target.ReadU16
Reads a half word from target memory (see Target Memory on page 146).

Prototype

U16 Target.ReadU16(U32 Address);

Return Value

-1: error
Memory value: success

GUI Access

None

7.10.14.8    Target.ReadU8
Reads a byte from target memory (see Target Memory on page 146).

Prototype

U32 Target.ReadU8(U32 Address);

Return Value

-1: error
Memory value: success

GUI Access

None

7.10.14.9    Target.SetAccessWidth
Specifies the default access width to be used when accessing target memory (see Tar-
get.SetAccessWidth on page 236).
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Prototype

int Target.SetAccessWidth(U32 AccessWidth);

Argument Meaning

AccessWidth Memory access width (See Memory Access Widths on page 171).

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → System Variables (Ctrl+Alt+V)

7.10.14.10    Target.FillMemory
Fills a block of target memory with a particular value (see Target.FillMemory on page 237).

Prototype

int Target.FillMemory(U32 Address, U32 Size, U8 FillValue);

Argument Meaning

Address Start address of the memory block to fill.
Size Size of the memory block to fill.
FillValue Value to fill the memory block with.

Return Value

-1: error
0: success

GUI Access

Memory Window → Context Menu → Fill (Ctrl+F)

7.10.14.11    Target.SaveMemory
Saves a block of target memory to a binary data file (see Target.SaveMemory on
page 237).

Prototype

int Target.SaveMemory(const char* sFilePath, U32 Address, U32 Size);

Argument Meaning

sFilePath Fully qualified path of the destination binary data file (*.bin).
Address Start address of the memory block to save to the destination file.
Size Size of the memory block to save to the destination file.

Return Value

-1: error
0: success
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GUI Access

Memory Window → Context Menu → Save (Ctrl+E)

7.10.14.12    Target.LoadMemory
Downloads the contents of a binary data file to target memory (see Download Behaviour
Comparision on page 149).

Prototype

int Target.LoadMemory(const char* sFilePath, U32 Address);

Argument Meaning

sFilePath Path to the binary data file (*.bin). The file path may contain directo-
ry macros (see Directory Macros on page 182).

Address Download address.

Return Value

-1: error
0: success

GUI Access

Memory Window → Context Menu → Load (Ctrl+L)

7.10.14.13    Target.SetEndianess
Sets the data endianness mode of the target.

Prototype

int Target.SetEndianess(int BigEndian);

Argument Meaning

BigEndian When 0, little endian is selected. Otherwise, big endian is selected.

Return Value

-1: error
0: success

GUI Access

Main Menu → Edit → J-Link-Settings → Target Device (Ctrl+Alt+J)

7.10.14.14    Target.LoadMemoryMap
Initializes the target’s memory map from the contents of a memory map file. The initialized
memory map can be observed using the Memory Usage Window on page 108.

Prototype

int Target.LoadMemoryMap(const char* sFilePath);

Argument Meaning

sFilePath Path to a memory map file. Currently, the only supported file format
is Segger Embedded Studio.
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Return Value

-1: error
0: success

GUI Access

None

7.10.14.15    Target.AddMemorySegment
Adds a segment to the target’s memory map (see Supplying Segment Information on
page 109).

Prototype

int Target.AddMemorySegment(const char* sName, U32 Addr, U32 Size);

Argument Meaning

sName Segment name.
Addr Segment base address.
Size Segment byte size.

Return Value

-1: error
0: success

GUI Access

None.

7.10.15    J-Link Actions

7.10.15.1    Exec.Connect
Establishes a J-Link connection to the target and triggers the default startup sequence (see
TargetConnect on page 163).

Prototype

int Exec.Connect();

Return Value

-1: error
0: success

GUI Access

None

7.10.15.2    Exec.Reset
Performs a hardware reset of the target (see Reset on page 140).

Prototype

int Exec.Reset();
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Return Value

-1: error
0: success

GUI Access

None

7.10.15.3    Exec.Download
Downloads the contents of a program or data file to target memory (see Download Behav-
iour Comparision on page 149).

Prototype

int Exec.Download(const char* sFilePath);

Return Value

-1: error
0: success

GUI Access

None

7.10.15.4    Exec.Command
Executes a J-Link command.

Prototype

int Exec.Command(const char* sCommand);

Argument Meaning

sCommand J-Link command to execute (refer to the  J-Link User Guide  for on
overview on the available commands).

Return Value

-1: error
0: success

GUI Access

None

7.10.16    Breakpoint Actions

7.10.16.1    Break.Set
Sets an instruction breakpoint (see Instruction Breakpoints on page 142).

Prototype

int Break.Set(U32 Address);
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Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Set / Clear (Alt+Plus)

7.10.16.2    Break.SetEx
Sets an instruction breakpoint of a particular implementation type (see Instruction Break-
points on page 142).

Prototype

int Break.SetEx(U32 Address, int Type);

Argument Meaning

Address Instruction address.

Type Breakpoint Implementation Types (see Breakpoint Implementation
Types on page 171).

Return Value

-1: error
0: success

GUI Access

None

7.10.16.3    Break.SetOnSrc
Sets a source breakpoint (see Source Breakpoints on page 142).

Prototype

int Break.SetOnSrc(const char* sLocation);

Argument Meaning

sLocation
Function Name: displays the first source line of a function.
Source Location: displays a particular source location (see Source
Code Location Descriptor on page 168).

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Set / Clear (Alt+Plus)

7.10.16.4    Break.SetOnSrcEx
Sets a source breakpoint of a particular implementation type (see Source Breakpoints on
page 142).
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Prototype

int Break.SetOnSrc(const char* sLocation, int Type);

Argument Meaning

sLocation
Function Name: displays the first source line of a function.
Source Location: displays a particular source location (see Source
Code Location Descriptor on page 168).

Type Breakpoint Implementation Types (see Breakpoint Implementation
Types on page 171).

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Set / Clear (Alt+Plus)

7.10.16.5    Break.SetType
Sets a breakpoint’s permitted implementation type (see Breakpoint Implementation Types
on page 171).

Prototype

int Break.SetType(const char* sLocation, int Type);

Argument Meaning

sLocation
Location of the breakpoint as displayed within the first column of
the Breakpoint Window (see Breakpoints/Tracepoints Window on
page 71).

Type Breakpoint Implementation Types (see Breakpoint Implementation
Types on page 171).

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Edit (F8)

7.10.16.6    Break.Clear
Clears an instruction breakpoint (see Instruction Breakpoints on page 142).

Prototype

int Break.Clear(U32 Address);

Return Value

-1: error
0: success
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GUI Access

Breakpoint Window → Context Menu → Set / Clear (F9)

7.10.16.7    Break.ClearOnSrc
Clears a source breakpoint (see Source Breakpoints on page 142).

Prototype

int Break.ClearOnSrc(const char* sLocation);

Parameter Description

Refer to Break.SetOnSrc on page 241.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Set / Clear (F9)

7.10.16.8    Break.Enable
Enables an instruction breakpoint (see Instruction Breakpoints on page 142).

Prototype

int Break.Enable(U32 Address);

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Enable (Shift+F9)

7.10.16.9    Break.Disable
Disables an instruction breakpoint (see Instruction Breakpoints on page 142).

Prototype

int Break.Disable(U32 Address);

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Disable (Shift+F9)

7.10.16.10    Break.EnableOnSrc
Enables a source breakpoint (see Source Breakpoints on page 142).
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Prototype

int Break.EnableOnSrc(const char* sLocation);

Parameter Description

Refer to Break.SetOnSrc on page 241.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Enable (Shift+F9)

7.10.16.11    Break.DisableOnSrc
Disables a source breakpoint (see Source Breakpoints on page 142).

Prototype

int Break.DisableOnSrc(const char* sLocation);

Parameter Description

Refer to Break.SetOnSrc on page 241.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Disable (Shift+F9)

7.10.16.12    Break.Edit
Edits a breakpoint’s advanced properties.

Prototype

int Break.Edit(const char* sLocation, const char* sCondition, int DoTrig-
gerOnChange, int SkipCount, const char* sTaskFilter, const char* sConsoleMsg,
const char* sMsgBoxMsg);

Argument Meaning

sLocation Location of the breakpoint as displayed within the Breakpoints/Trace-
points Window.

sCondition Symbol expression that must evaluate to non-zero for the breakpoint
to be triggered (see Expressions on page 181).

DoTriggerOn-
Change

Indicates whether the condition is met when the expression value has
changed since the last time it was evaluated (DoTriggerOnChange=1)
or when it does not equal zero (DoTriggerOnChange=0).

SkipCount Indicates how many times the breakpoint is skipped, i.e. how many
times the program is resumed when the breakpoint is hit.

sTaskFilter The name or ID of the RTOS task that triggers the breakpoint. When
empty, all RTOS tasks trigger the breakpoint. The task filter is on-
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Argument Meaning

ly operational when an RTOS plugin was specified using command
Project.SetOSPlugin.

sConsoleMsg Message printed to the Console Window when the breakpoint is trig-
gered.

sMsgBoxMsg Message displayed in a message box when the breakpoint is trig-
gered.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Edit (F8)

7.10.16.13    Break.SetOnData
Sets a data breakpoint (see Data Breakpoints on page 144).

Prototype

int Break.SetOnData(U32 Address, U32 AddressMask, U8 AccessType, U8 Ac-
cessSize, U32 MatchValue, U32 ValueMask);

Argument Meaning

Address Memory address that is monitored for IO (access) events.

AddressMask

Specifies which bits of the address are ignored when monitoring ac-
cess events. By means of the address mask, a single data breakpoint
can be set to monitor accesses to several individual memory address-
es.

AccessType Type of access that is monitored by the data breakpoint (see Connec-
tion Modes on page 171).

AccessSize

Access size condition required to trigger the data breakpoint. As an
example, a data breakpoint with an access size of 4 bytes (word)
will only be triggered when a word is written to one of the monitored
memory locations. It will not be triggered when, say, a byte is writ-
ten.

MatchValue
Value condition required to trigger the data breakpoint. A data break-
point will only be triggered when the match value is written to or read
from one of the monitored memory addresses.

ValueMask
Indicates which bits of the match value are ignored when monitoring
access events. A value mask of 0xFFFFFFFF means that all bits are ig-
nored, i.e. the value condition is disabled.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Set (Alt+Plus)
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7.10.16.14    Break.ClearOnData
Clears a data breakpoint (see Data Breakpoints on page 144).

Prototype

int Break.ClearOnData(U32 Address, U32 AddressMask, U8 AccessType, U8 Ac-
cessSize, U32 MatchValue, U32 ValueMask);

Parameter Description

Refer to Break.SetOnData on page 245.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Clear (F9)

7.10.16.15    Break.ClearAll
Clears all breakpoints (see Data Breakpoints on page 144).

Prototype

int Break.ClearAll();

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Clear All (Alt+Del)

7.10.16.16    Break.ClearAllOnData
Clears all data breakpoints (see Data Breakpoints on page 144).

Prototype

int Break.ClearAllOnData();

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Clear All (Alt+Del)

7.10.16.17    Break.EnableOnData
Enables a data breakpoint (see Data Breakpoints on page 144).
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Prototype

int Break.EnableOnData(U32 Address, U32 AddressMask, U8 AccessType, U8 Ac-
cessSize, U32 MatchValue, U32 ValueMask);

Parameter Description

Refer to Break.SetOnData on page 245.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Enable (Shift+F9)

7.10.16.18    Break.DisableOnData
Disables a data breakpoint (see Data Breakpoints on page 144).

Prototype

int Break.DisableOnData(U32 Address, U32 AddressMask, U8 AccessType, U8 Ac-
cessSize, U32 MatchValue, U32 ValueMask);

Parameter Description

Refer to Break.SetOnData on page 245.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Disable (Shift+F9)

7.10.16.19    Break.EditOnData
Edits a data breakpoint (see Data Breakpoints on page 144).

Prototype

int Break.EditOnData(U32 Address, U32 AddressMask, U8 AccessType, U8 Ac-
cessSize, U32 MatchValue, U32 ValueMask);

Parameter Description

Refer to Break.SetOnData on page 245.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Edit (F8)
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7.10.16.20    Break.SetOnSymbol
Sets a data breakpoint on a symbol (see Data Breakpoints on page 144).

Prototype

int Break.SetOnSymbol(const char* sSymbolName, U8 AccessType, U8 AccessSize,
U32 MatchValue, U32 ValueMask);

Argument Meaning

sSymbolName Name of the symbol that is monitored by the data breakpoint.

AccessType Type of access that is monitored by the data breakpoint (see Connec-
tion Modes on page 171).

AccessSize

Access size condition required to trigger the data breakpoint. As an
example, a data breakpoint with an access size of 4 bytes (word)
will only be triggered when a word is written to one of the monitored
memory locations. It will not be triggered when, say, a byte is writ-
ten.

MatchValue
Value condition required to trigger the data breakpoint. A data break-
point will only be triggered when the match value is written to or read
from one of the monitored memory addresses.

ValueMask
Indicates which bits of the match value are ignored when monitoring
access events. A value mask of 0xFFFFFFFF means that all bits are ig-
nored, i.e. the value condition is disabled.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Set (Alt+Plus)

7.10.16.21    Break.ClearOnSymbol
Clears a data breakpoint on a symbol (see Data Breakpoints on page 144).

Prototype

int Break.ClearOnSymbol(const char* sSymbolName, U8 AccessType, U8 Ac-
cessSize, U32 MatchValue, U32 ValueMask);

Parameter Description

Refer to Break.SetOnSymbol on page 248.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Clear (F9)

7.10.16.22    Break.EnableOnSymbol
Enables a data breakpoint on a symbol (see Data Breakpoints on page 144).
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Prototype

int Break.EnableOnSymbol(const char* sSymbolName, U8 AccessType, U8 Ac-
cessSize, U32 MatchValue, U32 ValueMask);

Parameter Description

Refer to Break.SetOnSymbol on page 248.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Enable (Shift+F9)

7.10.16.23    Break.DisableOnSymbol
Disables a data breakpoint on a symbol (see Data Breakpoints on page 144).

Prototype

int Break.DisableOnSymbol(const char* sSymbolName, U8 AccessType, U8 Ac-
cessSize, U32 MatchValue, U32 ValueMask);

Parameter Description

Refer to Break.SetOnSymbol on page 248.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Disable (Shift+F9)

7.10.16.24    Break.EditOnSymbol
Edits a data breakpoint on a symbol (see Data Breakpoints on page 144).

Prototype

int Break.EditOnSymbol (const char* sSymbolName, U8 AccessType, U8 AccessSize,
U32 MatchValue, U32 ValueMask);

Parameter Description

Refer to Break.SetOnSymbol on page 248.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Edit (F8)
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7.10.16.25    Break.SetCommand
Assigns a script function to a breakpoint that is executed when the breakpoint is hit.

Prototype

int Break.SetCommand (const char* sLocation, const char* sFuncName);

Argument Meaning

sLocation
Location of the breakpoint as displayed within the first column of
the Breakpoint Window (see Breakpoints/Tracepoints Window on
page 71).

sFuncName Name of the script function to callback when the breakpoint is hit.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Edit (F8)

7.10.16.26    Break.SetCmdOnAddr
Assigns a script function to a breakpoint that is executed when the breakpoint is hit.

Prototype

int Break.SetCmdOnAddr (unsigned int Address, const char* sFuncName);

Argument Meaning

Address Instruction address.
sFuncName Name of the script function to callback when the breakpoint is hit.

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Edit (F8)

7.10.17    ELF Actions

7.10.17.1    Elf.GetBaseAddr
Returns the program file’s download address.

Prototype

int Elf.GetBaseAddr();

Return Value

-1: error
Base address: success
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GUI Access

None

7.10.17.2    Elf.GetEntryPointPC
Returns the initial PC of program execution.

Prototype

int Elf.GetEntryPointPC();

Return Value

Initial PC of program execution (-1 on error)

GUI Access

None

7.10.17.3    Elf.GetEntryFuncPC
Return the initial PC of the program’s entry (or main) function.

Prototype

int Elf.GetEntryFuncPC();

Return Value

PC of the program entry function (-1 on error)

GUI Access

None

7.10.17.4    Elf.GetExprValue
Evaluates a symbol expression.

Prototype

int Elf.GetExprValue(const char* sExpression);

Return Value

-1: error
Expression value: success

GUI Access

None

7.10.17.5    Elf.GetEndianess
Returns the program file’s data encoding scheme.

Prototype

int Elf.GetEndianess(const char* sExpression);
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Return Value

0: Little Endian
1: Big Endian

GUI Access

None

7.10.18    Trace Actions
Actions performing trace related operations.

7.10.18.1    Trace.SetPoint
Sets a tracepoint

Prototype

int Trace.SetPoint(int Op, const char* sLocation);

Argument Meaning

Op Operation to be performed when the tracepoint is hit (see Tracepoint
Operation Types on page 172).

sLocation Location of the tracepoint as displayed within the Breakpoints/Trace-
points Window (see Breakpoints/Tracepoints Window on page 71)).

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Set Tracepoint (Ctrl+Alt+E)

7.10.18.2    Trace.ClearPoint
Clears a tracepoint.

Prototype

int Trace.SetPoint(const char* sLocation);

Argument Meaning

sLocation Location of the tracepoint as displayed within the Breakpoints/Trace-
points Window (see Breakpoints/Tracepoints Window on page 71)).

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Clear (F9)

Ozone User Guide & Reference Manual (UM08025) © 2013-2018 SEGGER Microcontroller GmbH



253 CHAPTER 7 User Actions

7.10.18.3    Trace.EnablePoint
Enables a tracepoint.

Prototype

int Trace.EnablePoint(const char* sLocation);

Argument Meaning

sLocation Location of the tracepoint as displayed within the Breakpoints/Trace-
points Window (see Breakpoints/Tracepoints Window on page 71)).

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Enable (Shift+F9)

7.10.18.4    Trace.DisablePoint
Disables a tracepoint.

Prototype

int Trace.DisablePoint(const char* sLocation);

Argument Meaning

sLocation Location of the tracepoint as displayed within the Breakpoints/Trace-
points Window (see Breakpoints/Tracepoints Window on page 71)).

Return Value

-1: error
0: success

GUI Access

Breakpoint Window → Context Menu → Disable (Shift+F9)

7.10.18.5    Trace.ClearAllPoints
Clears all tracepoints.

Prototype

int Trace.ClearAllPoints();

Return Value

-1: error
0: success

GUI Access

Breakpoint Toolbar → Clear All Tracepoints
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7.10.18.6    Trace.ExportCSV
Exports the contents of the Instruction Trace Window to a CSV file.

Prototype

int Trace.ExportCSV(const char* sFilePath);

Return Value

-1: error
0: success

GUI Access

Instruction Trace Window → Context Menu → Export

7.10.19    Watch Actions

7.10.19.1    Watch.Add
Adds an expression to the Watched Data Window (see Watched Data Window on page 130).

Prototype

int Watch.Add(const char* sExpression);

Return Value

-1: error
0: success

GUI Access

Watched Data Window → Context Menu → Watch… (Alt+Plus)

7.10.19.2    Watch.Insert
Inserts an expression into the Watched Data Window (see Watched Data Window on
page 130).

Prototype

int Watch.Insert(const char* sExpression);

Return Value

-1: error
0: success

GUI Access

None

7.10.19.3    Watch.Remove
Removes an expression from the Watched Data Window (see Watched Data Window on
page 130).
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Prototype

int Watch.Remove(const char* sExpression);

Return Value

-1: error
0: success

GUI Access

Watched Data Window → Context Menu → Remove (Del)
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Support

How to Report Bugs

Users are kindly asked to include the following information in Ozone bug reports:
• A detailed description of the problem
• Your OS and version
• Your debug probe model (e.g. J-Trace PRO Cortex-M V2)
• Information about your target hardware (processor, board, etc.)
• When possible an Ozone-log of the problem (for this, start Ozone with argument “–

logfile <filepath>”)

Users without a support agreement with SEGGER are kindly asked to report bugs at the
general room of  SEGGER’s forum .

Users which are entitled to support should use the contact information below.

Contact Information

SEGGER Microcontroller GmbH

Ecolab-Allee 5
D-40789 Monheim am Rhein

Germany

Tel. +49 2173 99312 0
Fax. +49 2173 99312 28
E-mail: support@segger.com
Internet: www.segger.com
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Chapter 9
 
Glossary

This chapter explains the meanings of key terms and abbreviations used throughout this
manual.

Big-endian

Memory organization where the least significant byte of a word is at a higher address than
the most significant byte. See Little-endian.

BMA

Background Memory Access. Targets featuring BMA support memory accesses while the
CPU is running.

Command Prompt

The console window’s command input field.

Debuggee

Same as Program.

Debugger

Ozone.

Device

The Microcontroller on which the debuggee is running.

Halfword

A 16-bit unit of information.

Host

The PC that hosts and executes Ozone.

ID

Identifier.
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Joint Test Action Group (JTAG)

The name of the standards group which created the IEEE 1149.1 specification.

Little-endian

Memory organization where the least significant byte of a word is at a lower address than
the most significant byte. See also Big-endian.

MCU

Microcontroller Unit. A small computer on a single integrated circuit containing a processor
core, memory, and programmable input/output peripherals.

J-Link OB

A J-Link debug probe that is integrated into the target (“on-board”).

PC

Program Counter. The program counter is the address of the machine instruction that is
executed next.

Processor Core

The part of a microprocessor that reads instructions from memory and executes them,
including the instruction fetch unit, arithmetic and logic unit, and the register bank. It
excludes optional coprocessors, caches, and the memory management unit.

Program

Application program that is being debugged and that is running on the target device.

RTOS

Real Time Operating System.

SVD

System View Description, a standard by ARM.

Target

Same as Device. Sometimes also referred to as “Target Device”.

Target Application

Same as Program.

User Action

A particular operation of Ozone that can be triggered via the user interface or program-
matically from a script function.

Window

Short for debug information window.

Word

A 32-bit unit of information. Contents are taken as being an unsigned integer unless oth-
erwise stated.
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